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IMDPIlus Analysis Types

IMDPIlus User
Manual

The IMDPlus modal dynamics software option calculates the modal response of a
system to a given input using calculated eigenmodes and eigenvectors from an
eigenvalue analysis. (Note that the eigenvalue analysis must have been performed with
mass normalised eigenmodes.)

IMDPIlus Analysis Types

There are three types of analysis that can be performed in IMDPlus. These are as
follows:

U Seismic Analysis
A seismic analysis obtains the dynamic response of a structure to acceleration
time histories of support motion.

U Moving Load Analysis
A moving load analysis obtains the dynamic response of a structure to moving
loads. In a moving load analysis the load can either be explicitly defined or a
vehicle configuration (composite axle definition) can be used. In both cases the
magnitude and configuration of the load remains constant throughout the
analysis.

U Moving Mass Analysis
A moving mass analysis obtains the dynamic response of a structure to moving
masses. In a moving mass analysis spring-mass systems are used in a vehicle
configuration. Each spring-mass system includes an unsprung mass and up to
two sprung masses connected by springs and viscous dashpots. The
configuration of the systems remains constant throughout the analysis but as they
move across the structure, the dynamic response of the unsprung and sprung
masses affects the forces acting on the underlying structure due to inertia effects.

All solutions from IMDPlus are carried out in the time domain.
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IMDPIlus Assumptions

The working assumptions for the IMDPlus modal dynamics facility are as follows:

O Linear

The system is linear in terms of geometry, material properties and boundary
conditions. Therefore geometrically nonlinear eigenvalue results are not
applicable. Nor are nonlinear joint and slideline analyses suitable for this type of

post-processing treatment.

U No Cross-Coupling

There is no cross-coupling of modes caused by the damping matrix. This is

reasonable for all but the most highly damped structures or applications.

Q Low Modes Dominant
The response is dominated by the lowest few modes.

U Damping Ratios Are Below Critical

Damping ratios of 100% or more are not permitted due to the solution of the
time domain response of the structure using either the Hilber—Hughes-Taylor

(HHT) method or Duhamel’s Integral.

O Moving Mass Analysis

The working assumptions for the particular case of a moving mass analysis are

as follows:

1 No Loss of Contact

There is no loss of contact between the unsprung masses (wheels) of the spring—

mass systems and the structure at any time during a moving mass analysis.

O Vertical Motion of Spring-Mass Systems Only

Only vertical motion of the spring-mass systems is considered in a moving mass

analysis.

U Mass of Spring-Mass Systems Not Included in Eigenvalue Solution

The mass of the spring-mass systems have no effect on the natural frequencies of

the structure.

0 Recommended Limit on Total Mass of Spring-Mass Systems

The accuracy of the moving mass solution reduces for light-weight structures or
structures where the magnitude of the moving mass is similar to the magnitude
of the structure mass. A literature search recommends that for most solutions of
this type, the total mass of all the spring-mass systems that are actively
interacting with the structure at any given time should not exceed 10% of the

total mass of the underlying structure.




Performing IMDPIus Calculations in LUSAS

Performing IMDPlus Calculations in LUSAS

The various stages of an IMDPlus analysis are initiated from the Utilities > IMDPlus
menu or the IMDPIus Toolbar. The basic steps that need to be undertaken for each of
the three analysis types are as follows:

Seismic Analysis

SNk wbh =

Select the acceleration time histories

Select the eigenmodes to include in the solution

Specify the damping for the eigenmodes

If required, modify the advanced solution options

Specify the frequency interpolation technique and if required, the time step

Specify the nodes or elements to process along with the output requirements

Moving Load Analysis

1.

2.
3.

A

Generate the movement of a discrete load across the structure by using a number
of distinct locations along the moving load path

Calculate the equivalent modal forces for each of these distinct locations

If the loading has not been explicitly defined in step 1, define moving load
vehicle configuration(s) using the positions of the axles/bogies that form a
vehicle together with the moving load factors to be applied at each position

If required, select the moving load vehicle configuration to be used in the
analysis

Select the eigenmodes to include in the solution

Specify the damping for the eigenmodes

If required, modify the advanced solution options

Specify the speed ranges to analyse along with time stepping parameters
Specify the nodes or elements to process along with the output requirements

Moving Mass Analysis

1.

W

Generate the movement of a discrete unit load across the structure by using a
number of distinct locations along the moving load path

Calculate the equivalent modal forces for each of these distinct locations
Define spring-mass system property attribute(s)

Define moving mass vehicle configuration(s) using the positions of the
axles/bogies that form a vehicle together with the spring-mass system property
attribute that is to be used at each position

Select the moving mass vehicle configuration to be used in the analysis
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6. If required, include a path surface profile that defines the surface irregularities
along the length of the moving load path

7. Select the eigenmodes to include in the solution

8. Specify the damping for the eigenmodes

9. Ifrequired, modify the advanced solution options

10. If required, modify the path surface profile options

11. Specify the speed ranges to analyse along with time stepping parameters

12. Specify the nodes, elements or spring-mass systems to process and the output
requirements

IMDPIlus Toolbar

All of the IMDPlus dialogs can be launched from the Utilities > IMDPIlus menu.
Alternatively, the IMDPIus Toolbar can be activated from the View > Toolbars...
menu, as shown in the following figure.

Toolbars
Toolkbars: -m
Defing =]

v Wiew Took Mew...
[]Advanced Define
[ 1Animation Builder Te Custarnize... |
[ Annotation Tools
[ 1%izibilityS election Fezet |
|0 Pluz -

Help |
Toalbar name:

IMain

v Shaw Toolips v Cool Look
" Large Buttons

The Toolbar has been split into four sections as follows:

U Analysis Type

This section allows the IMDPlus analysis type to be selected. Options available
are as follows:

=

:I Seismic Analysis

&

—1 Moving Load Analysis

gl Moving Mass Analysis

Only one of the analysis types can be selected at any time.
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O IMDPlus Vehicle Attributes

This section allows IMDPlus attributes to be defined prior to an IMDPlus
analysis. Options available are as follows:

E

=

Spring-Mass System Properties

This button opens the spring-mass system properties dialog. It is only
available when the analysis type is set to moving mass.

Vehicle Configurations

This button opens either the moving load or moving mass vehicle
configuration dialog. The dialog launched depends on the analysis type
selected. The button is only available when the analysis type is set to
moving load or moving mass.

O Moving Load Generation and Modal Force Calculator
This section allows the preliminary steps for a moving load or moving mass
analysis to be performed. These are the generation of the moving load path and
the calculation of the modal force history for use in the IMDPlus analysis, as
follows:

él

o

Moving Load Generation
This button opens the moving load generation dialog. It is only available
when the analysis type is set to moving load or moving mass.

Modal Force Calculator

This button opens the modal force calculator dialog. It is only available
when the analysis type is set to moving load or moving mass and the
moving load generation step has already been carried out.

O Running an IMDPIlus Analysis
This section allows an IMDPlus analysis to be performed. Options available to
the user are as follows.

L]

Analysis Control

This button opens either the seismic, moving load or moving mass
analysis control dialog. The dialog launched depends upon the analysis
type selected. For both moving load and moving mass analysis types the
button is only available when the modal force calculation has been
carried out.
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EI Output Control

This button opens either the seismic, moving load or moving mass output
control dialog. The dialog launched depends upon the analysis type
selected. It is only available when an IMDPlus analysis has been carried
out and results are still available on disk for graphing.

Seismic Analysis

The seismic analysis option calculates the response of the structure to an acceleration
time history applied at the support nodes. Both 2D and 3D structures can be analysed
but they are restricted to having the acceleration inputs applied in the global X-, Y-
directions and X-, Y- and Z-directions respectively. Only one acceleration time history
can be specified for each excitation direction and therefore, all support nodes are
accelerated with the same time history record in this direction. Different acceleration
records can be applied to each global direction and these can be factored based on
design code requirements. Up to seven earthquake combinations can be analysed in a
single IMDPlus analysis.

The IMDPIlus seismic analysis control dialog is accessed from the Utilities > IMDPlus
=
> Seismic... menu or from the IMDPlus Toolbar. Ensure the =21 button is selected to

-
choose a seismic analysis and then select the ;l button to launch the seismic analysis
control dialog.

IMDPlus Seismic Analysis Control

—Earthquake input

-direction earthquake record(s] I Browse... |
*r-direction earthquake record(z] I EBrowse... |
Z-direction earthquake record(s] I Browse... |

Ditection Factors % [1.0 ¥ 10 Z |0E6es7

— Mode/damping control
Total participating mass

Included modes: I All odify... | # Direction I 456 =

f Direction I 9384 %
¥ Default darmping I A0 4 Modify... |
Z Direction I M2

—Frequency interpalation

Advanced solution options odify |

@ all frequencies included ' Linear interpolation of records

" Limit frequencies to Myquist frequency  © Cubic spline interpolation of records

Time step I
< Back | Mext > I Cancel | Help |
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Earthquake Input

For two-dimensional structures, earthquake acceleration time history records can be
applied in the global X- and Y-directions. For three-dimensional structures, an
additional earthquake acceleration component in the global Z-direction can be applied.
Permissible input formats for these acceleration records are space delimited, TAB
delimited or Comma Separated Variable (CSV).

For all of these input formats, the time step of the acceleration records must be identical
in all of the earthquake acceleration files. IMDPlus supports the solution of up to seven
earthquakes at a time with enveloping / averaging of the Secondary Response Spectra
(SRS). For space or TAB delimited files the number of time steps in each directional
record for multiple record files must be identical across each of the earthquakes. For
Comma Separated Variable files, the number of time steps in each directional record
can vary but the number of time steps in individual earthquakes must be identical. If
more than one earthquake is present in the record files, the IMDPlus analysis will
process all valid combinations.

Sample Acceleration Time History Records

Space Delimited Single Combination Space Delimited Two Combinations
0.000 0.0000E+000 0.000 0.0000E+000 0.0000E+000
0.005 -2.7459E-002 0.005 -2.7459E-002 -4.0070E-005
0.010 -3.4127E-002 0.010 -3.4127E-002 8.2210E-004
0.015 -4.0796E-002 0.015 -4.0796E-002 1.2618E-002
0.020 -4.7464E-002 0.020 -4.7464E-002 1.4741E-002
0.025 -5.4133E-002 0.025 -5.4133E-002 1.8604E-002

Mode / Damping Control

The modes to include in the analysis can be controlled either by the eigenmodes solved
in the eigenvalue analysis or a subset defined in the mode control. The default option
when first running an analysis is for all modes to be included in the analysis but
individual modes can be included or excluded using the following dialog accessed via
the Modify... button on the seismic analysis control dialog.

Modify Modes

-~ Modes to include:
I Al modes

[T 536527 [EigenID=3Fil=iD=1]
£.92154 (EigenlD=4:FilelD=1]

~ Total paricipating mass

MPFz = 61.0408 %
MPFy = 66.2335 b4
MPFz = 0.758512E-3 b4

1] | Cancel | Help
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This dialog also calculates the total participating mass for the included modes. If a
significant proportion of participating mass is missing, based on the selected modes of
vibration, a warning will be issued when proceeding with the analysis. Omission of
modes of vibration with significant mass contributions that can be excited by the input
acceleration time histories will lead to unreliable solutions. Ideally, total mass
participations in excess of 90% should be used unless it is guaranteed that the modes of
vibration associated with any missing mass are at frequencies that cannot be excited.

The Default damping option allows the user to control the amount of damping used in
the IMDPlus analysis. If Default damping is selected, all of the modes of vibration
included in the analysis are forced to have the current default value. The default value is
set, via the Modify... button on the seismic analysis control dialog.

Modify Damping
Default damping  |5.0 %

IF madal damping walue is available in the eigenvalue
analysiz the following options are available

I™ |gnoe overdamped modes

I | Lirit overdarmped modes to critically damped

0K | Cancel | Help |

The Default damping option can only be turned off when viscous damping has been
included in the eigenvalue analysis. If Default damping is deselected the viscous
damping present in the eigenvalue analysis is used in the IMDPlus analysis. When
viscous damping is included in the eigenvalue solution additional options for the
inclusion of overdamped modes of vibration in the IMDPlus analysis also become
available. These options are as follows:

U Ignore overdamped modes

Modes of vibration with a damping ratio of 100% or more are omitted from the
IMDPlus solution.

O Limit overdamped modes to critically damped

Modes of vibration with a damping ratio of 100% or more are limited to
99.9999% to allow them to be included in the analysis.

Frequency Interpolation

Four interpolation options are available for the interpretation of the acceleration time
histories in IMDPlus. These are as follows:

Q All frequencies included
All modes of vibration are included in the analysis even if their frequencies are
greater than the maximum frequency that may be reliably resolved based on the
acceleration time history time step (the Nyquist frequency).
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Q Limit frequencies to Nyquist frequency

All modes of vibration up to and including the Nyquist frequency are included in
the analysis. Modes of vibration with frequencies in excess of this value are
discarded.

O Linear interpolation of records

Allows for linear interpolation of the earthquake records. The required time step
is specified by the user for the analysis.

O Cubic spline interpolation of records

Allows for cubic spline interpolation of the earthquake records. The required
time step is specified by the user for the analysis.

Note. For rapidly varying input acceleration time histories, such as real acceleration
records measured on site that often have large reversals in acceleration over one or two
time steps, the cubic spline interpolation should generally not be used. For synthetic
acceleration time history records, the use of cubic spline interpolation is usually valid
since the Fourier series used to generate the synthetic records tend to produce smoother
responses. It is however up to the user to ensure that the method of interpolation used is
suitable for the analysis being carried out.

Note. The Nyquist frequency is equal to 1/(2*8t) where ot is the time step of the
acceleration time history.

Advanced Seismic Solution Options

Advanced solution options can be set via the Modify... button on the seismic analysis
control dialog.

Time integration scheme for structure response

' Hilber Hughes Taplor (HHT) HHT factorec (0.0

" Duhamel's Integral

Defaults ak. | Cancel | Help |

The options available in a seismic analysis are as follows. The Defaults button resets
all of the options to the default values.

U Time integration scheme for structure response

The implicit time integration scheme used by IMDPlus to calculate the dynamic
response of the structure.

O Hilber Hughes Taylor (HHT)

This is the default time integration scheme and is the same as the method
used for an implicit transient dynamic analysis in LUSAS.




IMDPlus User Manual

O HHT factor a

The integration constant o used in the HHT integration scheme. For an
unconditionally stable, second order accurate scheme, o must lie between
the limits -1/3 < o < 0.0. Values of a outside this range cannot be
specified. The default value of a is 0.0, which reduces the method to the
Newmark method. Further integration constants [ and y are computed
automatically by IMDPlus using the following equations:

p=(1-a)/a . y=(1-20)/2

U Duhamel’s Integral
This is the time integration method used by IMDPlus in LUSAS 14.7 (and
earlier versions of LUSAS) and is available as an alternative to the HHT
integration scheme.

Moving Load Analysis

The moving load analysis option obtains the dynamic response of the structure to the
passage of a moving load along a user defined path. Both 2D and 3D structures can be
analysed and the magnitude and configuration of the load remains constant throughout
the entire analysis. Two methods are available for the definition of the moving load
configuration. These are:

U Explicit definition
The complete load configuration is defined through a discrete load definition in
Modeller. This can be used for analysing the passage of a single load
configuration across the structure.

O Composite axle definition
The complete load configuration consists of a unit load single axle
configuration, defined as a discrete load definition in Modeller, and a vehicle
configuration is that is defined separately. The vehicle configuration (composite
axle definition) method is the recommended approach, as it allows multiple load
configurations (such as multiple train rolling stock configurations) to be
analysed rapidly without having to repeat initial steps for the IMDPlus solution.

Irrespective of the method used, two distinct steps are required to prepare the moving
load input data for IMDPlus. These two steps are as follows:

1. Generation of the moving load path across the structure
2. Calculation of equivalent modal forces for the moving load path

10
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Note. These two steps must be carried out before the first analysis but may be omitted
from subsequent analyses, if and only if the moving load path, discrete load
configuration and direction of the moving load do not change between analyses. If any
of these are modified the moving load path and calculation of equivalent modal forces
must be carried out again.

Moving Load Generation

The moving load generator is used to mimic the passage of a load across a structure by
automatically setting up a number of static load cases at prescribed locations along a
single line/arc/spline, or a collection of lines/arcs/splines, which define a single
continuous path. These load cases can then be used to calculate the modal forces
equivalent to the applied loading for import into IMDPlus. Before entering the moving
load generator, the lines/arcs/splines defining the path must be selected and a discrete
load representing the load configuration that is to be moved across the structure must
have been defined.

The definition requirements for this discrete load are governed by the type of moving
load input that is going to be used in IMDPlus. If the discrete load is going to represent
the whole load configuration (i.e. a vehicle configuration is not being used) then it must
contain all of the loading associated with the configuration. However, if the composite
axle definition method is being used in IMDPlus, this discrete load should represent a
subset of the overall load configuration and will be used along with the vehicle
configuration to build up the total load configuration in IMDPlus.

Explicit Definition of United Kingdom HB Vehicle

For the LUSAS Bridge option, HB vehicles can be defined from the Bridge > Bridge
Loading > United Kingdom... menu entry.

Abnormal Load {HE Yehicle) [ <]

Vehicle details

+ ’:"
Inner axle spacing [m] [ - 1"": !
Number of HB units [25 - 45] |45.0

18m|B1116.21.26 ) 18m)
akK I Cancel | Apply | Help |

After defining a vehicle load, either the initial definition dialog (as shown above) or the
resulting attribute data can be viewed. This is done by right-clicking on the Attribute
name in the Attributes Treeview and selecting either the Edit Definition or Edit
Attribute menu item. Selecting the latter will show the following discrete point load
data for the above vehicle selection.

11
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Point
Untransformed load direction |~ Projection vector
© Arhitrary Cx oz [V Praject inlaad direction
®eid x|+ v surface normal @G ||
v lq— ¥ component | 0.0
#z l—
Z component | 1.0
= Y z Load -
1 -4.8 15 [iT] -112.5E3
2 30 -15 00 -1125E3
El an 15 0o -1125E3
4 43 15 0o -1125E3
[ -4.8 5 0o -112.8E3
E a0 05 0o -112.5E3
T an 05 0o N2BE3
g 48 05 00 -1125E3
E -4.8 05 0o -1125E3
10 3.0 04 0o -1125E3 -
4| | »
Name IPntl j j’ (8}
Close I Cancel I Apply | Help |

This discrete point load can now be used to define the passage of the HB vehicle across

the structure.

Note. The front of the moving load is always the location with the maximum discrete

load X co-ordinate.

Composite Axle Definition of United Kingdom HB Vehicle using a
Moving Load Vehicle Configuration

The equivalent composite axle definition of the above HB vehicle can be achieved by
defining a unit axle of the across carriageway configuration and defining the vehicle
configuration separately. The following discrete point load defines the unit axle for the

HB vehicle.
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Point
Untransformed load direction |- Projection wectar
& Arhitrary Cow oz ¥ Praject inload direction
Coaid  x |1 v suface normal S5 RIS |00
¥ I 1 ¥ component | 0.0
*z l—
Z component | 1.0
X Y Z Load
1 1] 15 0 -0.25
2 0 0.5 0 0.25
E] 1] 05 0 025
4 1} 15 0 0.25
Marme IUnlt HB Axle j ﬂ (new)
< Back I INext = Finish Cancel | Apply | Help I

The IMDPlus moving load vehicle configuration dialog is used to create or modify
vehicle configuration attributes for use in a moving load analysis. It is accessed from
the Utilities > IMDPIlus > Moving Load > Vehicle Configuration... menu or from the

-
IMDPlus Toolbar. Ensure the ;l button is selected to choose a moving load analysis
and then select the El button to launch the moving load vehicle configuration dialog.

In a moving load vehicle configuration the position (relative to the origin / front of the
vehicle) of each of the applied loads is defined along with the value of the moving load
factor to be applied at each position. For the United Kingdom HB vehicle the axle
positions and load factors shown in the following figure data should be entered into the
dialog. A meaningful name should be entered into the Name field, for example,
45Unit HB Axles.

13



N

NS

N

IMDPlus User Manual

IMDPlus ¥ehicle Configuration

Position Load
1 LK) 450.0E3
2 an 4B0.0E3
3 3.0 450.0E3
4 -4.8 450.0E3

Name: [ 45ni_H2_ides = i’ fiens
[s]4 I Cancel I Apply | Help |

Note. Care should be taken when defining axle positions (X co-ordinates) in discrete
load configurations. The path length should be sufficiently longer than the structure to
ensure that the load configuration correctly arrives onto and departs from the structure.
In the above example, the path should start at least 4.8 m before the structure and finish
4.8 m after the structure.

Note. The front of the moving load vehicle is always the position with the maximum
co-ordinate. The rear of the vehicle is always the position with the minimum co-
ordinate.

Note. The positions and loads that define the vehicle configuration can be copied and
pasted from a Microsoft Excel spreadsheet. This method is demonstrated in the
IMDPIlus Worked Example: Train Induced Vibration of a Bridge.

Note. Once created vehicle configurations will appear in the Utilities Treeview, from
where they can be modified or deleted from the model. To modify a vehicle
configuration either double-click or right-click on the Attribute name in the Utilities
Treeview and select the Edit Attribute... menu item.

Note. Vehicle configurations can be easily transferred from one model to another
using an attribute library file, accessed from the menu File > Import/Export model
data...
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Generation of the Moving Load Discrete Locations

If a valid continuous path has been selected and a valid discrete load defined then the
moving load generator can be used to create the static load cases at prescribed locations
along the path.

The IMDPlus moving load generation dialog is accessed from the Utilities > IMDPlus
> Moving Load > Moving Load Generation... menu or from the IMDPlus Toolbar.

-+
Ensure the ;l button is selected to choose a moving load analysis and then select the
+
= | button to launch the moving load generation dialog.

IMDPlus Moving Load Generation

[~ Loading oplions

Muoving load dataset IW Unit e Load

Ll L«

Search area Il |1 Track_Search_Area
" Praject onto line [ 2D line beam and frame models)

" Pigject over area [ gillages, slabs and 30 frame space)
MNOTE: &ll existing loading will be removed and Advanced |
the moving loads will start from loadcase 1

—Load path options

Incremental distance for moving load along path (0.1

Direction  * Fowards Backwards

Statofpath: ®= | 632 v=[ 00  Z=[ 05032

Finishof path: %= [ 2204  v=| 00 2= [ 05032

Mumber of divisions/increments ta define full path; 273

—Analysis options

Number of loadcases per— [1pp = 7 Datacheck
analpsis ¥ Run analyses

QK | Cancel | Help |

If a search area has been defined then this can be used to correctly assign the moving
load if there are multiple planes to which the discrete load could be assigned. Project
onto line or Project over area can be selected depending upon the geometry defining
the search area. For single deck models, the default search area which encompasses the
whole structure can be used. Parameters for the inclusion of the load can be accessed
through the Advanced... button which provides the full application options available
for discrete loads. These options consist of the inclusion of loads outside the search
area and the load factor to be applied.

Having defined the loading options, the load path options can be set based on the
lines/arcs/splines selected to define the path. The incremental distance controls the
separation of the discrete load locations used to define the passage of the load across
the structure. This incremental distance should be positive and sufficiently small to
capture the movement of the load.
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Note. Due to the dynamic solution a sufficiently small distance should be used
between the discrete locations defining the passage of the load to minimise
oversampling for load locations between those defined. For static analyses, much larger
distance increments can be used since the incremental movement does not need to be
close to the time step of the analysis.

Ideally, the distance increment used for the movement of the load along the path should
obey the following equation:

SDist < 10 x Minimum Speed x 8t

to give a maximum oversample of 10. ot is the minimum of the Nyquist time step and
any user specified time step (8" = 1/(2*f,50) Where fy is the maximum frequency
included in the analysis). Larger distance increments can be used but warnings will be
issued by IMDPlus since the accuracy of the dynamic solution decreases with
increasing oversampling ratio. Oversampling ratio reduces with increasing speed and
therefore it is possible that higher oversampling ratios can be used for lower speeds
where the dynamic excitation is reduced. It is however up to the user to ensure that use
of higher oversampling ratios for any speed does not adversely affect the solutions to
the dynamic analysis.

The moving load path forwards direction is defined by the order of selection of the
lines, arcs or splines. The path starts at the first line that is connected to only one other
selected line. If only a single line is selected, the forwards direction of the moving load
path is defined by the line direction defined in Modeller (Line directions can be
visualised through the Geometry layer in the Treeview). The direction that the moving
load travels can be toggled between forwards and backwards relative to the original line
selection for the generation of the discrete locations. The start and end of the path will
be displayed along with the number of divisions / increments required for the full
description.

The number of load cases per analysis controls the number of load cases for each
LUSAS analysis used to obtain the loading information. By default this is set to 100 but
can be increased up to 1000. Options are available to perform a datacheck analysis
instead of a full static solution. The advantage of using this option is in both speed and
the amount of disk space required for the LUSAS analyses. IMDPlus itself only
requires the loading vector information from the datacheck analysis but if static
solutions are also required for the passage of the moving load this option can be
switched off. An option is also available not to run the analyses immediately. By default
the LUSAS analyses will be carried out once the OK button has been clicked. If
however the user wishes to run a large number of analyses resulting from the moving
load definition overnight, this option can be switched off and a batch file generated so
the analyses can be run separately. The original model, associated eigenvalue results
and static load cases must be loaded prior to proceeding to the next stage of the moving
load analysis.
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This can be carried out by running the following two VBScript files which will have
been generated in the directory \<LUSAS Installation Folder>\Projects\<Model
Name>\Associated Model Data\<Model Name>

IMDPlus_Model_Reload.vbs

Reloads the model and eigenvalue results
IMDPlus_LoadVector_Load.vbs

Loads the static results on top of the model and eigenvalue

Note. If for any reason the model and static load cases need to be loaded for the
current moving load path and configuration in the future, these two VBScript files can
be used.

Modal Force Calculator

The path and configuration of the moving load should have been defined using the
moving load generation described previously. The discrete loads at distances along the
path now need to be converted into equivalent modal forces for import into IMDPlus.
This is carried out using the modal force calculator.

The IMDPIus modal force calculator dialog is accessed from the Utilities > IMDPlus >
Moving Load > Modal Force Calculator... menu or from the IMDPlus Toolbar.

-
Ensure the ;l button is selected to choose a moving load analysis and then select the
El button to launch the modal force calculator dialog.

i Modal force input options

Firstfle containing [ 1:144D Pius Rail Bridge™Analysis T.mys =l
eigenvalues

Total number of sigenvalue files = I 1

First file containing |2:IMDPIus Fail Bridge_00007, mys
static loadcases

Mumber of loadcases in each static file = 100

—Moving load path options

Direction & Forward " Backward

oK | Cancel | Help |

On entry, the eigenvalue and static results will be identified and placed into the dialog.
Multiple eigenvalue results files are supported which allows the solution of structures
with large numbers of eigenvalues over multiple analyses with frequency / eigenvalue
ranges.
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The moving load path options allow the user to change the direction of the load
movement along the path but this option should not be used unless the load
configuration is symmetrical.

Note. Once the moving load generation and modal force calculation have been carried
out in a moving load analysis, these two steps may be omitted from subsequent
analyses, even if the analysis type is switched from moving load to moving mass but
only if the moving load path, discrete load configuration and direction of the moving
load do not change between analyses. If any of these are modified the moving load path
and calculation of equivalent modal forces must be carried out again.

Running the Moving Load Analysis

An IMDPlus moving load analysis can only be performed if the following steps have
already been undertaken:

U The equivalent modal forces have been successfully calculated using the moving
load generator and the modal force calculator

U If a composite axle definition is being used at least one moving load vehicle
configuration has been defined in the model

The IMDPlus moving load analysis control dialog is shown in the following figure. On
entering moving load analysis control for the first time the dialog will be filled with
default information shown.

IMDPlus Moving Load Analysis Control

—Moving load input

™ Wehicle configuration I ﬂ

[Composzite axle]

—Mode/damping contral
Total participating mass

Included modes: I Al Madify. #Direction | 93.83 %

| 0 v Directi EIE
¥ Default damping 50 % Modify.. irection
Z-Direction 8820 %

7~ Salution control

Advanced solution options: odify...

2 CQuiet time after l—
Minimum speed I s o e on
M aximum speed I v IMDPlus automatic time step (Myquist]
Speed increment I Solution time step

< Back | Mext > I Cancel | Help |

The IMDPlus moving load analysis control dialog is accessed from the Utilities >
IMDPlus > Moving Load > Moving Load Analysis... menu or from the IMDPlus
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-
Toolbar. Ensure the ;l button is selected to choose a moving load analysis and then

select the ;l button to launch the moving load analysis control dialog.

Moving Load Input

If a composite axle definition is being used in the analysis a vehicle configuration can
be included by selecting the checkbox marked Vehicle configuration (Composite axle).
This will enable the drop-down list that will contain all of the moving load vehicle
configurations in the model. The required vehicle configuration can be selected for use
in the IMDPlus analysis, as shown by the example in the following figure.

IMDPlus Moving Load Analysis Control

—Moving load input

¥ Vehicle configuration I1.45Umt,HB,AxIs j
[Composite axle]

—Mode/damping control
Total participating mass

Included modes: I All Muodiy... =-Direction I 9383 %

“r-Direction I 94.07 %
¥ Default damping | 50 % Modify...
Z-Direction I aa20 %

r— Solution control

Adwvanced solution optiohs Madify...

Quigt time: after I—
Mimimum speed I passage of lnad 0.0
Mairmurn speed I W IMDPlus automatic time step (Mpquist]
Speed increment I Solution time step I

< Back I Mext > I Cancel | Help I

Note. Although a vehicle configuration (composite axle definition) is designed for
internal construction of complex loading configurations from a single axle, for example
defining a complete trainset from a single unit axle, it can also be used to model the
passage of more than one load configuration across the structure. Each load
configuration is restricted to having the same plan layout but can have different
magnitudes governed by the load factors contained in the vehicle configuration.

Mode / Damping Control

The modes to include in the analysis can be controlled either by the eigenmodes solved
in the eigenvalue analysis or a subset defined in the mode control. The default option
when first running an analysis is for all modes to be included in the analysis but
individual modes can be included or excluded using the following dialog accessed via
the Modify... button on the moving load analysis dialog.
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i Modes to include
™ 20 modes

M 16343 [EigenlD=5:FilelD=1) -

[ Total participating mass

MPFe= | 128267 %
MPFy= | 375734E3 %
MPFz= | 76,8844 %

QK | Cancel | Help |

This dialog also calculates the total participating mass for the included modes. If a
significant proportion of participating mass is missing based on the selected modes of
vibration a warning will be issued when proceeding with the analysis. Omission of
modes of vibration with significant mass contributions that can be excited during the
analysis will lead to unreliable solutions. Ideally, total mass participations in excess of
90% should be used unless it is guaranteed that the modes of vibration associated with
any missing mass are at frequencies that cannot be excited.

The Default damping option allows the user to control the amount of damping used in
the IMDPlus analysis. If Default damping is selected, all of the modes of vibration
included in the analysis are forced to have the current default value. The default value is
set, via the Modify... button on the moving load analysis control dialog.

Default damping  [5.0 %

It modal damping walue is available in the eigenvalue
analysiz the following options are available

™ lanore overdamped modes

= Limit overdamped modes to eitically damped

ok | Cancel | Help |

The Default damping option can only be turned off when viscous damping has been
included in the eigenvalue analysis. If Default damping is deselected the viscous
damping present in the eigenvalue analysis is used in the IMDPlus analysis. When
viscous damping is included in the eigenvalue solution additional options for the
inclusion of overdamped modes of vibration in the IMDPlus analysis also become
available. These options are as follows:

U Ignore overdamped modes
Modes of vibration with a damping ratio of 100% or more are omitted from the
IMDPlus solution.
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O Limit overdamped modes to critically damped

Modes of vibration with a damping ratio of 100% or more are limited to
99.9999% to allow them to be included in the analysis.

Solution Control

The speeds and time stepping information are input via the solution control section. The
input includes a range of speeds for the solution defined using a minimum speed,
maximum speed and a speed increment. If only a minimum or maximum speed is
specified then one speed, equal to the value entered, will be analysed for the moving
load. A quiet time can be specified which allows for the inclusion of a user defined
length of time after the passage of the load along the path. This enables decay of the
structural vibration to be analysed. By default, IMDPlus determines the time step
required for the analysis from the Nyquist time step. This is calculated from the
maximum frequency included in the analysis. User control over the time step for the
solution is available by disabling this feature.

Advanced Moving Load Solution Options
Advanced solution options can be set via the Modify... button on the moving load
analysis control dialog.

IMDPlus Moving Load Solution Dptions [ x|

i~ Time integration scheme for structure response

" Hilber Hughes Taylor (HHT] HHT factora  |0.0

" Duhamel's Integral

i~ Interpolation method for modal forces
' Cublic spline interpolation

" Linear interpalation

Defaults | ok | Cancel | Help |

The options available in a moving load analysis are as follows. The Defaults button
resets all of the options to the default values.

O Time integration scheme for structure response

The implicit time integration scheme used by IMDPlus to calculate the dynamic
response of the structure.

O Hilber Hughes Taylor (HHT)
This is the default time integration scheme and is the same as the method
used for an implicit transient dynamic analysis in LUSAS.

O HHT factor a
The integration constant o used in the HHT integration scheme. For an
unconditionally stable, second order accurate scheme, o must lie between
the limits -1/3 < o < 0.0. Values of a outside this range cannot be
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specified. The default value of a is 0.0, which reduces the method to the
Newmark method. Further integration constants 3 and y are computed
automatically by IMDPlus using the following equations:

B= (1—a)2/4 . y=(1-20)/2

U Duhamel’s Integral

This is the time integration method used by IMDPlus in LUSAS 14.7 (and
earlier versions of LUSAS) and is available as an alternative to the HHT
integration scheme.

Interpolation method for modal forces

The interpolation method used by IMDPlus to calculate the equivalent modal
forces from the values obtained at the discrete path locations by the modal force
calculator.

U Cubic spline interpolation

Equivalent modal forces are interpolated using a cubic spline interpolation
technique. This is the default option.

U Linear interpolation

Equivalent modal forces are interpolated using a linear interpolation
technique.

Moving Mass Analysis

The moving mass analysis option obtains the dynamic response of the structure to the
passage of moving spring-mass systems along a user defined path. Both 2D and 3D
structures can be analysed. The configuration of the spring-mass systems remains
constant throughout the analysis but as they move across the structure, the dynamic
response of the unsprung and sprung masses affects the forces acting on the underlying
structure due to inertia effects.

It is important to note the following working assumptions for the case of a moving mass
analysis:

a
a

Only vertical motion of the spring-mass systems is considered

There is no loss of contact between the unsprung masses (wheels) of the spring—
mass systems and the structure at any time

The mass of the spring-mass systems have no effect on the natural frequencies of
the structure

The accuracy of the moving mass solution reduces for light-weight structures or
structures where the magnitude of the moving mass is similar to the magnitude
of the structure mass. A literature search recommends that for most solutions of
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this type, the total mass of all the spring-mass systems that are actively
interacting with the structure at any given time should not exceed 10% of the
total mass of the underlying structure.

The following two steps are required to define the moving spring-mass systems that are
to be used in the analysis:

1. Define the spring-mass system property attribute(s)

2. Define the moving mass vehicle configuration(s) using the positions of the
axles/bogies that form a vehicle together with the spring-mass system property
attribute that is to be used at each position

Two further preliminary steps are required, in a similar manner to a moving load
analysis, before a moving mass analysis can be undertaken. These generate equivalent
modal forces by simulating the movement of a discrete unit load across the structure,
using a number of distinct locations along a moving load path. The two steps are as
follows:

3. Generation of the moving load path across the structure

A discrete load representing the unit load configuration for the axles/bogies of
the vehicle that is to be moved across the structure must be defined. The moving
load generator is then used to mimic the path of this unit load across the
structure by automatically setting up a number of static load cases at prescribed
locations along the path that the vehicle configuration is to follow.

4. Calculation of equivalent modal forces for the moving load path

The static load cases are used to calculate the modal forces equivalent to the
applied unit loading for import into IMDPlus. The equivalent modal forces are
used in IMDPlus together with the loading from the spring-mass systems of the
vehicle to build up the complete loading configuration applied to the structure.

Note. Steps 3 and 4 must be carried out before the first analysis but may be omitted
from subsequent analyses, if and only if the moving load path, discrete unit load
configuration and direction of the moving load do not change between analyses. If any
of these are modified the moving load path and calculation of equivalent modal forces
must be carried out again.
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Spring-Mass System Properties

A spring-mass system is represented by a single unsprung mass and up to two sprung
masses, connected by springs and viscous dashpots, as shown in the following figure. A
spring-mass system property attribute defines the masses, linear or nonlinear spring
stiffnesses and viscous damping properties for a spring-mass system. Spring-mass
system properties are assigned to different initial positions in a moving mass vehicle
configuration in order to represent all of the axle/bogie locations of an entire vehicle or
trainset. As these systems move across the structure, the motion of the unsprung and
sprung masses affects the forces acting on the underlying structure due to inertia effects.

Note. A vehicle or trainset may contain several axle/bogie positions with the same
spring-mass system properties, that is, masses, spring stiffnesses and viscous damping
constants. A spring—mass system property attribute can therefore be assigned to
multiple axle/bogie positions when defining a vehicle configuration.

Cze

Cz1

Different spring behaviour can be modelled ranging from a simple linear elastic spring
through to more complex nonlinear behaviour. Linear viscous dashpots can be
optionally included for each of the sprung masses. Nonlinear spring behaviour allows
for the inclusion of the following spring types.

Piecewise linear springs

Piecewise linear springs can be used to model bilinear springs or more general
nonlinear spring behaviour.
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Xsl -
MSl \ Ll
X7

»
XLI
M, t

Piecewise-linear spring: Nonlinear spring behaviour

Piecewise linear springs can also be used to simulate stopper systems that limit the
spring deflections through the inclusion of very high compressive spring stiffnesses
after a given closure.

Fa
Xlsl 8. -
MSl T T Xl VX
s1u
Ksl,Z{ ? Ksl,lLJ|:| Csl
3 X,
M, t

Piecewise-linear spring: Stopper system to limit deflections

Polynomial Springs

Polynomial springs can be used to represent nonlinear spring behaviour using the
following function:

F= ZN:Cadxa
a=1

The total spring force, F, is expressed in terms of the total spring deflection, dx, where
N is the order of the polynomial and C, are the polynomial constants. This allows for
the special cases of rubber springs and ‘C’ springs, as shown in the following figures,
along with more general spring definitions.
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Note. The polynomial function always passes through the origin of the spring force-
displacement curve. This ensures that the spring force is zero at zero spring
displacement.

1x;,
Ix

u

Polynomial spring: Rubber Spring F = C;x’y-X,) + C3(x’sl-xu)3

p 1!

1x,

Ix

u

Polynomial spring: 'C" Spring F = C;x’4-x,) + Cz(x’sl-xu)2

Spring Mass System Properties Dialog

The IMDPlus moving mass spring-mass system properties dialog is used to create or
modify spring-mass system property attributes for use in a moving mass analysis. It is
accessed from the Utilities > IMDPIlus > Moving Mass > Spring Mass Properties...

menu or from the IMDPlus Toolbar. Ensure the él button is selected to choose a

moving mass analysis and then select the EI button to launch the moving mass spring-
mass system properties dialog.
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IMDPlus Spring-Mass System Properties
IDuub\e Sprung mass j Unsprung mass Sprung mass 1 Sprung mass 2
Mass
¥ Damping Viscosity cosfficient
¥ Morlinear springs
" palynamial
" Piecewise linear
Spring 1 stiffness Spring 2 stiffness
| Constant | | Constant
1] f 1]
Palynomial
Ks2 Cs? constants
Ksl Csi
Marme j i’ (rew)
OF I Cance| | Apply I Help |

Options for the spring-mass system are located in the upper left hand corner of the
dialog. These define the number of sprung masses in the system and allow for the
optional inclusion of damping and nonlinear spring behaviour. The number of sprung
masses is controlled by selecting one of the following options from the drop-down list.

O Unsprung mass only
Q Single sprung mass
O Double sprung mass

On the left hand side of the dialog a diagram of the chosen spring-mass system is
displayed. All property data is input on the right hand side of the dialog as follows:

O Unsprung and sprung masses
o Unsprung and sprung masses should be defined in the model mass units

e Ifrequired, the unsprung mass can be set to 0.0 for a Single sprung mass or
Double sprung mass system

e Ifrequired, the 1st sprung mass can be set to 0.0 for a Double sprung mass
system
O Elastic spring stiffness

o Elastic spring stiffnesses are only required if Nonlinear springs has not been
selected

o Elastic spring stiffnesses should be defined in the model stiffness units
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O Viscosity coefficient
e Viscosity coefficients are only required if Damping has been selected
e Viscosity coefficients should be defined in the model force*time/length units
e Ifrequired, the viscosity coefficients can be set to 0.0

U Nonlinear springs

If Nonlinear springs is selected the spring behaviour is defined using either
polynomial constants or piecewise linear data.

U Polynomial springs

The spring force-displacement relationship is defined using a polynomial

function

e The polynomial constants C, should be entered in the table where row 1
defines the linear constant C;, row 2 defines the quadratic constant etc.

e The polynomial function must have a positive value at a displacement of
0.0

e At least one of the polynomial constants must be non zero

o IMDPlus requires the spring stiffness to always be a positive value. With
higher order functions the gradient of the force-displacement relationship
will generally reach a peak and become negative at a limiting
compressive and/or tensile displacement. In these cases the IMDPlus
analysis will terminate if the spring displacements ever reach these
limiting values.

O Piecewise linear springs
The spring stiffness-deformation relationship is defined using a piecewise
linear curve

o Compressive and tensile data is input separately to ensure that the
resulting force-displacement curves always pass through the origin

Q Stiffness

o Spring stiffnesses should be defined in the model stiffness units
e Spring stiffnesses must always be defined as a positive value

O Deformation

e Spring deformations should be defined in the model length units

e The deformation of the first data point (row 1) of each piecewise
linear curve must be set to 0.0

e In compression all deformations must be negative and must be
monotonically decreasing

e In tension all deformations must be positive and must be
monotonically increasing

A meaningful name should be entered into the Name field.
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Note. Once created spring-mass system properties will appear in the Utilities
Treeview, from where they can be modified or deleted from the model. To modify a
spring-mass system property either double-click or right-click on the Attribute name in
the Utilities Treeview and select the Edit Attribute... menu item.

Note. Spring-mass system properties can be easily transferred from one model to
another using an attribute library file, accessed from the menu File > Import/Export
model data...

Moving Mass Vehicle Configuration

The IMDPlus moving mass vehicle configuration dialog is used to create or modify
vehicle configuration attributes for use in a moving mass analysis. It is accessed from
the Utilities > IMDPIlus > Moving Mass > Vehicle Configuration... menu or from the

IMDPlus Toolbar. Ensure the él button is selected to choose a moving mass analysis

and then select the El button to launch the moving mass vehicle configuration dialog.

IMDPlus Yehicle Configuration

Position Spring-mass system | «

1 0.0 1:CRH Train ‘wheelsat

2 25 1:CRH Train Wheelset

3 175 T:CRH Train Wheelzet

4 -20.0 1:CRH Train wheelset

5 250 1:CRH Train wheelset

B 275 T:CRH Train Wheelzet

7 425 1:CRH Train wheelset

] -45.0 1:CRH Train wheelset

9 500 1:CRH Train Wheslsst

1o 625 T:CRH Train Wheelset

11 E7.E 1:CRH Train wheelset

12 00 1:CRH Train Wheslsst

13 50 1:CRH Tran wheelsst ~

14 R 1:CRH Train ‘wheelsat

15 4925 1:CRH Train Wheelset

16 950 T:CRH Train Wheelset

17 -100.0 1:CRH Train ‘wheelsat

iE] -025 1:CRH Train Wheelset

19 1175 T:CRH Train Wheelzet

20 -1200 1:CRH Train wheelset ;I

= e E VA Ti T ST, M i

Mame I CRH Train j ﬂ (1)

Close I Zance| | Apply | Help I

In an IMDPIus moving mass analysis a vehicle or trainset is represented by a number of
spring-mass systems. A moving mass vehicle configuration includes the position
(relative to the origin / front of the vehicle) of the axles/bogies that form the vehicle
along with the spring-mass system attribute to be used at each position. Each row of the
Spring-mass system column includes a drop-down list that contains all of the spring-
mass system property attributes in the model. The spring-mass system properties
required at each position can be selected for use in the vehicle configuration. A spring—
mass system property attribute can be used at multiple positions in a vehicle. An
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example of a moving mass vehicle configuration is shown in the figure. A meaningful
name should be entered into the Name field.

Note. Care should be taken with the definition of the spring-mass system positions.
The path length should be sufficiently longer than the structure to ensure that the
vehicle configuration correctly arrives onto and departs from the structure.

Note. The front of the moving mass vehicle is always the position with the maximum
co-ordinate. The rear of the vehicle is always the position with the minimum co-
ordinate.

Note. The positions and spring-mass system identifiers that define the vehicle
configuration can be copied and pasted from a Microsoft Excel spreadsheet. This
method is demonstrated in the IMDPlus Worked Example: High Speed Train
Modelling through Sprung Masses.

Note. Once created vehicle configurations will appear in the Utilities Treeview, from
where they can be modified or deleted from the model. To modify a vehicle
configuration either double-click or right-click on the Attribute name in the Utilities
Treeview and select the Edit Attribute... menu item.

Note. Vehicle configurations can be easily transferred from one model to another
using an attribute library file, accessed from the menu File > Import/Export model
data...

Moving Load Generation

In a moving mass analysis the moving load generator is used to mimic the path of a unit
load across a structure by automatically setting up a number of static load cases at
prescribed locations along a single line/arc/spline, or a collection of lines/arcs/splines,
which define a single continuous path. These load cases are subsequently used to
calculate the unit modal forces equivalent to the applied unit loading for import into
IMDPlus, where the unit modal forces are used together with the vertical loading from
each of the spring-mass systems to obtain the total modal force applied to the structure.

Note. In a moving mass analysis a discrete unit load must always be used in the
moving load generator to ensure that the correct loads are applied to the structure
during the IMDPlus analysis. The discrete unit load is used to calculate the unit modal
forces that are applied to the structure as the discrete unit load moves along the moving
load path. These unit modal forces are used in IMDPlus in conjunction with the vertical
loading from the spring-mass systems of the vehicle configuration to calculate the total
modal forces applied to the structure.

Before entering the moving load generator, the lines/arcs/splines defining the path must
be selected and a discrete load representing the unit load configuration for the

30



Moving Mass Analysis

axles/bogies of the vehicle that is to be moved across the structure must have been
defined. Examples of discrete unit loads are shown in the following figures.

Untransformed load direction |~ Projection vector
& prbitrary Con Cowrz IV Project in Ioad direction
Caid x|t & v (" surface nomal @SN |0
w [1 & Y component | L0
z Z component | 0.0
[ % [ Y zZ | Load |
1] 0 i i : 1.0 3
Mame IUnit Wheelset Load j ﬂ (new)
< Back. I [ext = | Finish | Cancel I Apply | Help |
UntransFormed load direction |- Prajection wectar
 arbitrary LOE S a4 IV Project inload direction
Coaid  x I 1 v surface normal B RIS (|10
I * companent | 0.0
T il g l—
Z component | 1.0
X Y z Load
1 a 15 1] -0.25
2 1) 0.5 0 -0.25
E] 0 05 0 -0.25
4 0 15 0 -0.25
T IUnit HE xle j j’ (new)
= Back I Mext = I Finish | Cance| | Apply | Help I

Generation of the Moving Load Discrete Locations

The IMDPlus moving load generation dialog is accessed from the Utilities > IMDPlus
> Moving Mass > Moving Load Generation... menu or from the IMDPlus Toolbar.

Ensure the gl button is selected to choose a moving mass analysis and then select the

)
il button to launch the moving load generation dialog.
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If a valid continuous path has been selected and a valid discrete unit load defined then
the moving load generator can be used to create the static load cases at prescribed
locations along the path.

IMDPlus Moving Load Generation

—Loading options

Maving load dataset |1'Llnit Aule Load j

Search area ID |1:Track_5 sarch_drea j
1~ Project anta line [ 20 line beam and frame models)

* Pioject over aea [ gillages, slabs and 30 frame space]
MNOTE: All existing loading will be remaved and Advanced
the moving loads will start from loadcase 1 .

—Load path options

Incremental distance for moving load along path IU.1

Direction % Forwards € Backwards

Statofpathy %= [ 632 v=[ 00 2= 08032

Finish of pathy %= | 2204 v=| 00 2= | 05032

MNumber of divisions/increments to define full path: 273

—Analysis optiohs

Number of loadcases per Iﬂ ¥ Datacheck

analysiz ¥ Aun analyses

Ok | Cancel | Help |

If a search area has been defined then this can be used to correctly assign the moving
load if there are multiple planes to which the discrete unit load could be assigned.
Project onto line or Project over area can be selected depending upon the geometry
defining the search area. For single deck models, the default search area which
encompasses the whole structure can be used. Parameters for the inclusion of the load
can be accessed through the Advanced... button which provides the full application
options available for discrete unit loads. These options consist of the inclusion of loads
outside the search area and the load factor to be applied. The load factor for a moving
mass analysis should always be set to 1.0.

Note. In a moving mass analysis the load factor defined under the Advanced...
options should always be set to 1.0 as the moving load generator needs to define the
passage of a discrete unit load across the structure. Any factor other than 1.0 can cause
the incorrect static and dynamic loads to be calculated during a moving mass analysis.

Having defined the loading options, the load path options can be set based on the
lines/arcs/splines selected to define the path. The incremental distance controls the
separation of the discrete unit load locations used to define the passage of the unit load
across the structure. This incremental distance should be positive and sufficiently small
to capture the movement of the load.

Note. Due to the dynamic solution a sufficiently small distance should be used
between the discrete locations defining the passage of the unit load to minimise
oversampling for load locations between those defined.
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Ideally, the distance increment used for the movement of the unit load along the path
should obey the following equation:

8Dist < 10 x Minimum Speed x 8t

to give a maximum oversample of 10. 8t is the minimum of the Nyquist time step and
any user specified time step (8‘[Nyq“iSt = 1/(2*f,,.x) Where f, is the maximum frequency
included in the analysis). Larger distance increments can be used but warnings will be
issued by IMDPlus since the accuracy of the dynamic solution decreases with
increasing oversampling ratio. Oversampling ratio reduces with increasing speed and
therefore it is possible that higher oversampling ratios can be used for lower speeds
where the dynamic excitation is reduced. It is however up to the user to ensure that use
of higher oversampling ratios for any speed does not adversely affect the solutions to
the dynamic analysis.

The moving load path forwards direction is defined by the order of selection of the
lines, arcs or splines. The path starts at the first line that is connected to only one other
selected line. If only a single line is selected, the forwards direction of the moving load
path is defined by the line direction defined in Modeller (Line directions can be
visualised through the Geometry layer in the Treeview). The direction that the moving
load travels can be toggled between forwards and backwards relative to the original line
selection for the generation of the discrete locations. The start and end of the path will
be displayed along with the number of divisions / increments required for the full
description.

The number of load cases per analysis controls the number of load cases for each
LUSAS analysis used to obtain the loading information. By default this is set to 100 but
can be increased up to 1000. It is recommended that the option to perform a datacheck
analysis instead of a full static solution is always selected as an IMDPlus moving mass
analysis only requires the unit loading vector information from the datacheck analysis.

Note. In a moving mass analysis a full static solution will only take into account the
loading from the discrete unit load and will not include the total static loading from the
spring-mass systems of the vehicle configuration. The results of the static analysis will
therefore not correspond to the total vehicle loading that is going to be applied to the
structure.

An option is also available not to run the analyses immediately. By default the LUSAS
analyses will be carried out once the OK button has been clicked. If however the user
wishes to run a large number of analyses resulting from the moving load definition
overnight, this option can be switched off and a batch file generated so the analyses can
be run separately. The original model, associated eigenvalue results and static load
cases must be loaded prior to proceeding to the next stage of the moving mass analysis.
This can be carried out by running the following two VBScript files which will have
been generated in the directory \<LUSAS Installation Folder>\Projects\<Model
Name>\Associated Model Data\<Model Name>
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IMDPlus_Model_Reload.vbs

Reloads the model and eigenvalue results
IMDPlus_LoadVector_Load.vbs

Loads the static results on top of the model and eigenvalue

Note. If for any reason the model and static load cases need to be loaded for the
current moving load path and configuration in the future, these two VBScript files can
be used.

Modal Force Calculator

The path and configuration of the moving unit load should have been defined using the
moving load generation described previously. The discrete unit loads at distances along
the path now need to be converted into equivalent modal forces for import into
IMDPlus. This is carried out using the modal force calculator.

The IMDPIlus modal force calculator dialog is accessed from the Utilities > IMDPlus >
Moving Mass > Modal Force Calculator... menu or from the IMDPlus Toolbar.

Ensure the gl button is selected to choose a moving mass analysis and then select the
%l button to launch the modal force calculator dialog.

—Modal force input options

First file cantaining IT.\MDFIus Rail Bridge™Analysis 1.mys ﬂ
eigenvalues

Total number of eigervalue files = 1

First file containing |2 IMDPlus Rail Eridge_000071.mys
static lnadcases

Number of lnadcases in each static file = 100

—Moving load path options
Direction & Fomard " Backward

Ok | Cancel | Help |

On entry, the eigenvalue and static results will be identified and placed into the dialog.
Multiple eigenvalue results files are supported which allows the solution of structures
with large numbers of eigenvalues over multiple analyses with frequency / eigenvalue
ranges.

The moving load path options allow the user to change the direction of the unit load
movement along the path but this option should not be used unless the load
configuration is symmetrical.

Note. Once the moving load generation and modal force calculation have been carried
out in a moving mass analysis, these two steps may be omitted from subsequent
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analyses, even if the analysis type is switched from moving mass to moving load but
only if the moving load path, discrete load configuration and direction of the moving
load do not change between analyses. If any of these are modified the moving load path
and calculation of equivalent modal forces must be carried out again.

Running the Moving Mass Analysis

An IMDPIlus moving mass analysis can only be performed if the following steps have
already been undertaken:

O The equivalent modal forces have been successfully calculated using the moving
load generator and the modal force calculator. A discrete load representing the
unit load configuration for the axles/bogies of the vehicle that is to be moved
across the structure must be used in the calculation of the modal forces to ensure
that the correct loads are applied to the structure during the moving mass
analysis.

O At least one moving mass vehicle configuration has been defined in the model

The IMDPIlus moving mass analysis control dialog is accessed from the Utilities >
IMDPlus > Moving Mass > Moving Mass Analysis... menu or from the IMDPlus

Toolbar. Ensure the él button is selected to choose a moving mass analysis and then
-
select the ;l button to launch the moving mass analysis control dialog.

On entering moving mass analysis control for the first time the dialog will be filled with
default information, as shown by the example in the following figure.
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IMDPlus Moving Mass Analysis Control

—Moving mass input

Wehicle configuration |1_EF|H Train ﬂ

[~ Path surface piofile | Browse...

[~ Mode/damping control

Total participating mass

Included modes: I All todify... »-Direction | 81.05

%
Y-Direction | 8560 %

v Default damping I 50 # Madify...
Z-Direction IW z

7~ Salution control

Advanced solution options: odify...
Path surface profile optiohs frldify...

o Quiet time after l—
Minimum speed I nassage of [nad on
I aximum speed | V¥ IMDPlus automatic time: step (Npquist)
Speed increment I Solution time step

< Back | Mext > I Cancel Help

Moving Mass Input
Vehicle Configuration

The vehicle configuration drop-down list will contain all of the moving mass vehicle
configurations in the model. The required vehicle configuration can be selected for use
in the IMDPlus analysis.

Path Surface Profile

The surface roughness of the structure along the path followed by the moving mass
vehicle can be optionally included via a perturbation of the vertical displacement of the
structure. This is termed the path surface profile displacement and it is added to the
displacements of the unsprung masses during the analysis. The path surface profile
velocity and acceleration vertical components are calculated during the IMDPlus
analysis and also applied to the unsprung masses for dynamic consistency.

The path surface profile displacements are defined in a path surface profile file. Select
the checkbox marked Path surface profile to include a path surface profile file in the
IMDPIlus moving mass analysis. This will enable the Browse... button so that the file
can be selected, as shown by the example in the following figure.
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IMDPlus Moving Mass Analysis Control

—Maoving mass input

Wehicle configuration |1_EHH Train j

¥ Pathsutace profile | C\LUSAS 160WFrojects\path_surface_proile.psf Blowse...l

i Mode/damping control
Total participating mass

Included modes: I All todify. | ¥-Direction I 81.08

%
5 -Direction I 8560 %

¥ Detault damping I 50 b4 I odify. |
Z-Direction IW z

r— Solution control

Advanced solution options Modify. |
Path surface profile optiors todify. |
. Cluiet time after
Minimurn speed || T 0.0
M aximum speed I W IMDPIus automatic time step [Myquist)
Speed increment I Solution time step

< Back | Next > I Cancel | Help |

The path surface profile file can contain either space, Comma Separated Variable
(CSV) or TAB delimited data and must include a piecewise linear displacement vs.
distance relationship that defines the surface irregularities along the path traversed by
the moving mass vehicle. An example of a path surface profile is shown in the
following figure. There should be a total of NPSP lines of data (NPSP defined below)
in the file. All input data must be valid integer or real numbers and each line of the file
should contain two data records as follows:

For i=1,NPSP
Dist; PSP;

End loop over NPSP

The path surface profile data is defined as follows:

O NPSP

e The number of data points in the path surface profile

e There must be a minimum of 2 data points in order to define a valid profile
U Dist;

The distance relative to the origin of the moving load path

¢ Distances should be defined in the model length units

e The distance of the first data point must be 0.0
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e The distances must be defined so that they are monotonically increasing

e Care should be taken to ensure that the last distance point in the file is equal
to or greater than the length of the path. If this is not the case an additional
point is automatically introduced during the IMDPlus analysis with a
distance equal to the path length and a displacement of 0.0

Q psp;

The surface irregularity vertical displacement at the distance Dist;

e Displacements should be defined in the model length units

e The displacement of the first data point must be 0.0

An example of a path surface profile file is shown in the following figure.

!& path_surface_profile.psf - Motepad  [l[=] E3
File Edit Format View Help

0. 0000E+00 0. 0000E+00 -
5.0000E-02 2.4472E-03

1. 0000E-01 5. 54 52E-03

1. 5000E-01 2.0611E-02

2.0000E-01 3.45459E-02

2.5000E-01 5.0000E-02

3. 0000E-01 5. 5451E-02

3. 5000E-001 7. B3809E-02

4. 0000E-01 5. 0451E-02

4. S000E-01 0.7553E-02

5. 0000E-C1 1. 0000E-01

5. 5000E-01 5.7553E-02

6., 0000E-01 5. 0451E-02

6. 5000E-01 7.9389E-02

7. 0000E-01 6. 54 51E-02

7.5000E-01 5.0000E-02

8. 0000E-0L1 3.4545E-02

8. 5000E-01 2. 0611E-02

5. 0000E-0L1 5. 54 52E-03

5, 5000E-01 2.4472E-03

1. 0000E+00 0. 0000E+00D =
< ol

Mode / Damping Control

The modes to include in the analysis can be controlled either by the eigenmodes solved
in the eigenvalue analysis or a subset defined in the mode control. The default option
when first running an analysis is for all modes to be included in the analysis but
individual modes can be included or excluded using the following dialog accessed via
the Modify... button on the moving mass analysis dialog.
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i Modes to include
™ &l modes

T 16343 [EigenlD=5:FilelD=1] -

i Total participating mass

MPFi = 128287 %
MPFy = 375734E3 %
MPFz = 768844 %

0Ok | Cancel | Help |

This dialog also calculates the total participating mass for the included modes. If a
significant proportion of participating mass is missing based on the selected modes of
vibration a warning will be issued when proceeding with the analysis. Omission of
modes of vibration with significant mass contributions that can be excited during the
analysis will lead to unreliable solutions. Ideally, total mass participations in excess of
90% should be used unless it is guaranteed that the modes of vibration associated with
any missing mass are at frequencies that cannot be excited.

The Default damping option allows the user to control the amount of damping used in
the IMDPlus analysis. If Default damping is selected, all of the modes of vibration
included in the analysis are forced to have the current default value. The default value is
set, via the Modify... button on the moving mass analysis control dialog.

Default damping  |5.0 k4

If madal damping value is available in the eigenvalue
analpsis the following options are available

™| lanore overdamped modes

I™ Limit overdamped modes o critically damped

ok | Cancel | Help |

The Default damping option can only be turned off when viscous damping has been
included in the eigenvalue analysis. If Default damping is deselected the viscous
damping present in the eigenvalue analysis is used in the IMDPlus analysis. When
viscous damping is included in the eigenvalue solution additional options for the
inclusion of overdamped modes of vibration in the IMDPlus analysis also become
available. These options are as follows:

Q Ignore overdamped modes

Modes of vibration with a damping ratio of 100% or more are omitted from the
IMDPlus solution.
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4 Limit overdamped modes to critically damped

Modes of vibration with a damping ratio of 100% or more are limited to
99.9999% to allow them to be included in the analysis.

Solution Control

The speeds and time stepping information are input via the solution control section. The
input includes a range of speeds for the solution defined using a minimum speed,
maximum speed and a speed increment. If only a minimum or maximum speed is
specified then one speed, equal to the value entered, will be analysed for the vehicle
configuration selected. A quiet time can be specified which allows for the inclusion of a
user defined length of time after the passage of the vehicle along the path. This enables
decay of the structural vibration to be analysed. By default, IMDPlus determines the
time step required for the analysis from the Nyquist time step. This is calculated from
the maximum frequency included in the analysis. User control over the time step for the
solution is available by disabling this feature.

Advanced Moving Mass Solution Options
Advanced solution options can be set via the Modify... button on the moving mass
analysis control dialog.

IMDPIlus Moving Mass Solution Options | X

—Time integration scheme for stucture response

" Hilber Hughes Taplar [HHT) HHT factor IU.U

" Duhamel's Integral

—Interpolation method for modal forces
' Cublic spline interpolation

' Linear interpalation

—Control variables for spring-mass system solution

M awirnun number of iterations |1UD

Maximum number of solution attempts |5

Convergence Lolerance IU.1 k4
M aximum constant for unsprung mass results update IU.

Defaults I 1] I Cancel I Help I

The options available in a moving mass analysis are as follows. The Defaults button
resets all of the options to the default values.

U Time integration scheme for structure response

The implicit time integration scheme used by IMDPlus to calculate the dynamic
response of the structure.

O Hilber Hughes Taylor (HHT)

This is the default time integration scheme and is the same as the method
used for an implicit transient dynamic analysis in LUSAS.
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O HHT factor o

The integration constant o used in the HHT integration scheme. For an
unconditionally stable, second order accurate scheme, o must lie between
the limits -1/3 < o < 0.0. Values of o outside this range cannot be
specified. The default value of a is 0.0, which reduces the method to the
Newmark method. Further integration constants § and y are computed
automatically by IMDPlus using the following equations:

p=(1-a)/a . y=(1-20)/2

U Duhamel’s Integral

This is the time integration method used by IMDPlus in LUSAS 14.7 (and
carlier versions of LUSAS) and is available as an alternative to the HHT
integration scheme.

Note. When Duhamel’s Integral is selected the HHT factor o remains active and can
still be modified. In moving mass analysis the HHT scheme is always used to calculate
the dynamic response of the spring-mass systems, irrespective of the time integration
scheme selected. The value of o will therefore always have an effect on a moving mass
analysis.

Q Interpolation method for modal forces

The interpolation method used by IMDPlus to calculate the equivalent modal
forces from the values obtained at the discrete path locations by the modal force
calculator.

O Cubic spline interpolation
Equivalent modal forces are interpolated using a cubic spline interpolation
technique. This is the default option.

U Linear interpolation

Equivalent modal forces are interpolated using a linear interpolation
technique.

O Control variables for spring-mass system solution

The variables used to control the solution of the spring-mass systems as they
move across the structure.

O Maximum number of iterations
The maximum number if iterations allowed for the spring-mass system and
structural solution. The default is 100 iterations per solution attempt. If
convergence problems occur this value may need to be increased.
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4 Maximum number of solution attempts
The maximum number of solution attempts allowed during the spring-mass
system and structural solution for each time step of the analysis. The default
is 5. If convergence problems occur this value may need to be increased.

Q Convergence tolerance
The convergence tolerance used for the spring-mass system and structural
solution. The default is 0.1%. Increasing the convergence tolerance can
reduce the time taken to perform an analysis but may produce inaccurate
results.

U0 Maximum constant for unsprung mass results update
The maximum constant, Cygy;, used in the calculation of the unsprung mass
results. The default is 0.5 and the constant must lie between the limits 0.0 <
Cusm < 1.0. Larger values of Cygy can be used to reduce the time taken to
perform an analysis but may result in convergence problems. If convergence
problems do occur this value may need to be reduced.

Path Surface Profile Options

If a path surface profile has been included in the analysis advanced path surface profile
options can be set via the Modify... button on the moving mass analysis control dialog.

IMDPlus Path Surface Profile Dptions
i Interpolation method for displacements
' Cublic spline interpolation

' Linear interpolation

[ Start/end point method for velocities and accelerations
& Use first and last values
€ Mirrar values about vertical axis

" Minor and reverse values about vertical axis

Defaults | ok | Cancel | Help I

The path surface profile options are as follows. The Defaults button resets all of the
options to the default values.

U Interpolation method for displacements
The interpolation method used by IMDPlus to calculate the path surface profile
displacements from the discrete values defined in the path surface profile file.

O Cubic spline interpolation
Path surface profile displacements are interpolated using a cubic spline
interpolation technique.
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O Linear interpolation

Path surface profile displacements are interpolated using a linear
interpolation technique. This is the default option.

Start/end point method for velocities and accelerations

IMDPlus calculates path surface profile velocities and accelerations from the
displacement data defined in the path surface profile file. In order to calculate
the complete velocity and acceleration profiles, displacement values beyond the
extent of the user defined data are required. This option defines the method that
is used to extrapolate the displacement profile at the start and end times of the
analysis.

O Use first and last values

Displacement data is extrapolated using the path surface profile displacement
values at the start and end of the analysis. This assumes that the displacement
profile continues indefinitely with the first and last values. This is the default
option and will be applicable in the majority of analyses.

O Mirror values about vertical axis

Displacement data is extrapolated by mirroring it about the vertical axis at
the start and end of the analysis. For example, this option would be
applicable where the path surface profile is defined using a cosine function
which has peak values at the start and end of the analysis.

O Mirror and reverse values about vertical axis

Displacement data is extrapolated by mirroring it about the vertical axis at
the start and end of the analysis and then multiplying the extrapolated data by
-1. For example, this option would be valid where the path surface profile is
defined using a sine function with zero displacement at the start and end of
the analysis.

Visualising the Results

Results are extracted from IMDPlus through the output control dialog which is used for
all of the seismic, moving load and moving mass analysis options. The IMDPlus output
control dialog is accessed by selecting Next> from the seismic, moving load or moving

mass analysis control dialogs or by selecting the El button from the IMDPlus
Toolbar.

Note. The El button will only be available for selection when an IMDPlus analysis
has been performed and the results are still available on disk for graphing.

For a seismic analysis the nodes or elements that are to be analysed are defined,
together with the type of output that will be generated by IMDPlus. In addition, the
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Earthquake to graph is selected using the drop-down list next to the Generate graphs
in Modeller option. Examples of the appearance of the seismic output control dialog
when processing an individual node or a selection of nodes are illustrated in the

following figure.

IMDPlus Seismic Output Control

[~ Mode/element selection

IMDPlus Seismic Output Control

[~ Mode/element selection

™ Secondary response spectia [SAS)
¥ Modal combination/factor history
I¥ Generate giaphs in Modsler

¥ Generate testfile output

& sbsolute

e
Eahqusketogsh [T 7]
Clptiaris.

I™ | Secondan iesponse spechia (SRS
™ Modal combination/factor history
[ Generate graphs in Modsller

I Generate textfile cutput

1+ Node = Element Entity | Displacement - = Node £ Element Enlity | Displacement ~
Edert  [lndividisl ~| Component [Dx, Dv&DZ | Edtent  [Selected  ¥| Component D DV&DZ =l
Node 51 - I Individual items Node 61 = I Indvidual iterns
I™ | Sum of chosenitems ™ Sum of chosen items
™ fverage of chosen ftems ¥ #verage of chosen items
~ Output control Dutput control
¥ Response time history ¥ Response time history
¥ Peak respanse summary £ Positive/negative. [T Enwelope ¥ Peak iesponse summary  Positive/nzaative W Envelope

| Absolute

Modiy

Optiors.
Eathuaketogiaph [1 7]

Options

<Back | Finish |

oo | Caneel | Heb

<Back [ Finsh |

g | Cancel | Hep

Individual Node

Selected Nodes

Seismic Analysis — Output Control Dialog

For a moving load analysis the nodes or elements that are to be analysed are defined,
together with the type of output that will be generated by IMDPlus. In addition, the
moving load Speed to graph is selected via the list next to the Generate graphs in
Modeller option. Examples of the appearance of the moving load output control dialog
when processing an individual element or a selection of elements are illustrated in the
following figure.
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IMDPIus Moving Load Output Control

IMDPlus Moving Load Output Control

™ Modal combination/tactor histony
™ Generate araphs in Modeller

¥ Generate textfile autput

I™ | Secondai iesponse spectia (SHS)

& ibsolute

Moy
Opticns
Opions

Speed to araph

I™ Modal combination/actor histan
[¥ Generate graphs in Modeler

™ Generate tetfle output

I | Seconday esponse spectia (RS)

r selection selection
" Mode 1 Element Entity [ForceMoment - Thick Shel - " Hode 1 Element Entity |Stess (middle) - Thick Shell -
Edent  [individual  ~| Companert [N | Edent  [Sclected | Component [Sw |
Elemert  [1133 - ¥ Individual tems Element  [1153 ~ I~ Incivicual tems
I= | Sum of chosen tems I™ Sum of chosen tems
Gauss Paint [1 - Bauss Point [4] 2
I i of chosenitems [¥ Ayerage of chosen iems
~Output control 7~ Output conirol
[¥ Response time history ™ Respanse time history
I™ Peak response summary | Positive/negative = Envelope ¥ Peak response summary * Positive/negative ¥ Envelope

" Absolute

Moy
Options:
Opiors

Speed to graph

<gack |[_Finsn_|

g | Cancel | Hel

<Back |[Firish |

b | Cancel | Hep

Indivi

dual Element

Selected Elements

Moving Load Analysis — Output Control Dialog

For a moving mass analysis the nodes, elements or spring-mass systems that are to be
analysed are defined, together with the type of output that will be generated by
IMDPlus. In addition, the moving mass Speed to graph is selected via the list next to
the Generate graphs in Modeller option. Examples of the appearance of the moving
mass output control dialog when processing an individual node or an individual spring-
mass system are illustrated in the following figure.

IMDPlus Moving Mass Dutput Control IMDPlus Maving Mass Output Control

[~ Mode/el selection [~ Node/el selection
& MNode  Element Entity | Displacement - " Node £ Element Entity |Displacement E
Extent [ndividual =] Component [D =1 Extent [Seiectzd =] Component [D =1
Node i ~ IV Individuslitems Hode B =~ I Irlivicusliterms
I™ | Sum of chosenitems I™ | Sum of chosenitems
I Average of chosen tems: I Average of choser tems:
- Spiingmass system selection S system selection

Result | Unsprung mass M

7 Springmass system

Etent  [individual =] Enty [Displacement |
System T10.0) CRH Train'v T

Result |Spung mass 1 B

1% Spring-mass system

Edtert [incividusl =] Eriiy [accelerstion =l
Sysem  [32(195.0) CAH Tr >

" Dutput cortral

¥ Response time history

€ Positive/negative. | Erwelope:

oy,
Optirs
Optiors

I Peak response summary

& Absolite

I Secondamy respanse spectra (SAS)
I Modal combination/factor histary
[V Generate graphs in Madeler Speed to graph

I Generate testfile cutput

7~ Output cantral

¥ Response time history

€ Positive/negative. T Erwelope:

oy,
Optiors
1:83.328 2

Oplors

I~ Peak response summary

& Absolte

I™ | Secondam response spectra (5RE)
™ Modal combination/factor histary
[V Generate graphs in Madeller Speed to graph

I Generate textile cutput

<gack |[ Fien_|

oo | Caedl | Hen

Cancel | He

<gack |[ Fien_|

Apply |

Individual Node

Individual Spring-Mass System

Moving Mass Analysis — Output Control Dialog
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Node / Element Selection

In this section of the output control dialog the nodes or elements that are to be analysed
are defined, together with the result entity and component and the type of output that
will be generated by IMDPlus.

Processing Individual, Selected or All Nodes or Elements

The Extent drop-down list includes the following options to determine whether
individual or multiple, nodes or elements will be processed by IMDPlus. This enables
results for a chosen set of nodes or elements to be obtained in a single IMDPlus
analysis.

U Individual

Process a single node or element in IMDPlus. This option is always available for
both Node and Element. With Individual the Node or Element lists are
enabled and filled with the node numbers or valid IMDPlus element numbers
selected in the model. Any of the node or element numbers listed can be chosen
for the analysis or alternatively a valid node or element number can be manually
specified by the user.

U Selected
Process the nodes or valid IMDPlus elements selected in the model. For Node
this option will be available if nodes have been selected in the model. For
Element the option will be available if valid IMDPlus elements have been
selected in the model and they are all the same type.

a All

Process all of the nodes or valid IMDPlus elements in the model. For Node this
option is always available. For Element the option will only be available if all of
the elements in the model are the same type.

Note. When analysing multiple elements, using Selected or All, only elements of the
same type, that is, bar, thick beam, continuum, thick shell or thin shell elements, can be
included in a set of IMDPIlus elements. The element set can, however, contain elements
with different numbers of Gauss points or nodes.

Note. When Extent is set to Selected or All the Node, Element and Gauss
Point/Node/End drop-down lists will not be available for selection. In addition the
element Gauss Point/Node/End is automatically set to All as multiple elements are
going to be processed in a single analysis.

Note. Both Generate graphs in Modeller and Generate textfile output can be used
when processing multiple node or element objects. With Generate textfile output a
number of output file formats are supported by IMDPlus to allow import of results into
graphing packages. These are discussed in the Output Control section presented later.
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Entity and Component Output

If Node output is selected, result entities supported are displacements, velocities,
accelerations, and reactions plus, for moving load and moving mass analyses, dynamic
amplification factors. The available components placed into the list will depend on the
nodes chosen for the analysis. In addition to the standard single component output,
options are also available to output all translational or rotational displacements,
velocities, accelerations, reactions and dynamic amplification factors (when applicable)
to the same graph.

If Element output is selected, the result entities supported are governed by the element
type chosen. For example, choosing a thick shell element allows selection of the Stress
resultants (such as Nx, Mx and Sx), Stress (Top/Middle/Bottom) and Strain
(Top/Middle/Bottom). Depending upon the element type either Gauss point, node or
end results are available with the ability to select either a single location or All locations
for an individual element. For a complete list of the output supported refer to the list of
elements supported by IMDPlus.

Results for Individual items, Sum of chosen items and Average of
chosen items

The Individual items, Sum of chosen items and Average of chosen items options
determine the type of node or element output that will be generated by IMDPlus, see
also Response time history and Peak response summary in the following section.

O Individual items

This option produces individual results for each of the chosen nodes or element
Gauss points/nodes/ends.

O Sum of chosen items
This option adds together results from the chosen nodes or element Gauss
points/nodes/ends to give summed node or element time histories from which
peaks of the summed results are obtained.

Q Average of chosen items
This option obtains results by first summing the time history results from the
chosen nodes or element Gauss points/nodes/ends. A simple average of this
summed result is obtained to give the node or element average time histories
from which the peak average results are obtained.

Sum of chosen items and Average of chosen items are only available for selection
when Extent is set to Selected or AllL

Note. Any combination of the options Individual items, Sum of chosen items and
Average of chosen items can be used in an IMDPlus analysis, although using the
Individual items option when Extent is set to Selected or All (nodes or elements) may
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produce a very large number of graphs, depending on the number of nodes or elements
chosen for processing.

Note. When processing reactions for a chosen set of nodes, Sum of chosen items and
Average of chosen items only take into consideration nodes with supported freedoms.

Note. When processing dynamic amplification factors only averaged results can be
obtained for a chosen set of nodes as summed results are meaningless for this result
entity.

Spring-Mass System Selection (Moving Mass Only)

This section of the output control dialog is only available in a moving mass analysis. It
defines the spring-mass system, result and entity that will be processed by IMDPlus.

Note. Only one of the Node, Element or Spring-mass system radio buttons can be
selected at any given time.

Processing Individual or All Spring-Mass Systems

The Extent drop-down list includes the following options to determine which spring-
mass systems will be processed by IMDPlus.

Q Individual
Process a single spring-mass system in IMDPIus. With Individual the System list
is enabled and will contain, in sequential order, all of the system identifiers,
together with the initial positions for each system and the spring-mass system
property set used at each position, for the vehicle configuration selected in the
IMDPIus moving mass analysis control dialog. Any of the spring-mass systems
listed can be chosen for the analysis.

a All

Process all of the spring-mass systems for the vehicle configuration selected in
the IMDPlus moving mass analysis control dialog.

Note. When Extent is set to All the System drop-down list will not be available for
selection.

Note. Both Generate graphs in Modeller and Generate textfile output can be used
when processing all of the spring-mass systems. With Generate textfile output a
number of output file formats are supported by IMDPIlus to allow import of results into
graphing packages. These are discussed in the Output Control section presented later.

Result and Entity Output

The Result drop-down list contains the valid result types available for the system(s),
selected using Extent and System. The result types available for selection depend on
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number of sprung masses in the system, that is, unsprung mass only, single sprung mass
or double sprung mass and whether a path surface profile has been included in the
analysis. Results are generated as the spring-mass system moves across the structure
and are available for the range of speeds defined in the IMDPlus moving mass analysis
control dialog.

a

a

Unsprung mass
The results for the unsprung mass of the spring-mass system(s).

Sprung mass 1
The results for the 1% sprung mass of the spring-mass system(s).

Sprung mass 2
The results for the 2™ sprung mass of the spring-mass system(s).

Contact point

The structural results at the contact point(s) between the spring-mass system(s)
and the structure.

Path surface profile
The path surface profile followed by the system(s). These can be used to confirm

that the user defined path surface profile has been interpreted correctly by
IMDPlus.

The Entity drop-down list contains the valid entities for the Result type selected. The
entities available for selection are as follows;

Q

Displacement
The vertical component of displacement for the Result type of the spring-mass
system(s).

Velocity

The vertical component of velocity for the Result type of the spring-mass
system(s).

Acceleration

The vertical component of acceleration for the Result type of the spring-mass
system(s).

Position

The horizontal position of the unsprung mass of spring-mass system(s), relative

to the initial position of the origin / front of the vehicle. This entity type is only
available when Result is set to Unsprung mass

Force
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The vertical force applied to the structure by the spring-mass system. This entity
type is only available when Result is set to Contact point

Output Control

The output control section selects the types of results to visualise. Options are:

U Response time history
Response time history outputs node or element time history results for the
selected Entity and Component or spring-mass system time history results for
the selected Result and Entity.

Results available include displacements, velocities, accelerations, dynamic
amplification factors and reactions for nodes, forces/moments, stresses/stress
resultants and strains/strain resultants for elements and vertical displacement,
velocity, acceleration, position and force for spring-mass systems.

For nodes or elements the type(s) of output generated depends on the options
selected in the node / element selection section of the dialog as follows.

Q Individual items

Individual time history results for all of the chosen nodes or elements are
generated.

Q Sum of chosen items

Summed time history results for the chosen set of nodes or elements are
generated.

U Average of chosen items

Averaged time history results for the chosen set of nodes or elements are
generated.

When processing spring-mass systems individual time history results for the
chosen system(s) are always generated.

U Peak response summary

Peak response summary outputs maximum, minimum and/or absolute peak
results and times for the selected node / element Entity and Component or the
selected spring-mass system Result and Entity.

Results available include displacements, velocities, accelerations, dynamic
amplification factors and reactions for nodes, forces/moments, stresses/stress
resultants and strains/strain resultants for elements and vertical displacement,
velocity, acceleration and force for spring-mass systems

When processing nodes or elements an Envelope of the peak results can also be
obtained for all components of the current result Entity. These highlight the
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individual nodes or element Gauss points/nodes/ends in the chosen set of nodes
or elements where peak results occur for each of the earthquakes or speeds
analysed.

For nodes or elements the type(s) of output generated depends on the options
selected in the node / element selection section of the dialog as follows.

Q Individual output
Individual peak results for all of the chosen nodes or elements are generated.

O Sum of chosen items
Peaks of the summed results for the chosen set of nodes or elements are
generated. If Envelope has been selected an envelope of the individual peak
results is also displayed in a Notepad application.

O Average of chosen items
Peaks of the averaged results for the chosen set of nodes or elements are
generated. If Envelope has been selected an envelope of the individual peak
results is also displayed in a Notepad application.

When processing spring-mass systems individual peak summary results for the
chosen system(s) are always generated.

Note. The options Positive/Negative and Absolute are not available for selection in a
seismic analysis.

Note. Pcak summaries are not available for spring-mass systems when Result is set to
Path surface profile or Entity is set to Position

Note. The option Envelope is only available for selection when either Sum of chosen
items or Average of chosen items is selected. Envelope is not available when spring-
mass systems are being processed.

QO Secondary response spectra (SRS)
Secondary response spectra (SRS) outputs secondary response spectra based on
the acceleration response for nodes. SRS output is not available for
displacements, velocities, dynamic amplification factors or reactions at nodes
and is not a valid option for elements or spring-mass systems. SRS output can
only be used when both Node and Individual items are selected.

O Modal combination/factor history

Modal combination/factor history outputs modal factors for the response of the
structure at each time step of the analysis. The output takes the form of a
VBScript file which can be imported into Modeller to define Modal
Combinations of the modes of vibration.

O Generate graphs in Modeller
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Generate graphs in Modeller presents the results from the IMDPlus analysis as
graphs immediately after completion of the analysis. The earthquake or speed to
graph is selected from the list of available records.

QO Generate textfile output
Generate textfile output saves the IMDPIlus results to the \SLUSAS Installation
Folder>\Projects\<Model Name>\Associated Model Data\<Model Name>
directory in text format. These results can be archived or imported into
additional graphing packages.

Response Time History

The time history results are computed by IMDPlus for the earthquake or speed
specified in the output control dialogs shown in the preceding section. Examples of time
history plots for an individual node and spring-mass system are shown in following
figures.
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Moving Mass Analysis Time Histories

Peak Response Summary

The peak response summaries are computed by IMDPlus for all of the earthquakes or
speeds included in the analysis. Examples of peak output for an individual node and
spring-mass system are shown in following figures.
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Note. Peak response summary graphs can only be generated in a moving load or
moving mass analysis. For a seismic analysis the results are presented in tabular format.
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Secondary Response Spectra (SRS)

Secondary Response Spectra (SRS) are computed for the selected nodes from the time
history acceleration responses. The damping ratio range for the SRS calculations along
with the frequency resolution are accessed via the Modify... button. In this dialog the
minimum and maximum damping ratios can be entered along with the damping ratio
increment. Control is also provided over the resolution of the SRS results computed.
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SRS Control

SRS damping contral

Please enter the damping range over which
the SRS calculations are to be camred out

Mirimum damping  |5.0 %

Maximum damping %

5.0
D amping increment an %
100 3:

SRS resolution contral

Mumber of frequencies
per decade (log-zcale)

Ok | Cancel | Help |

Examples of SRS plots are shown in the following figures:
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Modal Combination/Factor History

Modal combinaton/factor history outputs modal factors for the response of the structure
at each time step of the IMDPlus analysis. The modal combination history options are
accessed via the Options... button. In this dialog the minimum mass participation
factor percentage to include in the exported modal combinations can be defined.

Modal Combination History Options

”Mudal combination options

Minimum mass participation factor percentage to l— o
include in exported modal combinations 10 =

(1] | Cancel | Help |

The output takes the form of a VBScript file which can be imported into Modeller to
define modal combinations. These combinations can then be used to visualise the
deformations and produce contour plots of entities other than velocities and
accelerations, such as the examples shown in the following figures.
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Note. Importing all modal combinations could take significant time. For inspecting
key times during the analysis the required combination information can be extracted
from the original VBScript file and placed into a user defined VBScript file.

0.372E9ES
0.4GBZES
05645453

. 086278163
a5

Vertical displacement plot for a time of 1.0s

« = 2000000000

Vertical displacement plot for a time of 2.0s

Generate Textfile Output

If the option Generate textfile output is selected the results from the IMDPlus analysis
will  remain in the \<LUSAS Installation Folder>\Projects\<Model
Name>\Associated Model Data\<Model Name> directory after completion of the
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analysis. This allows the IMDPlus results to be archived and exported to additional
graphing packages. If graphs are being generated in Modeller, the output format for
these text files is the default IMDPIlus format, which has all of the QA information
placed in the header of the file and the results written in space delimited format. If
however the option to Generate graphs in Modeller is switched off additional output
formats become available via the Options... button which opens the following dialog.

Text Dutput Format Control

Flease select output format

* Fired width space delimited format W Include 4 headers

L5V format Set OA infa..

" Tab delimited format

Ok Cancel Help

The formats supported are:

U Fixed width space delimited format (IMDPlus default). Additional options are
available to exclude the QA headers and set the QA information.

U Comma Separated Variable (CSV) format.

U TAB delimited format.

For all text output formats, the extensions of the files indicate the results entity. The
following list describes the output file extensions used by IMDPlus:

*.dsp - Displacements/Rotations
*.vel - Velocities/Rotational Velocities
*.acc - Accelerations/Rotational Accelerations

*.daf - Dynamic Amplification Factors

*.rct - Force/Moment Reactions
*srs - Secondary Response Spectra
*fce - Forces/Forces and Moments
*.str - Stresses/Stress Resultants
*.stn - Strains/Strain Resultants

*pos - Positions of Spring-Mass Systems

*.cfc - Vertical Forces for Spring-Mass Systems

56



Elements Supported By IMDPIus

*sum - Peak response summary

Elements Supported By IMDPlus

Results for the following elements can be output and graphed directly from IMDPlus.
Elements that are excluded from this list and are valid for 2D/3D eigenvalue analyses
can still be used in an IMDPlus analysis but the results for these unsupported elements
must be obtained through the modal combinations facility available in IMDPIus. All
element output follows the default LUSAS Solver output directions (local or global) for
the element types below. For further information please refer to the LUSAS Element
Reference Manual.

O Bar Elements (Gauss Point Results)
BAR2 - 2D 2-noded Bar
BRS2 - 3D 2-noded Bar

O Beam Elements (End Results)
BEAM - 2D Engineering Thick Beam
BMS3 - 3D Engineering Thick Beam
BTS3 - 3D Thick Beam
BMI21 - 3D Thick Beam
BMI22 - 3D Thick Beam
BMI31 - 3D Thick Beam
BMI33 - 3D Thick Beam

O 2D Continuum Elements (Gauss Point Results)
TPM3, TPM6, QPM4, QPMS - 2D Plane Stress
QPM4M - 2D Plane Stress (Enhanced Strain)
TPK6, QPKS8 - 2D Plane Stress Crack Tip
TPN3, TPN6, QPN4, QPNS - 2D Plane Strain
QPN4M - 2D Plane Strain (Enhanced Strain)
TNK6, QNKS8 - 2D Plane Strain Crack Tip

O 3D Continuum Elements (Gauss Point Results)
TH4, TH10, PN6, PN12, PN15,
HX8, HX16, HX20 - 3D Solid
HX8M - 3D Solid (Enhanced Strain)

Q Thin Shell Elements (Nodal Results)
TS3, QSI4 - 3D Flat Thin Shell
SHI4 - 3D Flat Thin Box Shell

O Thick Shell Elements (Gauss Point Results)
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TTS3, TTS6, QTS4, QTS8 - 3D Thick Shell

O Joint Elements (Gauss Point Results)
JNT3 - 2D Joint Element for Bars, Plane Stress and Plane Strain
JPH3 - 2D Joint Element for Engineering Beams
IJNT4 - 3D Joint Element for Bars and Solids
JSH4 - 3D Joint Element for Engineering Beams and Shells
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Description

Seismic Analysis of
a 2D Frame (Time
Domain)

For software product(s): | All
With product option(s): IMDPlus
Note: The example exceeds the limits of the LUSAS Teaching and Training Version.

Description

This example examines
the seismic response of
a 2D plane frame
founded on an elastic
medium. The model is
an extension of the
Seismic Response of a
Plane Frame example.

Units used are N, m,
kg, s, C throughout.

Objectives

The output requirements of the analysis are:

U Displacements, velocities and accelerations at the top of the tower
O Secondary response spectra at the top of the tower
U Forces and moments in a column at the base of the tower

O Average forces/moments and peak forces/moments from all of the columns at
the base of the tower
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Keywords

Seismic, time domain, response, mass participation, interactive modal dynamics,
excitation, eigenvalue, Secondary Response Spectra.

Associated Files

O IMDPIlus 2D Tower.mdl Model file of the structure.

U horizontal.prn and vertical.prn define horizontal and wvertical
earthquake accelerations. These two files contain two earthquake records each;
one for the 1940 El Centro earthquake and one for the 1994 Northridge
earthquake.

Discussion

The Seismic Response of a Plane Frame is revisited in this example. The frame is
founded in a plane strain elastic medium and the response of the structure is evaluated
in the time domain using IMDPlus.

The model is comprised of thick beam elements for the concrete columns, beam
members, and steel diagonal bracing members, which have pinned end connections.
The number of beam elements representing the components of the structure has been
increased from 1 per line to 4 per line to provide greater definition of the deformed
shapes. In addition to this modification, all support restraints have been removed from
the frame and an additional 4.5 m length has been added to the base of each column to
allow embedment of the column bases into the elastic medium.

The elastic medium is modelled as a 108m by 20m block which is fully restrained along
its base and with cyclic translation constraints assigned to the sides. These constraints
provide support to the sides of the elastic medium without the need to apply physical
restraints, thus allowing direct and shear behaviours in the elastic medium.

The seismic response analysis is performed in two distinct stages. A natural frequency
analysis is performed first. This is used to calculate the first 50 natural modes of
vibration of the combined structure and elastic medium. The eigenvalues, frequencies
and eigenvectors (mode shapes) are stored and used in the subsequent IMDPlus
analysis. Although the natural frequencies are obtained from an eigenvalue analysis any
information regarding the magnitudes of deformations or stresses / moments is non-
quantitative.

The second phase of the analysis utilises the IMDPlus option which performs enhanced
time domain solutions using Interactive Modal Dynamics (IMD). This is an alternative
to performing a spectral response analysis and allows the excitation of the structure
using acceleration time histories instead of spectral excitation curves.

In the IMDPIlus solution, the structure is subjected to a support condition excitation
governed by time histories of acceleration in the model global axes. In this example this
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Modelling

| File

Open...

Modelling

is assumed to act along the base of the elastic medium in the form of horizontal and
vertical accelerations. It should, however, be noted that no deconvolution of the records
has been carried out to convert the surface responses recorded for these earthquakes to
at-depth acceleration time histories to be input into the analysis. As a consequence, the
ground level accelerations in the analysis will not correspond to the measured values.
As stated previously, two earthquake records are used in the analysis, the first being the
1940 El Centro earthquake and the second being the 1994 Northridge earthquake. The
two earthquake responses are computed during a single analysis. Only the first 10
seconds of each seismic event is analysed in this example.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.

Building and loading the model

e To create the model, open the file IMDPlus 2D Tower.mdl located in the
\<LUSAS Installation Folder>\Examples\Modeller directory. Click the OK
button if the Open File From Previous Version dialog appears.

After a short while the following view of the model of the building will be displayed.
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Seismic Analysis of a 2D Frame (Time Domain)

e In the \<LUSAS Installation Folder>\Projects\ folder create a new directory
called IMDPIlus 2D Tower

e Save the model into this new folder as IMDPIlus 2D Tower. This helps keep all
relevant IMDPlus created files separate from other analyses and is good practice.

Note. No static structural loading is required for this analysis because only the
dynamic loading is considered during the results processing based on the results from
the natural frequency analysis.

The modelling will now be completed by defining the controls necessary to extract the
natural frequencies.

Defining Eigenvalue Controls

Eigenvalue controls are defined as properties of the loadcase.

o In the & Treeview expand Analysis 1 then right-click on Loadcase 1 and select
Eigenvalue from the Controls menu.

The Eigenvalue dialog will appear.

e Set the Number of eigenvalues as 50

e Ensure the Shift to be applied is set as 0

e Ensure the Type of eigensolver is set as Default

Note. Eigenvalue normalisation is set to Mass by default. This is essential if the
eigenvectors are to be used for subsequent IMD analysis.

e C(Click the OK button to finish.

El Save the model file.

Running the Analysis

e With the model loaded click the Solve button ;l and the Solve Now dialog will be
displayed.

e Click the OK button to run the analysis.

A LUSAS Datafile will be created from the model information. The LUSAS Solver
uses this datafile to perform the analysis.
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Viewing the Results

If the analysis was run from within LUSAS Modeller the results will be loaded on top
of the current model and the loadcase results for each eigenvalue can be seen in the
Loadcase panel of the Treeview. Eigenvalue 1 is set to be active by default.

Plotting Mode Shapes

e Turn off the display of the Mesh, Geometry and Attributes layers in the
Treeview.

e With no features selected click the right-hand mouse button in a blank part of the
graphics window and select the Deformed mesh option to add the deformed mesh

layer to the Treeview. Select the Visualise tab and turn off the Beam end
releases option. Click the OK button to accept the remaining default values and
display the deformed mesh for Eigenvalue 1.

e At the bottom of the Treeview select the Window summary option and click
the Details... button. In the Window summary properties dialog set the position to
(50,-10) and click the OK button to return to the graphics window.

Scale: 1: 44927
Zoom: 100.0

Eye: (0.0,0.0,1.0)

Eigenvalue analysis

Loadcase: 1:Eigenvalue 1

Results file: IMDPIUS 2D Tower-Analysis 1.mys
Eigenvalue: 143.134

Natural frequency: 190411

Error norm: 10.8045E-12

Maximum displacement 9.97341E-3 at node 939
Deformation exaggeration: 209.054
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Note. The mode shape may be inverted. This is because the sense is arbitrary since
during vibration the deformed shape will appear in both directions.

Note. The window summary displays the values of the eigenvalue and the natural
frequency and also a value for displacement at a node. It should be noted that the
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displacement value is non-quantitative and is related to the amount of mass in a
particular mode using the mass normalisation technique. Therefore the only items that
can be found using a basic eigenvalue analysis are the frequency and the mode shape.

By setting each Eigenvalue to be active the deformed mesh can be seen for all mode
shapes.

o In the & Treeview right-click on Eigenvalue 2 and select the Set Active option.
The deformed mesh plot for Eigenvalue 2 will be displayed.

Printing Eigenvalue Results

Eigenvalue results for the whole structure can be displayed in the Text Output window.
e Select Active and press Next
e Select entity None of type Eigenvalues and click Finish

The Eigenvalue results will be printed to the Text Output window. For inspection only
the first 10 modes are shown here. Error norms may vary.

MODE EIGENVALUE FREQUENCY ERROR NORM
1 143.134 1.90411 0.108045E-10
2 1479.54 6.12185 0.402905E-06
3 7142.50 13.4507 0.142970E-09
4 11469.1 17.0445 0.834811E-09
5 13603.1 18.5626 0.131186E-08
6 15305.2 19.6897 0.147175E-06
7 22093.1 23.6564 0.464346E-06
8 23569.4 24.4340 0.139975E-06
9 23646.6 24.4740 0.179723E-06
10 23787.5 24.5468 0.627557E-06

Note. The frequency in Hertz can be obtained by dividing the square root of the
eigenvalue by 27, and the period of vibration in seconds is obtained using the reciprocal
of frequency (1/frequency). Values of error norm may vary from those shown.

Caution. The system eigenvectors have been normalised (in this case with respect to
mass) therefore any derived quantities such as displacement and moment are also
normalised and are not true design values.

e Close the text window by selecting the close button in the top right-hand corner of
the window.
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Checking the Mass Participation Factor

Note. In order to carry out a successful IMDPlus analysis you should ensure that a
significant proportion of the total mass has been accounted for in the analysis. This
requires checking that around 90% of the total mass has been achieved in the global
directions. If less than 90% has been achieved no further modes need to be included, if
and only if, the modes of vibration omitted cannot be excited by the input acceleration
time histories or a significant proportion of the structure is restrained by support in
these directions and therefore cannot participate in the modes of vibration. The
acceptability of the included modes of vibration will vary from analysis to analysis but
failure to check that a significant proportion of the total mass has been accounted for
may lead to important modes being missed and subsequent errors in the analysis results.

e After selecting Active, ensure Sum Mass Participation Factors is displayed in the
Type combo box and click Finish. The Sum Mass Participation Factors results will
be printed to the Text Output window.

For inspection only modes 40 to 50 will be printed here. It can be seen that the 90%
value has not been achieved and is discussed below.

MODE SUM MASS X SUM MASS Y SUM MASS Z
40 0.812738 0.589605 0.00000
41 0.812738 0.668202 0.00000
42 0.812738 0.754026 0.00000
43 0.812739 0.754159 0.00000
44 0.812741 0.754160 0.00000
45 0.812744 0.757374 0.00000
46 0.812745 0.788122 0.00000
47 0.812747 0.788903 0.00000
48 0.812760 0.789672 0.00000
49 0.812760 0.789674 0.00000
50 0.812760 0.789731 0.00000

Note. In this analysis, a significant proportion of mass is restrained along the base of
the elastic medium. For the 50 modes of vibration, 81.27% and 78.97% of the total
mass is achieved in the horizontal and vertical directions. In order to achieve 90% total
mass in both the horizontal and vertical directions 160 modes of vibration with an upper
frequency equivalent to 97.2 Hz would actually be required. However, for the purposes
of this example, the number of modes of vibration has been restricted to 50.

e Close the text window by selecting the close button in the top right hand corner of
the window.

e Use the maximise button to increase the size of the graphics window.
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Seismic Response Analysis

Seismic response calculations are performed using the IMDPlus (Interactive Modal
Dynamics) facility. This involves defining the excitation and specifying the results
required. Initially, in this example, the response of the node at the top-right corner of
the tower will be investigated.

Note. With a seismic response analysis, additional damping information may also be
set. Unlike results from a natural frequency analysis, the output values obtained from a
seismic response are design values.

e Turn off the display of the Deformed Mesh layer in the = Treeview.

e In the Treeview double-click on the Mesh layer name. Select the Visualise tab
and turn off the Beam end releases option. Click the OK button to accept all other
settings. This will turn on the layer in the graphics window.

e Zoom-in to the top of Select this node :>7

the tower and select
only the top-right

node.
Scale: 1: 424 361

The main tower members ~ Zoom: 235718

have been meshed with 4 Eye: (0.0,00,1.0)

line mesh divisions SO  Eigenvalue snalysis
each line will have 3 Loadcaze: 1:Eigenvalue 2
nodes along its length in
addition to one at either
end.

Results file: IMDPus 20 Tower~Analysis 1 (Structural).mys
Eigenvalue; 1.47934E3

Matural fregquency: 612185

Error norm: 0.402905E-6

Defining the Seismic Parameters

Note. To simplify the use of IMDPlus (and provide an alternative to picking
IMDPlus menu selections from the Utilities menu) for the rest of the example it is
recommended that the IMDPIus toolbar is enabled in LUSAS Modeller. To do this
select the View > Toolbars... menu command and enable the IMDPIus option in the
list and click Close.

=
e If the IMDPIlus toolbar has been enabled then click on the Z==1 Seismic analysis
button to enable the other relevant toolbar buttons (the seismic tool button) shortcuts
to the IMDPlus dialogs.
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|U|ti|':\t/il‘|935P| e Open the IMDPlus Seismic Analysis Control dialog through the menu or click on
us >
[Seismic.. the ;l button in the toolbar.

The input for the seismic analysis is defined on the IMDPlus Seismic Analysis Control
dialog. The input consists of the earthquake acceleration records, included modes and
damping along with interpolation options.

IMDFPlus Seismic Analysis Control

— Earthquake input
#-direction eathquake record(s) |I:: SLUSAST51ME vamplesiModelershorizont Browse...

‘Y-direction earthquake record(s] |I:: SLUEASTSNE samples\Modellervertical Browse. ..

il

Z-direction earthquake record(s] | Browsze,..

Direction Factors % [1.0 ' |0.GE6ET z |

— bode/damping contral
Total participating mass

Included modes: I Al Modify... | % Direction I 81.27 =

- ' Direction I T8A7 X
v Default damping I 50 % Modify... |
Z Diirection I 0o 4

— Frequency interpolation

Advanced solution options Madify... |

Al frequencies included " Linear interpolation of recards

 Limit frequencies to Myquist frequency © Cubic spline interpolation of recards

Time step I

< Back | Mext > | Cancel | Help |

e In the Earthquake Input section, for the X-Direction Earthquake Record(s)
browse to the \<Lusas Installation Folder>\Examples\Modeller directory and
select horizontal.prn

e For the Y-Direction Earthquake Record(s) browse to the \<Lusas Installation
Folder>\Examples\Modeller directory and select vertical.prn

e Ensure the Direction Factors in the X and Y directions are set to 1 and 0.66667

e In the Mode/Damping Control section, ensure Included modes is set to All. If this
is not the case, click on the Modify... button and turn the All modes option on.

e Ensure Default damping (5%6) is selected. If a different damping is displayed, click
on the Modify... button and set the Default damping to 5
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e In the Frequency Interpolation section, click on the Modify... button to change the
advanced solution options. Click the Defaults button to set the default options and
click the OK button.

¢ Ensure the All frequencies included option is selected.

e Click the Next button to proceed to the IMDPlus Output Control dialog. When
prompted that less than 90% total mass participation has been detected choose Yes
since we are aware of this (see Checking the Mass Participation Factor).

The IMDPlus Output Control dialog will then be displayed.
Notes relating to the IMDPIlus Seismic Analysis Control dialog

On the Seismic Analysis Control dialog the Browse buttons can be used instead of
entering the directional earthquake file names. As each file is loaded, the contents are
checked to ensure that they are in the correct format.

Under the Modify dialog for the modes, individual modes can be included or excluded
from the seismic analysis and total mass participations for the excitation directions are
reported.

Under the Modify dialog for the damping, control over the inclusion of over-damped
modes can be adjusted if viscous modal damping has been included in the original
eigenvalue analysis. To include viscous modal damping, Rayleigh damping parameters
must be defined in the material properties assigned to the model or a separate damping
attribute defined and assigned to the model. This allows direct mirroring of step-by-step
dynamic solutions and the inclusion of frequency dependent damping.

Under the Modify dialog for the advanced solution options, the time integration scheme
used in the IMDPlus analysis can be selected. Either a Hilber Hughes Taylor (HHT)
scheme or Duhamel’s integral can be utilised.

Four methods of interpolation are available in IMDPlus. The default All frequencies
included will solve the seismic analysis using all of the frequencies included in the
eigenvalue analysis. Limit frequencies to Nyquist frequency will limit the included
frequencies to the Nyquist frequency which is governed by the time step of the
earthquake records and defined as 1/28t. Linear interpolation of records allows the
specification of an alternative time step for the analysis where the earthquake records
are linearly interpolated to this time step. Cubic spline interpolation of records allows
the specification of an alternative time step for the analysis where the earthquake
records are interpolated with a cubic spline to this time step. This last form of
interpolation should generally not be used for measured earthquake records as it can
smooth the peak responses but is often more appropriate for synthesised earthquake
records.
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Displacement Plots

The displacement of the top of the tower will be investigated initially. Enter the
following information into the IMDPlus Output Control dialog.

Select Node and select Extent as Individual

Choose Node number 939 from the drop-down list (or your node number if
different). This is the node at the top-right of the tower.

Select results entity Displacement and component DX & DY

Ensure Individual items is selected. Sum of chosen items and Average of chosen
items will not be available as an individual node is being processed.

Ensure Response time history is selected.
Select Peak response summary

Ensure Generate graphs in Modeller is selected and specify the Earthquake to
graphas1

The dialog should look like this:

IMDPlus Seismic Dutput Control

—Mode/element selection

% Mode " Element Entity IDispIacement |
Extent Ilndividual vl Companent |D>< % DY j
Mode 939 - v Individual items

I™ | Sumof chozen items

] Ayerage of chosen items

—Output contral

¥ Response time history

¥ Peak response summary ) Positive/negative. [T Envelope
%1 ihzolute

[ Secondary response spectra [SRS) Fmdifi... |

[~ Modal combination/factor histany [Dpticrs... |
¥ Generate araphs in Modsller Earthquake ta graph |1 'l

[ Generate textfile output [Dptions... |
¢ Back | Finizh I Apply | Cancel | Help |
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e  Click the Apply button to proceed.

An IMDPlus analysis will run and after a short while the horizontal (DX) and vertical
(DY) displacements for the point at the top of the tower are displayed on the graph for
the first 10 seconds of the 1940 El Centro earthquake. (Earthquake 1)

Peak displacements are also output to Notepad and indicate absolute peak
displacements of 0.085 m in the X-direction, 0.006 m in the Y-direction, a peak rotation
0f 0.003 radians and an absolute peak resultant displacement of 0.086 m (Record 1).

Mode 939, Earthquake Combination 1: Translational Displacement Time Histary

Displacement

Response Time

#*
#*

#F +

# | rRecord = 001 |

#F +

#*

# Entity Time value
Peak_Pos_Dx L 0B0000000 0.8045374752E-001
Peak_Meg_Dx 130000000 -0, 8537246821e-001
abs_Peak_Dx 130000000 LBR3VI46821E-001

125000000 LO614023646E-002
07000000 -0, 5391873880E-002

0
Peak_Pos_Dv 0
0
L2 5000000 0. 568140253840E-002
0
0
0
0

Peak_Meg_Dv
Abs_Peak_ Dy
FPeak_Pos_THZ
Peak_Meg_THZ
Abs_Peak_THZ
Abs_Peak_RSLT

130000000 25726873 03E-002
065000000 -0, 25001711 74E-002
130000000 25726873 03E-002
130000000 L8555481793E-001

[ R L NN S S L |

Note. Displacements are relative to the supports.

e Close the Notepad application and graph window.
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[IMDPIus
|Seismic...

If the IMDPlus toolbar has been enabled,

e Click on the EI button in the toolbar to open the IMDPlus Output Control dialog

If the IMDPIlus toolbar is not enabled,

e Open the IMDPlus Seismic Analysis Control dialog through the menu and click

Next

> to keep the existing analysis control settings and open the IMDPlus Output

Control dialog.

In the IMDPIlus analysis we have analysed two earthquake combinations at the same

time.

We are therefore also interested in the displacement response of the top of the

tower for the second earthquake.

Enter the following information into the IMDPlus Output Control dialog:

e Select earthquake 2 in the Earthquake to graph list box.

e Click the Apply button to proceed.

The horizontal (DX) and vertical (DY) displacements for the point at the top of the
tower are displayed on the graph for the first 10 seconds of the 1994 Northridge
earthquake. Peak displacements are also output to Notepad and indicate absolute peak
displacements of 0.026 m in the X-direction, 0.002 m in the Y-direction, a peak rotation

0f 0.001

0.03
0.025
0.02

0015 f----4
0.01 |-

0.005

Displacernent
[}

-0.005

001 oo
0015 |-
o0l
005 |-

-0.03

— DX
—DY

radians and an absolute peak resultant displacement of 0.026 m (Record 2).

Mode 939, Earthquake Combination 2: Translational Displacement Time History

= W D

Y- .

Response Time
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|IMDPIus
|Seismic...

#*
#

#F +

# | Record = 002 |

#F +

#*

# Entity Time value
Peak_Pos_Dx G, 5G0000000 0.21255615383E-001
Peak_Meqg_Dx 9. 34 5000000 -0,2602101143E-001
Abs_Peak_Dix 9. 34 5000000 0.2602101143E-001
Peak_Pos_Ov 9. 355000000 0.2024933080E-002
Peak_Neg_DY 9, 600000000 -0.1693798527VE-Q02
Abs_Peak_Dy 5. 355000000 0.2024933080E-002
Peak_Pos_THZ 9. 355000000 0.9072047995E-003
Peak_Meqg_THZ 9, 600000000 -0, 77638117 24E-Q03
Abs_Peak_ _TH=Z 5. 355000000 0.9072047995E-003
Abs_Peak_ RSLT 9. 34 5000000 0.26009322984E-001

e Close the Notepad application and graph window.

If the IMDPlus toolbar has been enabled,

e Click on the El button in the toolbar to open the IMDPIus Output Control dialog
If the IMDPIus toolbar is not enabled,

e Open the IMDPlus Seismic Analysis Control dialog through the menu and click
Next > to keep the existing analysis control settings and open the IMDPIus Output
Control dialog.

Velocity Plots

In addition to the displacement response of the top of the tower we are also interested in
the velocities experienced by the tower. Enter the following information into the output
control dialog.

e Select Velocity results of VX & VY
e Select earthquake 1 in the Earthquake to graph list box
e  Click Apply to proceed

The horizontal (VX) and vertical (VY) velocities of the top of the tower are displayed
on the graph for the first 10 seconds of the 1940 El Centro earthquake. Peak velocities
are also output to Notepad and indicate absolute peak velocities of 1.13 m/s in the X-
direction, 0.085 m/s in the Y-direction, a peak rotational velocity of 0.039 rad/s and an
absolute peak resultant velocity of 1.13 m/s (Record 1).
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Mode 939, Earthguake Combination 1: Translational Yelocity Time History

Velocity

Response Time

—
—y

#*

#*

#F +

# | Record = 001 |

#F +

#*

# Entity Time
Peak_Pos_wx 2. 265000000
Peak_NeE_vx 2. 005000000
Abs_Peak_wx 2.2a5000000
Peak_Pos_wyY 1.995000000
Peak_NeE_VY 2. 295000000
Abs_Peak_wy 2.295000000
Peak_Pos_RVZ 2. 020000000
Peak_Meg_ RVZ 2. 270000000
Abs_Peak_RvVZ 2. 270000000
Abs_Peak_RSLT 2.2a5000000

Note. Velocities are relative to the supports.

e Close the Notepad application and graph window.

If the IMDPlus toolbar has been enabled,

value

1.130035452
-0.9632754105

1.130035452
0,.80425214a7E-00L
-0.8502032703E-001
0, 8502032703E-001
0,3271a0aa3%E-00L
-0.391a53%a71E-00L
0.3%91a5%39a71E-00L

1.13258%1352

e C(Click on the EI button in the toolbar to open the IMDPlus Output Control dialog

If the IMDPlus toolbar is not enabled,

e Open the IMDPlus Seismic Analysis Control dialog through the menu and click
Next > to keep the existing analysis control settings and open the IMDPIlus Output

Control dialog.
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Acceleration and Secondary Response Spectra Plots

The acceleration response of the top of the tower is now required. Enter the following
information into the output control dialog.

Select Acceleration results of AX & AY
Select Secondary Response Spectra (SRS)
Click on the Modify... button to bring up the SRS Control dialog.

On the SRS Control dialog set the Minimum damping and Maximum damping to
5.0 and the Damping increment to 0.0

Click the OK button and Yes to confirm that only a single damping ratio is to be
used

Click the Apply button to proceed.

When the IMDPlus analysis is finished select No when asked whether to show
average, maximum and minimum SRS envelopes.

The horizontal (AX) and vertical (AY) accelerations of the top of the tower are
displayed on the graph for the first 10 seconds of the 1940 El Centro earthquake. Peak
accelerations are also output to Notepad and indicate absolute peak accelerations of
15.089 m/s®> in the X-direction, 5.937 m/s* in the Y-direction, a peak rotational
acceleration of 1.56 rad/s> and an absolute peak acceleration of 15.24 m/s* (Record 1).

Acceleration

Mode 939, Earthguake Combination 1: Translational Acceleration Time History

---------------------------------------------------------------------------------------------------------------

,,M ,h '

Response Time
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#

#

#—_— +

# | rRecord = 001 |

#—_—— +

#

# Entity Time value
Peak_Pos_Ax 4. 820000000 15. 080907716
Peak_Meg_Ax 2.365000000 =14, 07786654
Abs_Peak_ax 4. 820000000 15. 08907714
Peak_Pos_ay 3. 385000000 5.9366010684
Peak_Meg_aY 3.4210000000 -5.754584426
Abs_Peak_ay 3.3B5000000 5.5836010684
Peak_PoOs_RAZ 3.480000000 1.5590971700
Peak_Neg_RAZ 1.235000000 -1.4575953105
Abs_Peak_RaAZ 3480000000 1.5590971790
Abs_Peak_RsSLT 4., 820000000 15.24035142

Secondary Response Spectra are also generated for the horizontal and vertical
directions in two additional graphs. These graphs represent the peak acceleration
responses of a range of single degree of freedom oscillators with known natural
frequencies and damping should they be attached to the node at the top of the tower.

5.0000% Darmped Secondary Response Spectrumn for Mode 939

Spectral Acceleration In X Direction

Frequency (Hz)

Earthquake Combination 1
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IMDPlus
Seismic...

5.0000% Damped Secondary Response Spectrurn for Mode 939

Spectral Acceleration In ¥ Direction

Frequency (Hz)

Earthguake Combination 1

e Close the Notepad application and graph windows.

Displaying Individual Element Results

In the previous section the displacement, velocity and acceleration response of the top
of the tower were investigated. Now, forces and moments in one of the columns of the
structure at ground level will be evaluated.

p :
il In the LUSAS graphics window re- Select this element

size the display to show the whole tower.

El Zoom-in to the base of the tower and
select the element immediately above
ground level in the second column from
the right.

The main tower members have been
meshed with 4 line mesh divisions so each
line will have 4 elements along its length.

e Click on the El button in the toolbar to open the IMDPlus Output Control dialog
If the IMDPlus toolbar is not enabled,

e Open the IMDPlus Seismic Analysis Control dialog through the menu and click
Next > to keep the existing analysis control settings and open the IMDPlus Output
Control dialog.

Enter the following information into the IMDPlus Output Control dialog:
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Select Element and ensure Extent remains selected as Individual

Choose Element number 656 from the drop-down list (or your element number if
different).

Select element End number 2 which corresponds to the ground level. (Note that line
directions can be viewed to ascertain which is end 1 or end 2 of a line).

Select Force/Moment - Thick 2D Beam results of Fx

Ensure Individual items remains selected. Sum of chosen items and Average of
chosen items will not be available as an individual element is being processed.

Deselect Peak response summary

Click the Apply button to proceed.

The time history of the axial force (in N) in the column is displayed on the graph for the
first 10 seconds of the 1940 El Centro earthquake. Similar graphs can also be generated
for the shear force and bending moment by selecting Fy (in N) and Mz (in Nm) from
the output control dialog.

Axial Force In Elerment Local Axis

1.3e6
1.1e6

900000 |--
700000 |--

500000
300000

100000 f----4--- 5P - PERON) SR R S e
300000 |- dem b e pet b

-500000
-7oo0000

-500000
[=]

Thick Beam Element 836, Earthquake Combination 1: Force Time Histary

Response Time

Fx (End 2)

Close the graph window.

e C(Click on the EI button in the toolbar to open the IMDPlus Output Control dialog

If the IMDPIlus toolbar is not enabled,

| utilities .
|IMDPIus >
Seismic...

Open

the IMDPlus Seismic Analysis Control dialog through the menu and click

Next > to keep the existing analysis control settings and open the IMDPIlus Output
Control dialog.
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[IMDPIus
|Seismic...

e Select Force/Moment - Thick 2D Beam results of Fy

e Click the Apply button to proceed.

Thick Beam Element 556, Earthquake Combination 1: Force Time History

BO00 ;
5000 |-----
4000
3000
2000
1000

-1000
-2000
-3000 f---
-4000
-5000

Shear Force In Element Local Axis

-6000 2
e o
Response Time
—Fy(End 2

e Close the graph window.

e Click on the El button in the toolbar to open the IMDPlus Output Control dialog
If the IMDPlus toolbar is not enabled,

e Open the IMDPlus Seismic Analysis Control dialog through the menu and click
Next > to keep the existing analysis control settings and open the IMDPlus Output
Control dialog.

e Select Force/Moment - Thick 2D Beam results of Mz
e Click the Finish button to finish output processing of the individual element results.

e Click Yes when asked whether to free up disk space by deleting the temporary files
created by IMDPlus.
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Thick Bearn Element 536, Earthquake Combination 1: Bending Morment Time History
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e Close the graph window.

Displaying Results for a Selected Set of Elements

The example analyses presented in the previous sections have all utilised individual
nodes or elements of the structure. In this section a set of beam elements will be
selected and analysed in order to evaluate the average forces/moments and peak
forces/moments from the bases of all the columns of the tower.

o
il In the LUSAS graphics window re-size the display to show the whole tower.

e With no features selected click the right-hand mouse button in a blank part of the
graphics window and select the Labels option to add the labels to the Treeview.

e On the Properties dialog select the Element > Name check box and the Label
selected items only check box.

e Click the Font... button and select Font: Arial, Font style: Bold, Size: 20 and click
OK.

e Click OK to return to the graphics window.

El Zoom-in to the base of the frame and select the beam elements immediately above
ground level for all of the columns in the structure, as shown in the following figure
(your element numbers may be different from those shown in the diagram).

Note. Use the Ctrl or Alt keys to select multiple elements in the model.
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Note. Only elements of the same type, for example, thick beam elements, continuum
elements or thick shell elements can be used in a set of IMDPlus elements. However,
the element set may contain elements with different numbers of Gauss points or nodes.

Select the elements shown

e Open the IMDPlus Seismic Analysis Control dialog through the menu or click on
the ;l button in the toolbar

e On the IMDPlus Seismic Analysis Control dialog click the Next button to accept the
previously defined values. When prompted about the total mass participation click
the Yes button to continue.

Enter the following information into the IMDPlus Output Control dialog.

e Select Element and change Extent to Selected using the drop-down list. This
chooses the eight beam elements at the base of the frame for processing. These
beams were selected in the preceding step.

Note. As Extent has been set to Selected the drop-down lists Element and End are
not available for selection. In addition the element End is automatically set to All as
multiple elements are going to be processed in a single analysis.

o Select results entity Force/Moment — Thick 2D Beam of component Fx

e Deselect Individual items and select Average of chosen items as the averaged
results for the eight beam elements are going to be investigated.

e Ensure Response time history is selected
e Select Peak response summary and select Envelope

e Ensure Generate graphs in Modeller is selected and Earthquake to graph is set
tol
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The dialog should look like this:

IMDPlus Seismic Dutput Control

—Mode/element selection

= MNode = Element Entity IForcex’Moment - Thick 20 Beam j
E=tent I Selected - l Component I Fu j
Elemert (656 > I Individual iterns

™ Sum of chosen items

End All v .
[v &verage of chosen items

— Output control

¥ Response time history

¥ Peak response summary | Rasitive/negative ¥ Erwvelope
5 Shsolute

¥ | Gecondan response spectia (SHS] Mty |

™ Modal combinationfactar histary ptiars... |
¥ Generate graphs in Modeller Earthiguake to graph |1 'I

[~ Generate textfile output [ ptiomns... |
¢ Back | Finizh I Apply | Cancel | Help |

e Click the Apply button to proceed. Click Yes when asked whether you want to
process all of the selected elements.

Note. Any combination of the options Individual items, Sum of chosen items and
Average of chosen items can be used in an IMDPlus analysis, although using the
Individual items option when Extent is set to Selected or All (nodes or elements) may
produce a large number of graphs, depending on the number of nodes or elements
chosen for processing.

Note. Average of chosen items obtains results by first summing the results from the
16 beam ends of the selected elements. A simple average of this summed result is
obtained to give the element average time history of axial force from which the peak
average results are obtained.

The IMDPlus analysis will run and after a short while a graph showing the average
axial (Fx) force obtained from the selected beam elements will be displayed for the first
10 seconds of the 1940 El Centro earthquake (Earthquake 1). The average axial force in
the beam elements is shown in the following figure.
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Thick Beam Element Set Avg, Earthquake Combination 1: Farce Time History
33000 I I I I I I I I I I I I I I I
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Peak results for the averaged element forces and moments are displayed in Notepad in
file peak forceSet Avgl.sum. These indicate a peak positive average axial (Fx) force
of 32.7kN at solution time 0.98 seconds and a peak negative average axial (Fx) force of
-36.1kN at 1.01 seconds for the 1940 El Centro earthquake (Record 1), as shown in the
following figure.

#*

*

#r——_———— +

# | Record = 001 |

# ot +

*

# Entity Time value
Peak_Pos_Fx 0. 5500000000 32659.52388
Peak_mMeag_Fx 1. 010000000 —-36B075. 22195
Abs_Peak_Fx 1. 010000000 36075,22195
Peak_Pos_Fy 2.105000000 5585.413288
Peak_reg_Fy 2. 905000000 =5007, 747700
Abs_Peak_Fy 2. 905000000 5997.747790
Peak_Fos_Mz 2.14 5000000 B350, 000014
Peak_reg_mMz 2. 905000000 -8270.495031
abs_Peak_mz 2.14 3000000 83550, 900514

An envelope of the peak results from the selected beam elements is displayed in
Notepad in file peak forceSetl.sum. Results for the 1940 El Centro earthquake (Record
1) are shown in the following figure. A peak positive axial (Fx) force of 1019.1kN
occurs at time 2.13 seconds at end 1 of element 656. A peak negative axial (Fx) force of
-956.0kN occurs at time 2.135 seconds at end 1 of element 648.

Note. The envelope of the peak results is obtained in IMDPlus by examining the
individual results from all 16 ends of the chosen beam elements. This helps to quickly
identify the locations where the peak results occur in the selected set of elements.
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F
#

# o +

# | rRecord = 001 |

# ot +

#

# Entity Time wvalue Element End
Peak_Pos_Fx 2.130000000 1019065, 962 656 1
Peak_neg_Fx 2.135000000 -8955968,.1579 648 1
abs_peak_Fx 2.130000000 1019065, 962 656 1
Peak_Pos_Fy 2.105000000 6684, 561177 640 1
Peak_neg_Fy 2.905000000 -6985. 728050 640 1
abs_peak_Fy 2.905000000 6085, 728050 G640 1
Peak_pos_mz 2.14 5000000 15472, 76400 G640 2
Peak_neg_mz 2.905000000 -15552. 26423 G640 2
abs_peak_mz 2.905000000 15552, 26423 640 2

e Close the Notepad applications and graph windows.

e Click on the EI button in the toolbar to open the IMDPlus Output Control dialog
If the IMDPlus toolbar is not enabled,

e Open the IMDPlus Seismic Analysis Control dialog through the menu and click
Next > to keep the existing analysis control settings and open the IMDPIus Output
Control dialog.

e Select Force/Moment - Thick 2D Beam results of Mz

e Click the Finish button to finish output processing of the element results. Click Yes
when asked whether you want to process all of the selected elements.

e Click Yes when asked whether to free up disk space by deleting the temporary files
created by IMDPlus.

A graph of the average (Mz) moment obtained from the selected elements will be
displayed, as shown in the following figure.

Thick Bearn Elerment Set Avg, Earthquake Cormbination 1: Bending Mornent Time History

9000 |-
7000 -
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1000 |--
-1000
-3000 f--
-5000 f--
-7000
-9000 5

Bending Mornent About Element Local Axis

Response Time
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All of the peak averaged results displayed in Notepad will be the same as those shown
when the axial (Fx) force was analysed earlier. These indicate an average absolute peak
(Mz) moment of 8.4kNm at time 2.145 seconds (Record 1). The envelope of the peak
results indicates an absolute peak (Mz) moment of 15.6kNm occuring at time 2.905
seconds in end 2 of element 640 (Record 1).

e Close the Notepad applications and graph windows.

Save the model

El Save the model. This saves all load combinations that have been defined during
the results processing operations.

This completes the example.
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Description

Seismic Analysis of
a 3D Frame (Time

Domain)

For software product(s): | All

With product option(s): IMDPlus

Note: The example exceeds the limits of the LUSAS Teaching and Training Version.

Description

This example examines the
seismic response of a 2-storey
3D frame in the time domain.
The geometry of the structure has
been simplified to a wire-frame
or stick representation with each
of the members of the structure
being represented by a line
feature.

Units used are N, m, kg, s, C
throughout.

Objectives

The output requirements of the analysis are:

U Maximum deflections in the X-, Y- and Z-directions of a node at the top centre

of the frame

O Average deflections and peak deflections in the X-, Y- and Z-directions from all
of the unrestrained nodes in the frame
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U Peak axial force and bending moment from all of the frame beams and columns

U Deformed mesh plots associated with the maximum deflections of a node at the
top centre of the frame

U Envelopes of axial force and bending moment from modal combinations.
Keywords

Seismic, time domain, response, interactive modal dynamics, excitation,
eigenvalue, modal combination.

Associated Files

O IMDPIlus 3D Frame.mdl Model of the structure.

U e-w.prn, n-s.prn and up.prn define the east-west horizontal, north-south
horizontal and vertical earthquake accelerations for the 1940 El Centro
earthquake.

Discussion

The mesh definition used in a dynamic analysis is somewhat different from that used in
a static stress analysis. In a static analysis, and with experience, it is usually not too
difficult to estimate where the high stresses are likely to occur. These estimates can
then be used to develop a meshing strategy with a fine mesh in high stress locations and
a coarse mesh in less critical locations. For a dynamic analysis the interaction between
the stiffness and inertia forces will lead to deflected shapes which can be very different
from those expected in a static analysis.

In a dynamic analysis both stiffness and mass distribution has to be considered.
Generally, the best strategy for a dynamic analysis is to have a uniform mesh over the
entire structure. If refinement is to be carried out a coarser mesh can sometimes be used
in stiff regions. In regions that are more flexible, or where heavy masses are located, the
mesh should be more refined.

In this example the global behaviour of the building is being considered for earthquake
response. In this analysis the lower frequencies will be dominant and a relatively coarse
mesh will suffice. If the higher frequencies are important, or if a local response for
individual beams and columns is to be considered, a revised mesh with more elements
would need to be used.

The seismic response analysis is performed in two distinct stages. A natural frequency
analysis is performed first. This is used here to calculate the first 30 natural modes of
vibration of the structure. The eigenvalues (frequencies) and eigenvectors (mode
shapes) are stored and used in the subsequent seismic response analysis. In order to
carry out a seismic analysis the eigenvectors must be normalised with respect to the
mass. Although natural frequencies are obtained from an eigenvalue analysis any
information regarding the magnitudes of deformations or moments is non-quantitative.
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The second phase of the analysis utilises the IMDPlus option which performs enhanced
time domain solutions using Interactive Modal Dynamics (IMD). This is an alternative
to performing a spectral response analysis and allows the excitation of the structure
using acceleration time histories instead of spectral excitation curves. In the IMDPlus
solution, the structure is subjected to support excitation governed by time histories of
acceleration in the model global axes. In this example, the seismic excitation is applied
directly to the bases of the columns using the first 2.5 seconds of the 1940 El Centro
earthquake.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.

Building and loading the model

e To create the model, open the file IMDPlus 3D Frame.mdl located in the
\<LUSAS Installation Folder>\Examples\Modeller directory. Click the OK
button if the Open File From Previous Version dialog appears.

After a short while the following isometric view of the model of the building will be
displayed.
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e In the \<LUSAS Installation Folder>\Projects\ folder create a new directory
called IMDPIlus 3D Frame

e Save the model into this new folder as IMDPIlus 3D Frame. This helps keep all
relevant IMDPlus created files separate from other analyses and is good practice.

Note. No static structural loading is required for this analysis because only the
dynamic loading is considered during the results processing.

The modelling will now be completed by defining the controls necessary to extract the

natural frequencies.

Defining Eigenvalue controls

Eigenvalue controls are defined as properties of the loadcase.

o In the ! Treeview expand Analysis 1 then right-click on Loadcase 1 and select
Eigenvalue from the Controls menu.

The Eigenvalue dialog will appear.

e Set the Number of eigenvalues as 30

e Ensure the Shift to be applied is set as 0

e Ensure the Type of eigensolver is set as Default

Note. Eigenvalue normalisation is set to Mass by default. This is essential if the
eigenvectors are to be used for subsequent IMD analysis.

e C(Click the OK button to finish.

El Save the model file.

Running the Analysis

e With the model loaded click the Solve button ;l and the Solve Now dialog will be
displayed.

e Click the OK button to run the analysis.

A LUSAS Datafile will be created from the model information. The LUSAS Solver
uses this datafile to perform the analysis.
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Viewing the Results

If the analysis was run from within LUSAS Modeller the results will be loaded on top
of the current model and the loadcase results for each eigenvalue can be seen in the

Loadcase panel of the Treeview with Eigenvalue 1 set to be active by default.

Seismic Response Analysis

Seismic response calculations are performed using the IMDPlus (Interactive Modal
Dynamics) facility. This involves defining the excitation and specifying the results
required. With a seismic response analysis, additional damping information may also
be set. Unlike results from a natural frequency analysis, the output values obtained from
a seismic response are design values.

Initially, in this example, the response of a node at the top and in the centre of the frame
will be investigated. Node numbers will be added to the mesh display to allow
selection.

e Turn off the Geometry layer in the [FTreeview.

e With no features selected click the right-hand mouse button in a blank part of the
graphics window and select the Labels option to add the labels to the Treeview.

¢ On the Properties dialog select the Node > Name check box and click OK

e Select the node at the top and in the centre of the frame, node 61 as shown in the
following diagram
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Defining the Seismic Parameters

Note. To simplify the use of IMDPlus (and provide an alternative to picking
IMDPlus menu selections from the Utilities menu) for the rest of the example it is
recommended that the IMDPlus toolbar is enabled in LUSAS Modeller. To do this
select the View > Toolbars... menu command and enable the IMDPIus option in the
list and click Close.

=
e [f the IMDPIus toolbar has been enabled then click on the Z=1 Seismic analysis
button to enable the other relevant toolbar buttons (the seismic tool button) shortcuts
to the IMDPlus dialogs.

e Open the IMDPlus Seismic Analysis Control dialog through the menu or click on
the ;l button in the toolbar.

The input for the seismic analysis is defined on the IMDPlus Seismic Analysis Control
dialog. The input consists of the earthquake acceleration records, included modes and
damping along with interpolation options.

IMDPlus Seismic Analysis Control

— Earthgquake input
#-direction eathquake record(s) |I:: SLUSAST51ME vamplesiModellere-w. pim Browse... |

-direction eathquake record(s) |E:\LUSAS‘I51\Examples\Modeller\n-s.pm Browse... |

Z-direction eathquake record(s) |E:\LUSAS‘I51\Examples\ModelIer\up.pm Browse... |

Direction Factors % 1.0 v |10 Z 066667

— bode/damping control
Total participating mass

Included modes: I Al Modify... | % Direction I 9456 z

- ' Diirection I 9384 X
v Default damping I 5.0 # Modify... |
Z Direction I 322 %

r— Frequency interpolation

Advanced solution options Madify... |

= All frequencies included " Linear interpolation of recards

= Limit frequencies to Myquist frequency ¢ Cubic spline interpolation of recards

Time step ID.DDZE
< Back | Mext > I Cancel | Help |

e In the Earthquake Input section, for the X-Direction Earthquake Record(s)
browse to the \<Lusas Installation Folder>\Examples\Modeller directory and
select e-w.prn

90



Viewing the Results

For the Y-Direction Earthquake Record(s) browse to the \<Lusas Installation
Folder>\Examples\Modeller directory and select n-s.prn

For the Z-Direction Earthquake Record(s) browse to the \<Lusas Installation
Folder>\Examples\Modeller directory and select up.prn

Ensure that the Direction Factors are set to 1.0 in the X-Direction, 1.0 in the Y-
Direction and 0.66667 in the Z-Direction

Ensure Included modes is set to All. If this is not the case, click on the Modify...
button and turn the All modes option on.

Ensure Default damping (5%0) is selected. If a different damping is displayed, click
on the Modify... button and set the Default damping to 5

In the Frequency Interpolation section, click on the Modify... button to change the
advanced solution options. Click the Defaults button to set the default options and
click the OK button.

Select the Linear interpolation of records option and enter a time step of 0.0025
(Half the time step of the original earthquake records)

Click the Next button to proceed. When prompted about significant missing total
mass choose Yes as only 31.22% is included in the Z-Direction (vertical) for 30
modes.

Individual Node Displacements

The displacement of the top of the central column will be investigated initially. Enter
the following information into the IMDPlus Output Control dialog.

Select Node and select Extent as Individual
Choose Node number 61 from the drop-down list.
Select Displacement results of DX, DY & DZ

Ensure Individual items is selected. Sum of chosen items and Average of chosen
items will not be available as an individual node is being processed.

Select Response time history
Select Peak response summary
Select Modal combination/factor history and click on the Options... button.

Set the Minimum mass participation factor percentage to include to 1.0 and
click on OK
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e Select Generate textfile output

The dialog should now look like this:

IMDPlus Seismic Output Control

—Mode/element selection

" Mode " Element E ity IDispIacement j
Extent Ilndividual vl Camponent |D><, DY & D2 j
Nade 3 - ¥ Individual items

™| S of chasen items

™ Average of chosen items

— Output control

¥ Response time history

¥ Peak response summary = Pasitive/negative I~ | Envelope
% Absolute

[~ Secondary response spectra [SRS] fmdifiy.... |

¥ Muodal combination/factar history Optiaris... |
¥ Generate graphs in Modeller Earthgquake to araph I'I 'I

¥ Generate testfile output [phioris.. |
< Back | Finizh I Apply | Cancel | Help |

e Click the Finish button to perform the analysis.

e Click Yes when asked whether to free up disk space by deleting the temporary files
created by IMDPlus.

The horizontal (DX and DY) and vertical (DZ) displacement of the top of the column
are displayed on the graph for the first 2.5 seconds of the 1940 El Centro earthquake.
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Mode 61: Translational Displacement Time History
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—DY
DI

Peak displacements are also output to Notepad and indicate absolute peak
displacements of 0.0047 m in the X-direction, 0.0248 m in the Y-direction along with
additional output for the Z-direction and rotations about each of these axes. From this
output we can identify times of 2.4725 seconds and 2.49 seconds which correspond to
the absolute peak displacements in the X and Y directions respectively. This
information will be used in a later section to visualise the deformed shapes using modal
combinations.
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#*
#*

#Ft————————— +

# | rRecord = 001 |

#Ft——————— +

#*

# Entity Time value
Peak_Pos_Dx 2.472500000 0.4661208719E-002
Peak_Megq_Dx 1. 985000000 -0.44 509615391 E-002
Abs_peak_Dx [:::::::::> 2.472500000 0. 4661 208719E-002
Peak_Pos_DY 2.490000000 0.2475375967E-001
Peak_Meg_D¥ 2. 337500000 -0, 2302464 293E-001
abs_peak_py [ ) 2.450000000 ) 0.2475375967E-001
Peak_PFos_DZ 1.082500000 0.6606589245E-004
Peak_mMeqg_DZ 1.015000000 -0.9454571681E-004
Abs_peak_DzZ 1.015000000 0.59454571681E-004
Peak_Pos_THx 2.327500000 0.5261706667E-004
Peak_Meg_THx 2. 500000000 -0, 53465704 918E-004
Abs_Peak_THx 2. 500000000 0. 5468570491 8E-004
Peak_Pos_THY 2.470000000 0.1598727930E-004
Peak_Meg_THY 2. 002500000 -0.1607368682E-004
Abs_peak _THy 2. 002500000 0.1607368682E-004
Peak_Pos_THZ 2. 380000000 0.4129028145E-003
Peak_Megq_THZ 2. 480000000 -0.4321706515E-003
Abs_peak_TH=z 2. 480000000 0.4321706513E-003
Abs_peak _RSLT 2.490000000 0.25088Y6353E-001

e Close the Notepad application and graph window.

Average and Peak Displacements for a Selection of

Nodes

This section investigates results for a chosen set of nodes containing all of the
unrestrained nodes in the model, that is, all of the nodes above ground level. The
average displacements and peak displacements of the selected nodes will be obtained.

Ue ibi Rotate the model to view along the Y axis by clicking the status bar at the
bottom of the Modeller window.

M Using Select Nodes drag a box to select all of the 89 nodes above ground level, as
shown in the following figure.
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Open the IMDPlus Seismic Analysis Control dialog through the menu or click on
the ;l button in the toolbar

On the IMDPIlus Seismic Analysis Control dialog click the Next button to accept the
previously defined values. When prompted about the total mass participation click
the Yes button to continue.

Enter the following information into the IMDPlus Output Control dialog.

Select Node and change Extent to Selected using the drop-down list. This chooses
all 89 nodes above ground level that were selected in the preceding step.

Note. As Extent has been set to Selected the Node drop-down list will not be
available for selection.

Select result entity Displacement and component DX, DY & DZ

Deselect Individual items and select Average of chosen items as the averaged
results of the selected nodes are going to be investigated.

Ensure Response time history and Generate graphs in Modeller remain selected.
Ensure Peak response summary remains selected and also select Envelope

Deselect Modal combination/factor history and Generate textfile output

The dialog should now look like this:
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IMDPlus Seismic Output Control

— Modeselement selection

* Node " Element E ritity IDispIacement j
Extent |Selected vI Compaorient |D><, DY & 0F j
Mode B1 - [ Individual items

[~ Sum of chosen items

v Average of chozen items

— Dutput contral

¥ Fesponze time history

¥ Peak responze summary | Fusitive/neaative v Envelope
% sbsalute

™| Secondam response spectia (SHS] I iadify.. |

[~ Modal combination/factar histary [ pticmns... |
¥ Generate graphs in Modeller E arthquake to graph I'I 'I

[~ Generate textfile output [0 ptions... |
< Back | Finish I Apply | Cancel | Help |

e Click the Apply button to perform the analysis. Click Yes when asked whether you
want to process all of the selected nodes.

Note. Any combination of the options Individual items, Sum of chosen items and
Average of chosen items output can be used together in an IMDPlus analysis,
although using the Individual items option when Extent is set to Selected or All
(nodes or elements) may produce a large number of graphs, depending on the number
of nodes or elements chosen for processing.

Note. Average of chosen items obtains results by first summing the results from the
89 nodes selected. A simple average of these summed results is obtained to give the
averaged node time histories from which the peak average results are obtained.

A graph showing the average horizontal (DX and DY) and vertical (DZ) displacements
for all of the selected nodes is displayed for the 1940 El Centro earthquake. The
average node displacements are shown in the following figure.
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Mode Set Avg: Translational Displacement Time History

Displacernent

Response Time

— DX
— DY
Dz

The peak results for the averaged node displacements are displayed in Notepad in file
peak dspSet Avgl.sum. These indicate absolute peak average displacements of
0.0027m at time 2.4725 seconds in the X-direction and 0.0106m at time 2.485 seconds
in the Y-direction.

#*
#*

# o +

# | Record = 001 |

#Ft————— +

#*

# Entity Time value
Peak_Pos_Dx 2.472500000 0271157044 6E-002
Peak_Meg_Dx 1.982500000 -0, 254 5200708E-002
abhs_Peak_Dx [::::::::$ 2.472500000 [::::? 0271157044 6E-002
Peak_Pos_Dv 2485000000 0.1059843682E-001
Peak_Meg_Dv 2.340000000 -0.104608%938E-001
Abs_Peak_Dy 2485000000 [::::? 0.1059843682E-001
Peak_Pos_DZ 0. 9900000000 0. 457029121 0E-004
Peak_Meg_DZ 1.015000000 -0.85209205567E-004
Abs_Peak_Dz 1.015000000 0.B520296567E-004
Peak_Pos_THx 2.337500000 0.30035976055E-003
Peak_Meg_THx 2.4582500000 -0.304400364 5E-003
Abs_Peak_THx 2.4582500000 0.304400384 5E-003
Peak_Pos_THY 2.475000000 0.43852704096E-004
Peak_Meg_THY 1.980000000 -0.43609077358E-004
Abs_Peak_THy 2.475000000 0.43852704096E-004
Peak_Pos_THZ 2340000000 0. 28877 25883E-003
Peak_Meg_THZ 2482500000 -0.3000152315E-003
Abs_Peak_THZ 2482500000 0.3000152315E-003
Ahs_Peak_RSLT 2.482500000 0.1156838441E-001
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An envelope of the peak results for the chosen nodes is displayed in Notepad in file
peak dspSetl.sum and is shown in the following figure. The peak X-displacement of
0.0068m occurs at node 143 at time 2.745 seconds and the peak Y-displacement of
0.0248m occurs at node 135 at time 2.49 seconds.

Note. The envelope of the peak results is obtained in IMDPlus by examining the
individual results from the 89 unrestrained nodes. This helps to quickly identify the
nodes of the model where the maximum and minimum displacements occur.

#

#

# ot +

# | Record = 001 |

# +

#

# Entity Time value Mode
Peat_PDS_DX 2.475000000 0.6821753781E-Q02 143
Peak_MNeg_Dx 2. 372500000 -0, 5593165797E-002 143
Abs_Peak_Dix E:::::::::§ 2.475000000 [::::> 0.6821753781E-002 [::::j 143
Peat_PDS_DY 2.490000000 0. 2475797 7EEE-00L 135
Peak_Meg_Dv 2.337500000 -0, 2302854973E-001 135
abs_Peak_Dv () 2.400000000 ) 0.2475757788E-001 [__) 135
Peak_Pos_DZ 2.477500000 0.9252464285E-003 277
Peak_Meg_DZ 1.995000000 -0, 8662857720E-003 277
Abs_Peak_Dz 2. 477500000 0.9252464 285E-003 277
Peak_Pos_THx 2.342500000 0.3661382546E-002 23
Peak_Meg_THx 2.485000000 -0, 3739308469E-002 23
Abs_Peak _THx 2. 485000000 0.37309308469E-002 23
Peak_Pos_THY 2477500000 0.4783B63731E-003 277
Peak_Meg_THY 1.995000000 -0.4772056675E-003 277
Abs_Peak_THv 2.47F77500000 0.4783863731E-003 277
FPeak_Pos_THZ 2. 485000000 0. 5087373266E-002 a9
Peak_Meg_THzZ 2.342500000 -0, 50745544 80E-002 69
Abs_peak_THz 2.485000000 0. 5087373266E-002 69
Abs_Peak_RSLT 2. 487500000 0.2551992385E-001 143

o Close all of the Notepad applications and graph windows.

Peak Axial Forces from All of the Elements in the Model

In this section the peak results for a set of elements containing all of the 201 beam
elements in the model will be investigated.

Note. Only elements of the same type, for example, thick beam elements, continuum
elements or thick shell elements can be used in a set of IMDPIlus elements. However,
the element set may contain elements with different numbers of Gauss points or nodes.

Note. As all of the elements in the model are going to be processed there is no need
to pre-select the elements in the graphics window prior to running the IMDPlus
analysis. Instead the All option from the Extent drop down list will be utilised on the
IMDPlus Output Control dialog.

e Click on the El button in the toolbar to open the IMDPlus Output Control dialog
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If the IMDPIlus toolbar is not enabled,

e Open the IMDPlus Seismic Analysis Control dialog through the menu and click
Next > to keep the existing analysis control settings and open the IMDPlus Output
Control dialog.

Enter the following information into the IMDPlus Output Control dialog.

o Select Element and change Extent to All using the drop-down list. This chooses all
of the elements in the model.

Note. As Extent has been set to All the drop-down lists Element and End are not
available for selection. In addition the element End is automatically set to All as
multiple elements are going to be processed in a single analysis.

e Select results entity Force/Moment — Thick 3D Beam and component Fx

e Ensure Average of chosen items remains selected and Individual items and Sum
of chosen items deselected as only the average results of the chosen elements are
going to be investigated.

e Deselect Response time history
e Ensure Peak response summary and Envelope remain selected.
The dialog should now look like this:

—Mode/element selection

" Node ' Elemert Entity IForce.-’Moment-Thick 3D Beam j

E stent All | Component I F= j

Element | v[ [ Individual items

™ Sum of chosen items

End All X .
vV Average of chosen items

r— Output control

[ Responze time history

¥ Peak response summary ! Positive/negative ¥ Ervelope
% shsolute

= | Secondany response: spectia (SHS] Ffadify... |
™ todal combination/factor history [ptions... |
¥ Generate graphs in Modeller Earthquake to graph |1 'l

[ Generate textfile output [Dptions... |
< Back | Finish I Apply | Cancel | Help |
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¢ Click the Finish button to perform the analysis. Click Yes when asked whether you
want to process all of the elements in the model. On modern computers this will take
under 5 minutes.

e Click Yes when asked whether to free up disk space by deleting the temporary files
created by IMDPlus.

Peak average results for the chosen set of elements are output to Notepad in file
peak forceSet Ave2.sum.

Note. Average of chosen items obtains the element results by first summing the
results from all of the beam ends in the model. A simple average of these summed
results is obtained to give the average response time histories from which the peak
average results are obtained.

An envelope of the peak results for all of the elements in the model is displayed in
Notepad in file peak forceSet2.sum and is shown in the following figure. It can be seen
that the peak compressive axial force (Fx) of -30.97kN occurs at end 1 of element 4 at
time 2.3425 seconds. The peak bending moment (My) occurs at end 1 of element 133 at
time 2.49 seconds and has a value of -46.42kNm.

Note. The envelope of the peak results is obtained in IMDPlus by examining the
individual results for all of the beam elements in the model. This enables the locations
of the elements with maximum and minimum results to be quickly identified.

#
#

#Fobomm +

# | Record = 001 |

#F o +

#

# EEt"lty Time value Element End
Peak_Pos_Fx 2.340000000 34152, 50443 10 1
Peak_Meg Fx [ ) 2.342500000 [__) -30970.3%501 () 4 1
Abs_Peak_Fx 2.340000000 34152,50443 10 1
Feak_Pos_Fy 2.482500000 15453, 07531 1 1
Feak_Neg_Fy 2.342500000 -14410.67957 1 1
Abs_Paak_Fy 2.482500000 15453.07531 1 1
Feak_Pos_rz 2.490000000 9383.017514 133 1
Feak_heg_Fz 2.472500000 -10137.43335 12 1
Abs_Feak_Fz 2.472500000 10137.43335 12 1
Feak_Pos_Mx 2.485000000 174.0245661 47 1
Feak_heg_Mx 2.485000000 -172.9160181 58 1
Abs_Peak_pix 2.485000000 174.0245661 47 1
Peal_Pos iy 2.337500000 43014.11544 133 1
Feak_Neg_My ) 2.400000000 () -46420.96736 [ 133 1
Abs_Peak_my 2.450000000 46420. 96736 133 1
Feak_Pos_Mz 2.482500000 27226.15524 1 2
Peak_hag Mz 2.482500000 -27323.10660 1 1
Abs_Feak_mz 2.482500000 27323.19660 1 1

e Close the Notepad applications.

The elements that contain the peak compressive axial force and peak bending moment
will now be located in the model.

El In the LUSAS graphics window click on the Isometric view button.
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Click the left-hand mouse button in a blank part of the graphics window to remove
the node selection created in the preceding sections.

Double-click on the Labels layer name in the [ETreeview.

On the Properties dialog de-select the Node > Name check box, select the Element
> Name check box and select the Label selected items only check box.

Click the OK button to accept all other settings. This will turn on the layer in the
graphics window.

With no features selected click the right-hand mouse button in a blank part of the
graphics window and select the Advanced Selection... option.

Select Type and Name, select Element from the drop-down list and enter element
number 4

Select Add to selection and click the Apply button to accept all other settings.
Beam element 4 will be highlighted in the graphics window.

Enter element number 133 and click the OK button. Beam element 133 will also be
displayed in the graphics window, as shown in the following figure.

e

>

!Jﬂ»
» e <§‘
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| Script

| Run Script...

Displaying Deformed Mesh Plots from Modal
Combinations

When the IMDPlus analysis of node 61 was carried out in an earlier section, the Modal
combination/factor history option was selected and caused IMDPlus to generate a
command file in the \<LUSAS Installation Folder>\Projects\IMDPIus 3D
Frame\Associated Model Data\IMDPIlus 3D Frame directory called
Modal_Combinations-rec001.vbs. These combinations can now be generated in
Modeller by loading this command file.

Modal_Combinations-rec001.vbs defines the modal combinations for all time
steps in the seismic analysis.

e Open the file Modal_Combinations-rec001.vbs located in the \<LUSAS
Installation  Folder>\Projects\IMDPIus 3D  Frame\Associated  Model
Data\IMDPIlus 3D Frame directory.

The combinations will appear under the original model in the (X Treeview.

e Click the left-hand mouse button in a blank part of the graphics window to remove
the element selection created in the previous section.

e Turn off the display of the Labels and Attributes layers in the =" Treeview.

e In the &b Treeview click the right-hand mouse button on the Local Coordinates 1
entry and deselect Show definition

e In the Treeview click the right-hand mouse button on the Mesh and select
Properties. Select the Choose pen... button and select a Green colour for the
mesh. Select the Visualise tab and turn off the Beam end releases option. Click the
OK button.

e With no features selected click the right-hand mouse button in a blank part of the
Graphics area and select the Deformed Mesh option to add the deformed mesh
layer to the Treeview. Select the Visualise tab and turn off the Beam end
releases option. Click the OK button to accept the remaining default values and
display the deformed mesh.

e At the bottom of the Treeview select the Window summary option and click
the Details... button. In the Window summary properties dialog set the position to
(50.0,-120.0) and click the OK button to return to the graphics window.

e In the @ Treeview right-click on the 991:Response Time = 2.472500000 dataset
name and select the Set Active option to set this combination active. This is the
time at which the absolute peak displacement in the X-direction occurred at node
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61. The deformed mesh will now be displayed for this instance in time as shown

below.

4

=2472!
mum displacement 0.0239642 at node 143
tion: 37.3615

Eye: (-0.57735, -0.57735, 0.57735)
is

o In the {2 Treeview right-click on the 998:Response Time = 2.490000000 dataset

name and select the Set Active option to set this combination active. This is the

time at which the absolute peak displacement in the Y-direction occurred at node

61. The deformed mesh will now be displayed for this instance in time as shown

below.
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Note. Standard post-processing such as displaying contours can be performed on
these modal combinations to allow the global behaviours at instances in time to be
investigated.

Displaying Envelopes for the Whole Earthquake

Plots showing the maximum and minimum axial force and bending moment in the
columns for the entire earthquake duration are to be displayed.

Create an envelope

Enter Whole Earthquake for the name
Select model data from the drop-down list

Hold down the shift key and select combinations 2 to 1002 in the list and click on
the >> ‘Add to’ button to add all combinations to the envelope

Click the OK button to create the max and min envelopes.

In the L2l Treeview right-click the group named Columns and Set as Only Visible
to only view the column members.

Turn off the display of the Mesh and Deformed Mesh layers in the 5 Treeview.

In a blank part of the Graphics area, click the right-hand mouse button and select the
Diagrams option to add the Diagrams layer to the = Treeview.

Select Force/Moment — Thick 3D Beam results of axial force FX in the members.
Select the Diagram display tab, select the Label values option and deselect the
Peaks Only option. Plot values on 80% of the element length.

Click the OK button.

In the ‘& Treeview right-click on the Whole Earthquake (Max) envelope and
select the Set Active option to set this envelope active.

On the Set Active dialog select Force/Moment — Thick 3D Beam results of axial
force Fx and click the OK button to finish.

The envelope will now be assembled over the 1000 modal combinations generated by
IMDPlus. On modern computers this will take under 5 minutes.

104



Viewing the Results

For this central column Fx = 11.94E3
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In the & Treeview right-click on the Whole Earthquake (Max) envelope and
select the Set Active option to set this envelope active. Select entity Force/Moment
— Thick 3D Beam of component My and click the OK button. When informed that
the component is different to the one used in the drawing layers click the Yes button
to update the diagrams layer.

The envelope will now be assembled over the 1000 modal combinations generated by

IMDPlus.
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Displaying results for a selected member

To check these previous results for Fx and My we will utilise IMDPlus again to check
the response of the member in centre of the frame.

e Turn off the display of the Diagrams and Annotation layers in the [FTreeview.
e Turn on the display of the Mesh layer in the Treeview.
Element numbers will be added to the mesh display to allow selection.

e Double-click on the Labels layer name in the [ETreeview. On the Properties dialog
de-select the Label selected items only check box and click OK. (This turns on the
display of a turned-off layer.)

. M Select the element in the centre of the frame as shown in the following diagram.

Select this element

2

e

|U|ti|':\t/ileDsP| e Open the IMDPlus Seismic Analysis Control dialog through the menu or click on
us >
| Seismic... the ;l button in the toolbar

e On the IMDPIlus Seismic Analysis Control dialog click the Next button to accept the
previously defined values. When prompted about the total mass participation click
the Yes button to continue.

e On the IMDPlus Output Control dialog select Element change Extent to
Individual
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e Select Element number 22 from the drop-down list and ensure End is set to All
e Choose Force/Moment — Thick 3D Beam and component Fx.

e Select Individual items. Sum of chosen items and Average of chosen items will
not be available as an individual element is being processed.

e Ensure Peak response summary is selected.

e Click the Finish button and click the Yes button to confirm that both ends of the
beam element are to be processed (because All ends has been previously set).

e Click Yes when asked whether to free up disk space by deleting the temporary files
created by IMDPlus.

The peak forces and moments in element 22 will be output to a Notepad application in
the format indicated below.
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T EEEEE
ral
m
™
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[w]
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Erntity

Peak_Pos_Fxl [:::::::> 1.082500000 [::::> 12244, 70438
Peak_Meg_Fxl 1.015000000 -17622.485885
Abs_Peak_Fxl 1.015000000 17622 . 485885
Peak_Pos_Fx2 1.082500000 12244, 70438
Peak_Meg_Fx2 1.015000000 -17622.485885
Abs_Peak_Fx2 1.015000000 17622 . 485885
Feak_Pos_Fyl 2. 500000000 14769, 22560
Peak_NEE_Fyi 2.330000000 -13277.01107
abs_Peak_Fyl 2. 500000000 14769, 22560
Feak_Pos_Fy2 2. 500000000 14769, 22560
Paak_Neg_Fy2 2.330000000 -13277.01107
abs_Peak_Fy2 2. 500000000 14769, 22560
Peak_Pos_Fzl 1.5982500000 5578.155101
Peak_Meg_Fzl 2.475000000 -5870. 701372
abs_Peak_Fzl 2.475000000 SB70.TOL372
Peak_Pos_Fz2 1.5982500000 5578.155101
Peak_Meg_Fz2 2.475000000 -5870. 701372
abs_Peak_Fz2 2.475000000 SB70.TOL372
Peak_Pos_mxl 2. 285000000 1.401136532
Peak_Mag_mxl 2.155000000 -0. 9631674002
ahs_peak_mMxl 2. 285000000 1.401136532
Peak_Pos_Mx2 2. 285000000 1.401136532
Peak_Mag_mx2 2.155000000 -0. 9631674002
ahs_peak_mMx2 2. 285000000 1.401136532
Peak_Paos_myl E::::::::> 2.475000000 8023, 0105641
Peak_MNeg_Myl 1.982500000 -8468.623770
abs_Peak_myl 2.475000000 8023.010641
Peak_Paos_mMy2 [::::::::> 1. 982500000 [::::j 8600, 530840
Peak_NEE_MyE 2.475000000 —0040, 426557
abs_Peak_my2 2.475000000 5040.426557
Peak_Pos_mzl 2.330000000 20327.20230
Peak_nNag_mzl 2. 500000000 -22606,97454
ahs_peak_mz1l 2. 500000000 22606, 97454
Peak_Pos_mz2 2. 500000000 22586, 85570
Peak_Nag_mz2 2.330000000 -20300.36140
ahs_peak_mz2 2. 500000000 22586, 85570

Comparison of the results for Fx and My for the central column show good agreement
between the envelope and IMDPlus results. Exact agreement would have been obtained
if all modes were included in the modal combinations used for the envelope instead of
the 1% minimum participating mass selected earlier.

e Close the Notepad application.
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Viewing the Results

Note. For an IMDPlus seismic analysis selecting Peak response summary will
tabulate results for all components and not just the one selected (Fx). If Response time
history is selected only the results for the selected component will be graphed.

Save the model

El Save the model. This saves all load combinations that have been defined during
the results processing operations.

This completes the example.
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Description

Train Induced
Vibration of a
Bridge

With product option(s): IMDPlus
Note: The example exceeds the limits of the LUSAS Teaching and Training Version.

Description

This example examines the
response of a steel rail bridge to
the passage of a train.

Units used are N, m, kg, s, C
throughout.

Objectives

The output requirements of the analysis are:

U Deflections in the X-, Y- and Z-directions for a train speed of 15 m/s
O Accelerations in the vertical direction for a train speed of 70 m/s

U Peak deflections and accelerations in the vertical direction for a speed range of
15 m/s to 70 m/s in 5 m/s intervals

Stress resultants and peak stress resultants in main girder web.

(M

Averaged and peak vertical displacements and resultant dynamic amplification
factors from all of the nodes of the bridge structure
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| File

Open...

Train Induced Vibration of a Bridge

U Total summed reactions and peak reactions from all of the supported nodes of
the bridge structure
U Averaged and peak stresses for a side panel of the bridge structure
Keywords

Moving load, time domain, response, interactive, modal, dynamics, IMDPIlus,
eigenvalue.

Associated Files

U IMDPlus Rail Bridge.mdl Model of the structure.

U ec1-3 Type3.Imd Attribute library that contains the Eurocode ENV 1991-3
Type 3 moving load train definition for the example.

U ec1-3 Type3.xls Microsoft Excel spreadsheet that contains the axle
positions and loads of the Eurocode ENV 1991-3 Type 3 train set.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.

Building and loading the model

To create the model, open the read-only file IMDPIlus Rail Bridge.mdl located in the
\<LUSAS Installation Folder>\Examples\Modeller directory. Click the OK button if
the Open File From Previous Version dialog appears.

After a short while the following view of the model of the bridge will be displayed.
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Modelling

In the \<LUSAS Installation Folder>\Projects\ folder create a new directory

called IMDPIus Rail Bridge

| File

Save As...

Save the model into this new folder as IMDPIlus Rail Bridge. This helps keep all

relevant IMDPlus created files separate from other analyses and is good practice.

e Turn off the display of the Attributes layer in the (& Treeview.

No static structural loading is required for this analysis because only the

dynamic loading is considered during the results processing, which is defined later.

Note.

&
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Modelling Discussion

The bridge is approximately 16.5m long and 4.75m wide and carries a single track with
ballast and concrete sleepers. The primary structure is constructed from steel and is
modelled using shell elements. For this analysis, modelling of the ballast/track-bridge
interaction has been carried out using a full 3D solid representation of the ballast with
the sleepers modelled with thick beam elements laid along the top of the ballast. The
rails of the track have been modelled using thick beam elements spanning between the
sleepers and the whole ballast/track model is connected to the bridge deck using a
sliding-only slideline. For the purposes of this example the bridge and ballast model has
been represented with a coarse mesh and therefore the results from this analysis will be
inaccurate. For analysing actual structures it is recommended that a finer mesh be used
which can capture both the vibration modes of the bridge and the movement of the load
across the bridge more accurately.

Bridge representation
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Ballast representation

To allow the loading of the rails to be distributed to the 3D solid elements using
discrete point loads the track modelling uses weak, weightless shell elements which
span between the beam elements representing the rails. The track representation is
shown in the following figure.

traight line: 12000 length=27 36
Poirts : 10958, 10859

Track (sleepers and rails) representation

Note that the line down the centre of the track (Line 12000) is used to define the path of
the train across the bridge and will be used later in this example. In order to avoid any
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adverse dynamic behaviour of the weak weightless shell elements, only one division is
used to span between the two rails thus providing full support to the shells without
adding stiffness to the model.

Defining Eigenvalue Controls

Eigenvalue controls are defined as properties of the loadcase.

o In the & Treeview expand Analysis 1 then right-click on Loadcase 1 and select
Eigenvalue from the Controls menu.

The Eigenvalue dialog will appear.

The following parameters need to be specified:

o Set the Eigenvalues required to Range

o Ensure the Range is set to Frequency

e Set the Minimum frequency as 0

e Set the Maximum frequency as 35

o Set the Number of eigenvalues to 0 (this solves for ALL frequencies in the range)
e Ensure the Type of eigensolver is set as Default

Note. Eigenvalue normalisation is set to Mass by default. This is essential if the
eigenvectors are to be used for subsequent IMD analysis.

e C(Click the OK button to finish.

El Save the model file.

Running the Analysis

e With the model loaded click the Solve button El and the Solve Now dialog will be
displayed.

e Click the OK button to run the analysis.

A LUSAS Datafile will be created from the model information. The LUSAS Solver
uses this datafile to perform the analysis.
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Viewing the Results

| utilities

Print Results
Wizard...

If the analysis was run from within LUSAS Modeller the results will be loaded on top
of the current model and the loadcase results for each eigenvalue can be seen in the
Loadcase layer. Eigenvalue 1 is set to be active by default.

Checking the Mass Participation Factor

Note. In order to carry out a successful IMDPlus analysis you should ensure that a
significant proportion of the total mass has been accounted for in the analysis. This
requires checking that around 90% of the total mass has been achieved in the global
directions. If less than 90% has been achieved no further modes need be included, if
and only if, the modes of vibration omitted cannot be excited by the dynamic input or a
significant proportion of the structure is restrained by support in these directions and
therefore cannot participate in the modes of vibration. The acceptability of the included
modes of vibration will vary from analysis to analysis but failure to check that a
significant proportion of the total mass has been accounted for may lead to important
modes being missed and subsequent errors in the analysis results.

e Select Active and click Next.

e Select Entity None and from the Type drop-down menu select Sum mass
participation factors and then click Finish. The Sum Mass Participation Factors
results will be printed to the Text Output window.

It can be seen that the 90% value has almost been achieved in all directions for this
analysis. This is discussed in the note below.

MODE SUM MASS X SUM MASS Y SUM MASS 7
1 0.110940E-01 0.117572E-04 0.707920
2 0.121970E-01 0.133845E-04 0.708029
3 0.125612E-01 0.182964 0.708274
4 0.131909E-01 0.182989 0.769089
5 0.290473E-01 0.352634 0.770999
6 0.430279E-01 0.813529 0.771960
7 0.177903 0.890132 0.806536
8 0.178201 0.892043 0.831905
9 0.188464 0.893014 0.832302

10 0.207253 0.893215 0.833539
11 0.864564 0.893542 0.861563
12 0.901000 0.938795 0.862830
13 0.901132 0.939785 0.862830
14 0.920871 0.940199 0.864118
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15 0.920872 0.940360 0.881332
16 0.938299 0.940366 0.882002
17 0.938309 0.940637 0.882002
18 0.938347 0.940642 0.882003
19 0.938366 0.940708 0.882003

Note. In this analysis we are only including modes of vibration with frequencies up to
and including 35 Hz with frequencies higher than this value considered insignificant for
the analysis. In this analysis the printed results show that 93.8% of the total mass is
achieved in the X-direction, 94.1% is achieved in the Y-direction and 88.2% is
achieved in the Z-direction.

e Close the text window by selecting the close button in the top right hand corner of
the window.

e Select Active and click Next.

e Select Entity None and from the Type drop-down menu select Mass participation
factors and then click Finish. The Mass Participation Factors results will be
printed to the Text Output window.

MODE MASS PF X MASS PF Y MASS PF Z

1 0.110940E-01 0.117572E-04 0.707920

2 0.110297E-02 0.162728E-05 0.109262E-03
3 0.364226E-03 0.182951 0.245424E-03
4 0.629662E-03 0.241889E-04 0.608148E-01
5 0.158564E-01 0.169645 0.191047E-02
6 0.139805E-01 0.460895 0.960755E-03
7 0.134875 0.766029E-01 0.345759E-01
8 0.298085E-03 0.191048E-02 0.253685E-01
9 0.102626E-01 0.971036E-03 0.397193E-03
10 0.187893E-01 0.200908E-03 0.123754E-02
11 0.657310 0.327165E-03 0.280234E-01
12 0.364360E-01 0.452530E-01 0.126713E-02
13 0.132603E-03 0.990173E-03 0.130638E-07
14 0.197387E-01 0.413466E-03 0.128847E-02
15 0.797027E-06 0.161819E-03 0.172134E-01
16 0.174272E-01 0.517541E-05 0.670045E-03
17 0.100738E-04 0.271287E-03 0.727634E-06
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18 0.383935E-04 0.473477E-05 0.479303E-07
19 0.185724E-04 0.667088E-04 0.664934E-07

From these mass participation factors the major modes of vibration of the bridge can be
seen to be mode 1 in the Z-direction (vertical) and modes 3, 5 and 6 in the Y-direction
(lateral).

e Close the text window by selecting the close button in the top right hand corner of
the window.

e Use the maximise button to increase the size of the graphics window.

Plotting Mode Shapes
e Turn off the display of the Mesh, and Geometry layers in the [ Treeview.

e With no features selected click the right-hand mouse button in a blank part of the
Graphics area and select the Deformed mesh option to add the deformed mesh

layer to the Treeview. Click the OK button to accept the default values and
display the deformed mesh for Eigenvalue 1.

e In the panel at the bottom of the Treeview select the Window summary option
and click the Details... button. In the Window summary properties dialog set the
position to (50,-10) and click the OK button to return to the graphics window.

This mode of vibration is the primary mode in the vertical direction as determined in
the Checking the Mass Participation Factor section.

Scale: 1: 83525
Zoom: 100.0

Eye: (-0.57735, -0.57735, 0.57735)
Eigenvalue analysis

Loadcase: 1 Eigenvalue 1

Results file: IMDPius Rail Bridge-Analysis 1.mys
Eigenvalue: 1.58958E3

Natural frequency: 6.34543

Error norm: 30 3143E-12

Maximum displacement 6 98944E-3 at node 1672
Deformation exaggeration: 80.2854

119



Train Induced Vibration of a Bridge

By setting each Eigenvalue to be active the deformed mesh can be seen for all mode
shapes.

o In the ! Treeview right-click on Eigenvalue 6 and select the Set Active option.
The deformed mesh plot for Eigenvalue 6 will be displayed.

This mode of vibration has the highest participating mass in the lateral (Y) direction for
the whole bridge as determined in the Checking the Mass Participation Factor section.

Scale: 1: 83525
Zoom: 100.0

Eye: (-0.57735, -0.57735, 0.57735)
Eigenvalue analysis

Loadcase: 1:Eigenvalue 6

Results file: IMDPlus Rail Bridge~Analysis 1.mys
Eigenvalue: 10.74314E3

Natural frequency: 16,4965

Eror nert ™ 851362612

Maximum displacement 9 76179E-3 at node 1851
Deformation exaggeration: 57.4843

Note. The window summary displays the values of the eigenvalue and the natural
frequency and also a value for displacement at a node. It should be noted that the
displacement value is non-quantitative and is related to the amount of mass in a
particular mode using the mass normalisation technique. Therefore the only items that
can be found using a basic eigenvalue analysis are the frequency and the mode shape.

Note. The mode shape may be inverted. This is because the sense is arbitrary since
during vibration the deformed shape will appear in both directions.

Selecting individual nodes and elements of interest

Prior to running an IMDPlus analysis, individual node and element numbers for the
locations of the structure that will be assessed should be ascertained. This can be done
by selecting the locations of interest with the cursor and noting down the numbers of the
node and elements concerned.
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e Turn off the display of the Deformed mesh and Annotation layers in the
Treeview.

e In the Treeview double-click on the Mesh layer name and click the OK button
to accept the default settings. This will turn on the layer.

To view just the bridge structure without the ballast and track:

e In the Treeview click the right-hand mouse button on the group name
Bridge_Structure and select the Set as Only Visible option from the drop-down
menu.

By selecting or hovering the cursor over the node and element shown, the node or
element number of interest can be obtained. For the first stage of this analysis we are
interested in the node at the centre of the bridge deck and the element in the middle of
the side girder, as shown in the following figures.

Node 1672
Elements; 3394, 3390, 3376, 3374, 1216, 1215, 1206, 1205
83058, 12442618, 0.2032)
There are 2 ftems o this position
Press Tab to cycle thiough them
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e
odes: 1615, 1685, 1666, 1615
here are 2 fems af this position
tess Tab ta cycle through them

Defining the Eurocode ENV 1991-3 Type 3 Trainset

Before the analysis can be performed we need to define the moving load representation
of the Eurocode ENV 1991-3 Type 3 trainset in LUSAS Modeller.

Note. To simplify the use of IMDPlus for the rest of the example it is recommended
that the IMDPlus toolbar is enabled in LUSAS Modeller. To do this select the View >
Toolbars... menu command and enable the IMDPIus option in the list and click Close.
-
o If the IMDPlus toolbar has been enabled then click on the ;l Moving Load
analysis button in the toolbar to select a moving load analysis and enable the
toolbutton shortcuts to the dialogs.

| Utiities e Open the IMDPlus Moving Load Vehicle Configuration dialog through the menu or
IMDPIqs > E
M%W click on the _I button in the toolbar. The moving load vehicle is now defined
enicle

using the positions of the axles relative to the front of train together with the moving
load factors to be applied at each position. To simplify the definition of the vehicle
the positions and loads are included in a Microsoft Excel spreadsheet so they can be
copied and pasted into the dialog.

Configuration...
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e Locate the ecl-3 Type3.xls
spreadsheet in the T — = -
\<LusaslInstallationFolder w‘z o S
>\Examples\Modeller ! a8 20000
folder and open it. 5 e 50000

[ -21.41 150000
oys 7 3791 150000

e Select all of the 60 positions 8 a4 150000

and loads in the first and It A2 100
il -64.31 150000

second colums and copy 1 gl 100
these to the clipboard using ] A 150000
14 -F4 150000

Ctrl+C 15 507 50000
16 932 150000

- 17 -98.11 150000

e Select both the Position and 18 S T
Load headers of the grid in 5 e et r
the dialog and paste these - e
into the grid using Ctrl+V

Mame |ecl-3 Typed j é’ {new)

e Enter the name as ecl-3

Type3
. . [s]4 Cancel | Apply | Help |
Once finished the dialog should

appear as shown.

e Click OK to create the vehicle configuration.

Note. Alternatively each Position and Load in the table can be entered manually.

Note. The positions of the axles should be defined as negative values to ensure that
the whole trainset passes over the structure. Negative values place the axles behind the
front of the train which is at a position of 0. The movement of the front of the train will
be calculated from the start of the path to the end of the path with additional time
included in the IMDPlus solution to allow all of the axles with negative positions to
pass along the path.

If any axles are defined with positive values then these will already be the distance
down the path equivalent to the position entered in the vehicle configuration. Those
axles with positive positions may already be over the structure at the start of the
IMDPlus analysis if the start of the path has not been defined to account for this. If any
positive positions are used then always ensure that the lines defining the beginning of
the path allow sufficient additional length in order to model the transition of the whole
of the train onto the structure correctly.

Note. Once a trainset or vehicle has been defined it can be saved in a library so it can
be imported and used in future analyses without the need to go through all of the
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| File

Train Induced Vibration of a Bridge

Import/Export Model
Data...

definition process above. This is achieved through the Library Browser accessed
through the File > Import/Export Model Data... menu command.

Importing a Vehicle

If it proves time consuming or you are unable to obtain the same results shown later in
the example the vehicle definition can be imported from the library provided in the
\<LusaslnstallationFolder>\Examples\Modeller folder.

O The ec1-3 Type3.Imd contains the vehicle library for the example.

e Select the Import from library to model option

e Click on the Choose file... button and browse to the ec1-3 Type3.Imd file in the
\<LusaslnstallationFolder>\Examples\Modeller folder.

e Select the IMDPIus (1) entries in the tree

e  (lick the OK button.

After vehicle configuration attribute has been S 1L_1& 18 -
defined it will appear in the o Utilities B

. 2423 Wehicle Configuration (1)
treeview. 5538 Moving Load (1)

& Liecl-3 Typed

To edit the wvehicle configuration attribute
simply double-click with the left mouse button
or right-click and choose Edit Attribute... on
the name of the attribute to bring up the original
dialog.

Moving Load Analysis

Moving load calculations are performed using the IMDPlus (Interactive Modal
Dynamics) facility. In order to carry out the moving load analysis of the train travelling
across the bridge we need to carry out three stages:

1. Define and set-up the path along which the moving loads will travel using a
unit load defined as either a discrete point or patch load. For this example the
unit axle load has already been defined as a discrete point load called Unit
Axle Load which acts vertically

2. Convert the loading along this path from this unit load into modal forces that
are applied in the IMDPlus moving load analysis
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Viewing the Results

3.  Run an IMDPlus moving load analysis to calculate the response of the bridge

Note. This process is similar to the IMDPlus moving mass analysis procedure but
with the trainset / vehicle defined by constant forces rather than spring-mass systems.

Note. Before an IMDPlus analysis can be carried out the load that is going to pass
over the structure must be defined using either discrete point or patch loads. For this
example this has already been carried out with a single axle of unit load defined as a
discrete point load. Defining a single axle allows multiple load configurations to be
analysed through the composite axle definition method in IMDPlus without the need to
carry out the path and modal force stages for each layout. For railways the axle lengths
remain constant over all of the train set and this method would normally be used. For
moving loads where axles are of different widths the full definition of the load must be
carried out with the path and modal force stages carried out for each layout.

Defining the Moving Load Path

To solve for the passage of the train across the bridge the path for the moving load must
be defined. Line 12000 (the line representing the path of the moving load) will be set to
be the current selection.

To view the complete model again:

e In the Treeview click the right-hand mouse button on the group name IMDPIus
Rail Bridge.mdl and select the Visible option from the drop-down menu. Click Yes
when asked whether to act on subgroups as well.

e In the Treeview double-click on the Geometry layer name and click the OK
button to accept the default settings. This will also turn on the layer.

e Select the line shown (line 12000)
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Staight line 12000, length=27.35

Points : 10858, 10859
Pia There are 5items at this position

The path can be built from multiple lines and arcs but these must form a

continuous path without branching.

[
-
=]
4

Open the IMDPlus Moving Load Generation dialog through the menu or click on

4+
the il button in the toolbar.

IMDPlus

| utilities

Moving Load
Generation...

all valid discrete loads and
search areas will be made available in the loading options along with information about

On startup of the IMDPlus Moving Load Generation dialog,
the path defined by the current selection.

Moving Load >

In this example a single discrete load called Unit Axle Load which defines the unit
loading from a single axle of the train is present along with a search area that is

assigned to the weak weightless shells.
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Viewing the Results

e Ensure 1:Unit Axle Load is selected

from the Moving load dataset list. ~Loading options
Maving load dataset I‘I:UnitAxIe Load j
e Ensure 1:Track Search Area is Searchacald  [1Tisck_Semch e =]

selected from the Search area ID for
the assignment of the discrete
loading.

" Project onto line [ 20 line beam and frame models]

% Project over area [ gilages, slabs and 30 frame space)
MNOTE: &l existing loading will be removed and
the moving loads will start from loadcase 1

—Load path optiong

selected.
Incremental distance for moving load along path ID.‘I

e Click on the Advanced button to Ditection & Forwards  © Backwards
adjust the inclusion of load Statofpath: ®= [ 532 v=| 00 2Z= | 05032
characteristics. On the Moving Load Fiishofpath: X= | 2204 =] 00 2= | 05032
Advanced O tiOIlS dialO ChOOSG the Mumber of divisions/increments to define full path: 273
Y g
Include Full Load option for loads
outside the search area and click the ¥ Datacheck
Numnber of loadcases per o0 <=
OK button. analysis IV Run analyses

e Ensure Project over area is

—Analysiz options

] | Cancel | Help

e On the IMDPlus Moving Load
Generation dialog set the
Incremental distance to 0.1

Note. Using search areas targets the application of the loading to the required
features as described in the Modeller Reference Manual.

Note. By default the incremental distance is set to one tenth of the length of the line
along which the load moves.

e Click the OK button to proceed and choose Yes to accept the warnings and save the
current model.

The program will now generate the loading information for the 274 locations of the unit
axle along the path before returning control back to LUSAS Modeller. This process will
take only a minute or so on a modern computer and does not need to be repeated unless
the lateral configuration of the load changes. For a railway this will not happen but it
may be required for highway analyses where the axle lengths and tyre configurations
could vary.

Note. The discrete loading locations defined by this dialog will be tabulated into
three datafiles with a maximum of 100 loadcases each and the analyses will be
performed automatically. These analyses will use the same file basename as the original
model with a numeric indicator appended to it (e.g. 00001, 00002, etc). They are
required for the modal force calculation stage.
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IMDPIlus >
Moving Load >

~ [Modal Force
Calculator...

| utilities
IMDPIlus >
Moving Load >
Moving Load
Analysis...

Train Induced Vibration of a Bridge

Generating the Modal Force History for the Moving Load

In the previous stage the passage of the train axle across the structure has been defined.
The modal forces for the IMDPlus solution now need to be calculated using the Modal
Force Calculator.

e Open the IMDPIlus Modal Force Calculator dialog through the menu or click on the
%I button

« Click the OK button to accept
the default information and —Modal force input options
proceed. First file: containing

eigenvalues

Note. ThlS process Wlll take Total number of eigenvalue files = I‘I—

only a minute or so on a modern ztl;tlchllzac;g;asgsmg 2IMDPlus Rail Bridge_000071. mys
computer and does not need to be

repeated unless the moving load
path or configuration in Stage 1 is
changed.

Mumber of loadzases in each static fils = 100

—Moving load path options

Direction % Forward  Backward

ok Cancel Help

Defining the Moving Load Parameters

All of the basic moving load information has now been defined for the IMDPlus
analysis. The next stage is to define the included modes, damping and speed
parameters.

e Open the IMDPlus Moving Load Analysis Control dialog through the menu or click
on the ;l button in the toolbar.
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Viewing the Results

Click on  the
Veh i CI e —Moving load input
Configu ration IV “ehicle configuration |1:ec1 -3 Typed j
(Composite aXIe) [Composite axle)
option since we are |- Mode/damping cantral
using a unit load
axle definition.

Total participating mass

Included modes: I All Modify... | #-Direction I 9283 %
= r-Direction I 9407 X%
[V Default damping I 5.0 % m

Ensure the Vehicle ZDiection [8820 %
conﬁguratlon r—Solution control
contains 1 . eC1_3 Advanced zolution optiohs rdodify... |
Type3 Guiet time: after
Minimum speed |'|5 ErsaEe of o ID.D

Ensure that M awimum speed I?D I IMDPlus automatic time step [Mypguist)
Included modes is S - i —

PR peed increment I olution time step -
set to All. If this is

not the case, click
on the Modify...
button and ensure

the' A“ mOdeS < Back | Mext » I Cancel | Help |
option is selected.

Ensure Default damping of 5.0 is selected. If a different damping is displayed,
click on the Modify... button and set the Default damping to 5.0

In the Solution control section, click on the Modify... button to change the advanced
solution options. Click the Defaults button to set the default options and click the
OK button.

Enter the Minimum Speed as 15, the Maximum Speed as 70 and the Speed
Increment as 5

Deselect the IMDPIus determining time step (Nyquist) option so we can specify
the required time step

Enter the Solution time step as 1E-3

Click the Next button to proceed. When prompted about significant missing total
mass choose Yes to continue. For this analysis we are only interested in the
contributions of modes of vibration up to and including 35Hz which means that we
are not going to achieve the 90% total mass target.

The information entered above will analyse the passage of a Eurocode ENV 1991-3
Type 3 train (with axle details as held in the file ec1-3 Type3.xls) across the bridge for
a speed range of 15 m/s to 70 m/s in increments of 5 m/s (or 54 kph to 252 kph in
increments of 18 kph). The quiet time allows for the decay of the response of the bridge
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after the train has passed across and the solution time step forces the time step to be
used in the analyses.

Displaying Individual Node and Element Results for
Moving Load Analysis

The IMDPIlus Output Control dialog will appear. This controls the results output for the
model.

Displacement and Acceleration Graphs

The response of the mid-span of the bridge for the range of speeds selected will be
investigated. Initially we will look at the displacements of the mid-span for a single
speed of 15 m/s (or 54 kph).

Enter the following information into the output control dialog:

e Choose Node and

select Extent as —Mode/element selection

Individual = Node ' Element Entity | Displacement |
e Enter NOde number Extent Ilndividual 'I Component |D><, oY & DZ j
1672 (This is the Nade [1672 -] IV Individual items
node in the centre of ™| Sumof chesenitems
the brldge deck at the I Awerage of chaosenitems
mid_span of the r—Output cantral
1 V¥ Response time histary
bridge)
S 1 t Displacement [ Peak response summary ! Positive/negative ™ Enwelope
L4 elec
% phsolute
I;;ults Of DX’ DY & [T Secondary response spectra (SRS) Il cdifyy.... |
I Modal combinationfactor history [ptions... |
* Fj[nsure . Indl;lldu(ail W Generate graphs in Modeller Speed to graph |1:15.D YI
Items 18 selected.
H [ Generate textfile output [ptions...
Sum of chosen items [ oo
and Average of
Chosen items Wlu not < Back ”WI Apply | Cancel | Help |

be available as an
individual node is
being processed.

e Ensure Response time history is selected.

e Ensure Generate graphs in Modeller is selected.

130



Viewing the Results

e Set the Speed to graph as 1:15.0 which indicates that the first speed of 15 m/s is
being processed

e Click the Apply to proceed.

Note. Clicking the Apply button instead of the Finish button keeps the IMDPlus
/ Control Dialog accessible for subsequent graph plotting.

The IMDPlus analysis will now run.

Node 1672, Speed 15.0000000000000: Translational Displacement Time Histary

Displacernent

Response Time

e When the graph has been displayed, close the graph

The vertical acceleration response of the mid-span for a single speed of 15 m/s (or 54
kph) will now be investigated.

If the IMDPIus toolbar has been enabled,

e Click on the EI button in the toolbar to open the IMDPIlus Output Control dialog

If the IMDPlus toolbar is not enabled,

| Utilies e Open the IMDPlus Moving Load Analysis Control dialog through the menu and
'MDFl:::ling oad z click Next > to keep the existing analysis control settings and open the IMDPlus
'Moving Load Output Control dialog.
Analysis...
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e On the IMD Output
Control dialog select
Acceleration results
of AZ for the vertical
component only

e Click the Apply
button and not the
Finish  button to
proceed.

Note. IMDPlus does

not need to be rerun
since the acceleration
results were computed at
the same time as the
displacement results.

IMDPlus Moving Load Output Control

—MNode/element selection

[ Secondary response spechra (SAS)
™ Modal combination/factar kigtar
V¥ Generate graphs in Modeller

[T Generate tewtfile output

% fhsolute

Speed to graph

' Mode " Element Enitity IAcceIeration j
Estent IIndividuaI 'I Campanent IAZ =l
Maode |15?2 vI V' Individual items
™| Surm of chosen items
™| Awerage of chosen items:
— Output control
¥ Fiesporss time histony
™ Peak response summary ! Positive/negative ™| Envelope

odify.... |
[ptions... |
|1:15.D 'I

[ptions... |

< Back I

Finizh

Apply |

Cancel |

Help |

Mode 1672, Speed 15.0000000000000: Translational Acceleration Time History

4.2

3.7
3.2

27

22
17 b -

12+
07 -
02n
03

Acceleration

e When the graph has been displayed, close the graph

12
13
17 L

= w w

Response Time

Previously we have investigated the displacement and acceleration response of the mid-
span of the bridge deck for a single train speed. We will now look at the peak positive
and negative vertical displacement and acceleration responses of the mid-span over the
speed range of 15 m/s to 70 m/s as specified previously in the moving load analysis

control dialog.
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[IMDPIUs >
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Moving Load
Analysis...

Viewing the Results

If the IMDPlus toolbar has been enabled,

Click on the EI button in the toolbar to open the IMDPlus Output Control dialog

If the IMDPIlus toolbar is not enabled,

Open the IMDPlus Moving Load Analysis Control dialog through the menu and
click Next > to keep the existing analysis control settings and open the IMDPlus
Output Control dialog.

On the IMDPlus

Output COIltI'Ol —MNodeselement selection
dialog select * Node " Element Entity IDisplacement |
DISplacement results Extent Im Component IDZ j
of DZ for the vertical
component only Node [1672 -] I Individual items
' ™| S of chesenitems
Deselect the ™| &verage of chosen items
ReSpOﬂSE time —Output control
histo ry Option [ Fesporss time history
S 1 t th Peak ¥ Peak response summary & Positive/negative ™ Envelops
clec (&
" Absolute
response summary ;
. [ Secondary response spechra [SAS) I cdifyy.... |

option and select
Positive/negative ™ Modal combination/factar histary [ptions... |
Click th Appl [ Generate graphs in Modsller Speed to araph |1:15.D YI

1C (5] PPy
button to proceed [ Generate textfile output Dptians... |

< Back | Finish I Apply | Cancel | Help |

The IMDPlus analysis will now run.
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IMDPlus >

Moving Load >

Moving Load

Analysis...

Train Induced Vibration of a Bridge

MNode 1672: Translational Displacement Summary

Displacerment

a0 H | |
W o~ m o= Mmoo Mk m o= MWk m o= moW M ® — M o M m o— Mo [~ m = Mm L
L S T T T A O T v O T L T B S SNV T SN v S Pe S+ R /= N I~ - - B T S L

%‘Pasltwe Dz
—— Negative DZ

e When the graph has been displayed, close the graph

If the IMDPlus toolbar has been enabled,

e Click on the El button in the toolbar to open the IMDPlus Output Control dialog
If the IMDPlus toolbar is not enabled,

e Open the IMDPlus Moving Load Analysis Control dialog through the menu and
click Next > to keep the existing analysis control settings and open the IMDPlus
Output Control dialog.

o Select Acceleration results of AZ for the vertical component only

e Click the Apply button to display a graph of acceleration versus speed at the mid-
span.
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IMDPlus >

Moving Load >

Moving Load

Viewing the Results

Analysis...

Mode 1672 Translational Acceleration Sumrmary

Acceleration

—t+— Pusitive AZ
—&— Negative A7

e When the graph has been displayed, close the graph

Stress Resultant Graphs for Shells

In the previous section the displacement and acceleration responses at the mid-span of
the bridge were investigated. We will now look at the stress resultants in the web of one
of the main girders. Results for element number 1193 in the centre of the web of the

nearside girder will be investigated.

If the IMDPlus toolbar has been enabled,

e Click on the EI button in the toolbar to open the IMDPlus Output Control dialog
If the IMDPlus toolbar is not enabled,

e Open the IMDPlus Moving Load Analysis Control dialog through the menu and
click Next > to keep the existing analysis control settings and open the IMDPlus
Output Control dialog.

Enter the following information into the IMDPlus Output Control dialog.
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e Sclect Element and

ensure Extent —Modeselement selection

remains set as ' hode & Element Entity |Force/Moment - Thick Shel =l

I nd IVIduaI Extent Ilndividual VI Comporent INx j
e Enter Element Element  [1193 | ¥ Individual ftems

number 1193 and set . ™| S of chosen items

Gauss Point I‘I vl
Gauss Point to 1 = | &verage of chosen items
r— Dutput contral

* SeleCt V¥ Response time histary

Force/Moment - — P, _——

. ‘eak rezponse summary * L ISOsiivE/AEdative MVEIDRE:
Thick Shell results
f NX which is the _— |
() ’
. I™| Secondanyresponse spectia [SHS) Fmdify...

stress resultant in the

10ngitudinal brldge I Modal combinationfactor bistory Dptiars... |

dlrectlon. W Generate graphs in Modeller Speed to graph |12:?D.D 'l
o Ensure Individual [ Generate textfils output Optians... |

items is selected.

Sum Of Chosen Items < Back | Finish I Apply | Cancel | Help |

and Average of
chosen items will
not be available as an individual element is being processed.

¢ Ensure the Response time history option is selected.
e Deselect the Peak response summary option.

e Set the Speed to graph as 12:70.0 which indicates that the twelfth and last speed of
70 m/s is being processed.

e Click the Apply button to display a graph of Nx versus time for gauss point 1 of
element 1193.

The IMDPlus analysis will now run and a graph of Nx versus time for gauss point 1 of
element 1193 will be displayed.
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IMDPlus >

Moving Load >

Moving Load

Analysis...

Viewing the Results

Thick Shell Element 1193 Gauss Paoint 1, Speed 70.0000000000000: Stress Resultant Tirme History
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110000 f--
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-130000 f----
-140000
-150000_5

Force/Unit Width In Element Local Axis

Response Time

i3

e When the graph has been displayed, close the graph

If the IMDPlus toolbar has been enabled,

e Click on the EI button in the toolbar to open the IMDPlus Output Control dialog
If the IMDPlus toolbar is not enabled,

e Open the IMDPIus Moving Load Analysis Control dialog through the menu and
click Next > to keep the existing analysis control settings and open the IMDPlus
Output Control dialog.

e Select Force/Moment — Thick Shell results of Mx which is the moment in the
along bridge direction

e Click the Apply button to proceed.

After a short pause a graph of Mx versus time for gauss point 1 of element 1193 will be
created.
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Thick Shell Element 1193 Gauss Point 1, Speed 70.0000000000000: Stress Resultant Tirme Histary

Mornent/Unit Width In Elernent Local Axis
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i oMo W - = = = wowowmow

22
24f T
286

Response Time

e When the graph has been displayed, close the graph
If the IMDPlus toolbar has been enabled,

e Click on the El button in the toolbar to open the IMDPIlus Output Control dialog
If the IMDPIlus toolbar is not enabled,

e Open the IMDPlus Moving Load Analysis Control dialog through the menu and
click Next > to keep the existing analysis control settings and open the IMDPlus
Output Control dialog.

e Deselect the Response time history option
e Select the Peak response summary option and select Absolute
e Click the Finish button.

e Click Yes when asked whether to free up disk space by deleting the temporary files
created by IMDPlus.

A graph of absolute peak Mx versus speed for gauss point 1 of element 1193 will be
generated.
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Thick Shell Element 1193 Gauss Paint 1: Absolute Stress Resultant Summary

B feeree
114
112
110
108
106
104
102
100 f----
98 k-
5
94
92
a0 F- -
a3

Faorce/Unit Width In Elerment Local Axis

e Close the graph window.

Displaying Results for a Selection of Nodes and Elements

In the preceding sections the analyses utilised individual nodes and elements of the
structure. In the following sections chosen sets of nodes and elements will be used in
order to investigate the following results for the bridge structure:

U Averaged and peak displacements and dynamic amplification factors
U Total summed reactions and peak reactions
U Averaged and peak stresses in a side panel

Averaged and Peak Displacements and Dynamic
Amplification Factors for the Bridge Structure

In order to examine the averaged and peak displacements and dynamic amplification
factors, a selection of nodes needs to be created that contains all of the nodes of the
bridge structure.

e Turn off the Geometry layer in the Treeview.

e In the Treeview click the right-hand mouse button on the group name
Bridge_Structure and select the Set as Only Visible option from the drop-down
menu.

M Using Select Nodes drag a box to select all of the 1665 nodes of the bridge
structure, as shown in the following figure.
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Drag a box to select all the
nodes of the bridge structure

AR
/MW%\%/
‘.!Il;\ N

A

Y

e Open the IMDPlus Moving Load Analysis Control dialog through the menu or click
on the ;l button in the toolbar.

>

Moving Load >

Moving Load
Analysis...

e On the IMDPIlus Moving Load Analysis Control dialog click the Next button to

| utilities
IMDPlus

accept the previously defined values. When prompted about the total mass

participation click the Yes button to continue.

Enter the following information into the IMDPlus Output Control dialog.
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e Sclect Node and

change Extent to —Modedelement selection

Selected using the & Mode " Elament Entity IDispIacement j
drop—down list. This Extent I Selected - I Companert I 0z j
chooses all 1665

nodes of the brldge Node |15?2 vl [ Individual items

[~ Sum of chosen items

structure that were
selected in the
preceding step.

V¥ Average of chosen items

— Dutput control

™ Responze time hiztory

b Se.leCt I'CSlllt 61’1tity ¥ Peak response summary & Positive/negative ¥ Erwelope
Displacement  and € absolte
Component Dz | Secondan response. spectra (SRS Fmdify... |
e Deselect Individual ™ Modal combinationfactar histary Optians... |
itemS and SeleCt ¥ Gererate graphs in Modeller Speed to graph |12:?D.D 'l
Average Of Chosen [” Generate textfile output Wptians... |
items as only the
averaged results for
the Selected nodes < Back | Finish I Apply | Cancel | Help |
are going to be
investigated.

e Ensure Peak response summary remains selected, then select Positive/negative
and Envelope

e Ensure Generate graphs in Modeller remains selected

e Click the Apply button to perform the analysis. Click Yes when asked whether you
want to process all of the selected nodes.

The IMDPlus analysis will now run. On modern computers this will take under 15
minutes.

Note. Any combination of the options Individual items, Sum of chosen items and
Average of chosen items output can be used together in an IMDPlus analysis,
although using the Individual items option when Extent is set to Selected or All
(nodes or elements) may produce a large number of graphs, depending on the number
of nodes or elements chosen for processing.

Note. Average of chosen items obtains results by first summing the results from the
selected nodes. A simple average of this summed result is obtained to give the averaged
node time histories from which the peak average results are obtained.

A graph of peak positive and negative results for the averaged vertical (DZ)
displacements, for all of the speeds analysed, 15m/s to 70m/s, is displayed as shown in
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the following figure. It can be seen that the largest peaks occur at a speed of 55m/s,
with positive and negative peak values of 0.0013m and -0.0061m respectively.

Mode Set Avy: Translational Displacement Surmary

0.001 |-
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0002 |-t

Displacement

D003 |oocbee b

0004 [-oecb oot
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-0.007
o
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—— Positive DZ
#Neganve Dz

An envelope of the peak displacements and rotations for the selected nodes is displayed
in Notepad in file peak dspSetl.sum. By investigating all of the speeds analysed it can
be seen that the individual peak vertical (DZ) displacements also occur at a moving
load speed of 55m/s. These are shown in the following figure and both positive and
negative peak Z-displacements occur at node 1624 with respective values of 0.0044m at
time 4.656 seconds and -0.0204m at time 6.826 seconds.

Note. The envelope of the peak results is obtained in IMDPlus by examining the
individual results from all of the nodes in the bridge structure. This enables the
locations of the nodes with maximum and minimum results to be quickly identified.

#
#*

#F +

# | speed = 55.0000000000000 |

L e e e L e Tt +

&+

# Entity Time value Mode
rpeak_Pos_Dx 6. 807000000 0.3177041183E-002 1028
Peak_Meg_Dx 6. 815000000 -0.1450325103E-002 2302
Peak_Pos_Dy 6. 830000000 0.1432152932E-001 1617
Peak_Meg_py 6. 834000000 -0.1436008318E-001 16946
reak_Pos_DZ 4., 656000000 0.4432708343E-002 1624
Peak_Meg_Dz 6. 826000000 -0.2040436034E-001 1624
Peak_Pos_THx 6. 837000000 0.1278003970E-001 1654
Peak_Meg_THx 6. 837000000 -0.1272787014E-001 1673
Peak_Pos_THy 6. 974000000 0. 5659962656E-002 950
Peak_Meg_THY 0. 5750000000 -0.8138300538E-002 2285
reak_Pos_THZ 0.4680000000 0.44590018200E-002 1861
Peak_Meg_THz 7150000000 -0.4332880472E-002 2277

e Close the Notepad application and graph windows.
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IMDPIus >
Moving Load >

~ [Moving Load
Analysis...

Viewing the Results

If the IMDPlus toolbar has been enabled,

e Click on the EI button in the toolbar to open the IMDPlus Output Control dialog
If the IMDPIlus toolbar is not enabled,

e Open the IMDPIus Moving Load Analysis Control dialog through the menu and
click Next > to keep the existing analysis control settings and open the IMDPlus
Output Control dialog.

Enter the following information into the IMDPlus Output Control dialog.
e Select result entity Dynamic Amplification Factor and component DAF_RSLT

e Ensure Peak response summary and Envelope remain selected and select
Absolute

e Click the Finish button. Click Yes when asked whether you want to process all of
the selected nodes.

e Click Yes when asked whether to free up disk space by deleting the temporary files
created by IMDPlus.

A graph showing the absolute peak of the average resultant dynamic amplification
factor against speed is displayed, as shown in the following figure. This shows that a
maximum averaged DAF of 1.215 occurs at speed 55m/s.

Note. Only averaged dynamic amplification factor results can be obtained for a set of
nodes as summed results are meaningless for this result entity.

MNode Set Avg: Absolute Translational DAF Summary

——DAF_RSLT
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An envelope of the peak dynamic amplification factors for the selected nodes is
displayed in Notepad in file Abs_peak dafSetl.sum is. These results indicate that the
individual peak resultant DAF occurs at a speed of 60m/s. A value of 1.71 is calculated
at a solution time of 0.529 seconds at node 34.

#
#

#F o +

# | Speed = &0.0000000000000 |

# o +

#

# Entit Time value Mode
ahs_Peak_DAF_Dx . 284000000 1.965105582 10587
ahs_Peak_DAF_DY 0. 6690000000 3.252813452 1582
abs_Peak DAF_DZ 6. 367000000 1.578463432 2412
ahs_Peak_DAF_THxX 0. 6710000000 4. 548161937 1624
ahs_Peak_DAF_THY 6. 351000000 1.652702600 1296
abs_Peak DAF_THZ 6.423000000 2.023501402 1112
Abs_peak_RSLT [y 0.5290000000 ) 1.712660095 ) 34

e Close the Notepad application and graph window.

Total and Peak Reactions for the Bridge Structure

The total sum of the reactions and the peak reactions that act on the bridge structure for
each of the moving load speeds will now be investigated. The set of nodes from the
preceding section could be utilised for this purpose. However, in order to improve the
efficiency of the IMDPlus solution, the chosen selection of nodes will be reduced so
that it only includes the geometric features that contain the supported nodes of the
bridge structure.

e Click the left-hand mouse button in a blank part of the graphics window to remove
the node selection created in the preceding section.

= =
|_| In the LUSAS graphics window click on the Supports on/off button to show the
supported nodes in the model.

e In the Treeview click the right-hand mouse button on the group name
Bridge_Structure and select the Set as Only Visible option from the drop-down
menu.

e Turn on the Geometry layer in the [ Treeview.

ﬁ Using Select Volumes drag a box around the entire bridge structure to select the
volumes immediately above the bridge supports, as shown in the following figure.
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Click the right-hand mouse button in a blank part of the graphics window and select

the Keep as Only Visible option. Only the selected volumes will remain visible.

M Using Select Nodes drag a box to select the 120 visible nodes of the bridge

structure, as shown in the following figure.
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Drag a box to select all

;F? of the visible nodes
L o o k
| Utilties ¢ Open the IMDPlus Moving Load Analysis Control dialog through the menu or click
IMDPIus > -
[Moving Load > on the _|- button in the toolbar.
Moving Load
(Analysis. o On the IMDPlus Moving Load Analysis Control dialog click the Next button to

accept the previously defined values. When prompted about the total mass
participation click the Yes button to continue.

Enter the following information into the IMDPlus Output Control dialog.
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e Sclect Node and

ensure Extent —Modedelement selection
remains set to & Node = Element Enrlity I Reaction j
Se I eCted . ThlS Extent I Selected - I Component I FZ j

chooses the 120
visible nodes of the Node [iE72 | B

bridge structure that G e e
were selected in the
preceding step.

[ Average of chosen items

— Dutput control

¥ Fesponze time hiztory

b SeleCt I'CSlllt 61’1tity ¥ Peak response summary & Positive/negative ¥ Erwelope
Reaction and " Absalute
component FZ | Secondan response. spectra (SRS Fmdify... |
e Deselect Average of ™ Modal combinationfactar histary Optians... |
Chosen items and ¥ Gererate graphs in Modeller Speed to graph |9:55.D 'l
_SeleCt Sum Of Chosen [” Generate textfile output Wptians... |
items. Ensure
Individual items
remains deselected. < Back | Finizh I Apply | Cancel | Help |
e Select Response
time history

e Ensure Peak response summary and Envelope remains selected and select
Positive/negative

e Ensure Generate graphs in Modeller remains selected.

e Set the Speed to graph as 9:55.0 which indicates that the ninth and speed of 55 m/s
is being processed

e Click the Finish button to perform the analysis of the node set. Click Yes when
asked whether you want to process all of the selected nodes.

e Click Yes when asked whether to free up disk space by deleting the temporary files
created by IMDPlus.

Note. Sum of chosen items adds together the results from the selected nodes to give
the summed nodal time histories from which the peaks of the summed results are
obtained.

Note. Average of chosen items obtains results by first summing the results from the
selected nodes. A simple average of this summed result is obtained to give the averaged
node time histories from which the peak average results are obtained.
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The summed nodal results that give the total vertical reactions acting on the bridge
structure are displayed. The graph of the peak positive and negative summed reaction in
the Z-direction for all of the speeds analysed is shown in the following figure.
Examining the results for each speed shows a positive peak reaction of 976.6kN at a
train speed of 55m/s and a negative holding down peak reaction of -159.0kN at a speed
of 60 m/s.

Mode Set Sum: Force Summary
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In addition, the following figure shows the time history of the summed FZ reactions for
the analysis speed of 55m/s. For this speed it can be seen that the positive peak value of
976.6kN occurs at an analysis time of 6.81 seconds.

MNode Set Sum, Speed 55.0000000000000: Force Time History

1.7e6 f---
166 (-
900000 |---
800000 -
700000 |
600000 |- - -
500000 -

Force

400000 |- -
300000 {-- - 4-
200000 -
100000 |-{-

0
-100000 - -

-200000

O™ =T @M — WO MmN T @M@ MM T O T T @MW M T WM WO N T @M M NT oo m
oo oo - = = = oo Momomom = s s W owowow (L= TR ) (RS

Response Time

FZ

148



Viewing the Results

The envelope of the peak reactions from file peak rctSetl.sum are displayed in a
Notepad application. These give a summary of the peak reactions obtained from all of
the individual nodes of the bridge structure for each of the moving load speeds
analysed. The vertical (FZ) component of interest shows consistently that the maximum
positive reaction (from a downward force) occurs at node 82 and the maximum
negative reaction (from an upward force) occurs at node 112. Results for speeds of
55m/s and 60m/s are shown in the following figure.

#

#

#F—_— +

# | speed = 55. 0000000000000 |

#F +

#

# Entity Time value Mode
Peak_Pos_Fx 6, 756000000 52731.24971 =]
Peak_Neg_Fx 4, 576000000 -18589, 20194 =]
Peak_Pos_FY 7. 015000000 22B81.92033 6o
Peak_neg_F¥ 6, 934000000 -19169,. 69107 =]
Peak_Pos_FZ ) 0. 53760000000 250862.3328 —————) 82
Peak_neg_FZ 2, 343000000 -135238. 8224 112
Peak_Pos_Mx eSS [HES: g
Peak_Neg_mx MR IRy M,
Peak_Pos_my MR IRy M,
Peak_Meg_pryv 1A A [
Peak_Pos_mz 1A M A [
Peak_Meg_mMz N IR M
#

#

L e +

# | sSpeed = 50.0000000000000 |

L +

#

# Entity Time value Mode
Peak_Pos_Fx 6.196000000 48130.35311 =]
Peak_Neg_Fx G, 722000000 -17547.90507 32
Peak_Pos_F¥ 0. 6700000000 23428, 89095 =]
Peak_Neg_FY 0. 7000000000 -22936,61174 ]
peak_Fos_FZ 0. 5340000000 257957, D082 82
Peak_Neg_FZ ) 6.367000000 ) -145133.7444 ) 112
Peak_pos_Mx ML A, MA M A
Peak_Neg_mx N RS M
Peak_Pos_my RS (IR M
Peak_Meg_my RS RS M,
Peak_Pos_mz MR IRy M,
Peak_Neg_mz MR (IR M,

The maximum positive reaction of 259.9kN occurs at a time 0.576 seconds for speed
55m/s and the maximum negative reaction of -145.1kN occurs at a time 6.367 seconds
for speed 60m/s.

e Close the Notepad application and graph windows.

The nodes 82 and 112 representing two of the vertical supports for the bearings of the
bridge will now be located in the model.

e Click the left-hand mouse button in a blank part of the graphics window to remove
the node selection created in the preceding section.
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e In the Treeview click the right-hand mouse button on the group name
Bridge_Structure and select the Set as Only Visible option from the drop-down
menu.

e Turn off the Geometry layer in the [ETreeview.

e With no features selected click the right-hand mouse button in a blank part of the
graphics window and select the Labels option to add the labels to the Treeview.

e On the Properties dialog select the Name/Node and Label selected items only
check boxes.

e Click the Font... button and select Font: Arial, Font style: Bold, Size: 20 and click
OK.

e Click the OK button to accept all other settings. This will turn on the layer in the
graphics window.

e With no features selected click the right-hand mouse button in a blank part of the
graphics window and select the Advanced Selection... option.

e Select Type and Name, select Node from the drop-down list and enter node
number 82

e Select Add to selection and click the Apply button to accept all other settings.
Node 82 will be highlighted in the graphics window.

e Enter node number 112 and click the OK button. Node 112 will also be displayed in
the graphics window, as shown in the following figure.
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e Click the left-hand mouse button in a blank part of the graphics window to remove

the node selection.

Treeview.

Finally, the average peak and total peak in-plane shear stresses in a side panel of the

bridge structure will be investigated.

Average and Peak Stresses in a Side Panel of the Bridge

Structure

e Double-click on the Labels layer name in the

OK button.

e On the Properties dialog de-select the Name/Node check box and select the
Name/Element check box. Click the

M Select the six elements

that form the side panel of the bridge structure shown in the

following figure.
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\'

o\ooo/

Note. Only elements of the same type, for example, thick beam elements, continuum
elements or thick shell elements can be used in a set of IMDPlus elements. However,
the element set may contain elements with different numbers of Gauss points or nodes.

e Open the IMDPIus Moving Load Analysis Control dialog through the menu or click
on the ;l button in the toolbar.

>

Moving Load >

Moving Load
Analysis...

e On the IMDPIlus Moving Load Analysis Control dialog click the Next button to

IMDPlus

| utilities

accept the previously defined values. When prompted about the total mass

participation click the Yes button to continue.

Enter the following information into the IMDPlus Output Control dialog.
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e Select Element and

set Extent to —Modedelement selection

Selected from the " Mode & Element Entity | Stress [middle) - Thick Shel =l
drop—down hSt ThlS Extent lm Component ISxy j
chooses the 6

elements of the Element lm [ Individual items

bridge structure that GaussPant [0l <] L) Sumof chosensms

V¥ Average of chosen items

were selected in the
preceding step.

— Dutput control

™ Responze time hiztory

d SeleCt I'CSlllt 61’1t1ty ¥ Peak response summary & Positive/negative ¥ Erwelope
Stress (middle) - " Absolute
ThICk She" and | Secondan response. spectra (SRS f mlify. |
component SXy _
™ Modal combination/factor histary [ptiong... |
i Desele(:t Sum Of ¥ Gererate graphs in Modeller Speed to graph |9:55.D 'l
chosen items and |
™ Generate textfile output [ptions...

select Average of
chosen items. Ensure
IndiVidUaI Output < Back | Finizh I Apply | Cancel | Help |
remains deselected.

e Deselect Response time history

e Ensure Peak response summary, Positive/negative and Envelope all remain
selected.

e Ensure Generate graphs in Modeller remains selected.

Note. As Extent has been set to Selected the drop-down lists Element and Gauss
Point are not available for selection. In addition the element Gauss Point is
automatically set to All as multiple elements are going to be processed in a single
analysis.

e  Click the Finish button to perform the analysis of the element set. Click Yes when
asked whether you want to process all of the selected elements.

e Click Yes when asked whether to free up disk space by deleting the temporary files
created by IMDPlus.

The graph shown in the following figure is displayed. It shows the peak positive and
negative, average middle shear stress, Sxy, for the side panel of the bridge structure.
The largest positive and negative peaks occur at a speed of 55m/s with values of
2.05Mpa and -10.2MPa respectively.

Note. Average of chosen items obtains the element results by first summing the
results from all of the Gauss points of the selected thick shell elements. A simple
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average of these summed results is obtained to give the average element response time
histories from which the peak average results are obtained.

Thick Shell Element Set Avg: Middle Stress Summary
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An envelope of the peak element stresses for each of the moving load speeds is
displayed in Notepad in file peak stressSetl.sum. This gives a summary of the peak
stresses and stress resultants obtained by examining all of the individual Gauss point
results of the selected elements. The results for speed 55m/s are shown in the following
figure. The maximum positive and negative middle in-plane shear (Sxy) stress occurs at
Gauss point 2 of element 560. Values of 2.69MPa at time 7.224 seconds and -13.6MPa
at time 6.986 seconds are observed.
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[ File

|Save...

#+

#

# 4 - - - ;

# | sSpeed = 55.0000000000000 |

# 4 - - - t

#+

# Entity Time value Element =13l
Peak_Pos_Top_Sx 6. 804000000 6l78B32. 782 580 1
Peak_Meg_Top_Sx 6. 981000000 -177244093, 52 564 4
Peak_Pos_Top_Sy 6, 812000000 3238750.965 560 1
Peak_heq_Top_sy 6. 797000000 -5028205.725 559 4
Peak_POS_Top_Sxy 7. 224000000 2745000, 347 560 3
Peak_Meg_Top_Sxy 6, GELO00000 -11816861. 23 a0 2
Peak_Pos_Top_Syz 6. 812000000 0.1396187750E-023 a0 2
Peak_Meg_Top_Syz 6. 803000000 -0.1716030574E-0.23 559 2
Peak_Pos_Top_Szx 6. 906000000 0.7440377432E-024 560 1
Peak_Meg_Top_Szx 6, 824000000 -0.1110811094E-023 559 2
peak_Pos_mid_sx 6. 985000000 5728221.278 560 2
Peak_Neg Mid_sx 6, 9Ea000000 -16401763. 30 264 4
Peak_Pos_Mid_sy 6. 980000000 32434471 . 704 a0 2
Peak_neg_mMid_sy 6. 796000000 -5224766.419 559 4
Peak_Pos_Mid_sxy 7.224000000 2685334, 300 560 2
Peak_Meg_Mid_sxy 6, 986000000 -13610114. 52 560 2
peak_pos_mMid_syz 0.1350000000 236128.4546 560 2
Peak_nNeg_mMid_syz G, S04 000000 -226209, 2633 362 2
Peak_Pos_Mid_Szx 6. 814000000 341032. 8462 a0 1
Peak_neg_Mid_szx 6. 913000000 -322802.1144 580 1
Peak_Pos_Bot_Sx 6. 980000000 6474520.454 560 2
Peak_Neg_Bot_Sx 6, 803000000 -16534341.68 564 4
Peak_PoOS_BOt_Sy 0. 3340000000 4167596, 897 562 2
Peak_Meg_Bot_Sy 6. GE0000000 -5722445.457 5509 4
Peak_Pos_Bot_Sxy 7. 223000000 3133803, 240 5309 2
Peak_Meg_Bot_Sxy 6. 801000000 -16182311. 53 580 2
Peak_Pos_Bot_Syz 6, 801000000 0.2213546367E-023 560 2
Peak_Meg_Bot_Syz 0. 3410000000 -0, 201030894 9E-0.23 559 2
Peak_PoS_BOt_Szx 0. 5380000000 0.42212535670E-023 559 2
Peak_Heg_Bot_Szx 6. 840000000 -0, 1863288508E-023 560 1
Peak_Pos_Mx 6, 985000000 72748,41024 a0 2
Peak_Meg_Mx 6. 986000000 -208302,3030 S84 4
Peak_Pos_My 6. 980000000 411591, 71079 560 2
Paak_heg_hy 6. 796000000 -66354. 53352 559 4
Peak_Pos_Hxy 7.224000000 34154, 54573 560 2
Peak_Meg_Nxy 6. GEE000000 -172848.4544 560 2
Peak_Pos_Mx 7011000000 01, 80102037 262 1
Peak_Keg_Mx 6. 909000000 -138.1163838 ha2 1
Peak_Pos_My 6. 873000000 FT.03755272 562 4
Peak_keg_ My 6. 907000000 -100. 7634410 562 1
Paak_Fos_Mxy 6. 974000000 88. 52683013 559 2
Peak_Meg_mMxy 6, 906000000 -35.90002843 560 2
Peak_Pos_3x G, 814000000 2BE7.400738 a0 1
Peak_Keg_sx 6. 913000000 -2733.057002 a0 1
Peak_Pos_sy 0.1350000000 1960, 220015 580 2
Peak_Meg_sy 6. 914000000 -1915. 258685 562 2

e Close the Notepad application and graph windows.

Save the model

Save the model.

This completes the example.
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Description

High Speed Train
Modelling through
Sprung Masses

For software product(s): | Any Plus version

With product option(s): IMDPlus

Note: The example exceeds the limits of the LUSAS Teaching and Training Version
and requires approximately 4 GB of disk space.

Description

? 29 38 8% 3%

This example examines the response of a two-span continuous beam to the passage of a
Chinese CRH high speed train modelled as sprung masses based on the paper by Wang
et al, Latin Journal of Solids and Structures 7 (2010).

Units used are N, m, kg, s, C throughout.

Objectives
The output requirements of the analysis are:
O Vertical mid-span deflection response of the two spans for a train speed of 250
kph
U Peak mid-span vertical deflections in the Y-direction for train speeds between 25
kph and 600 kph in 25 kph increments
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Modelling

High Speed Train Modelling through Sprung Masses

U Vertical mid-span deflection response of the two spans for a train speed of 300
kph, the critical velocity exciting the first resonant frequency of the continuous
beam

U Displacement time histories of the body and wheel of the first and last spring-
mass systems for a train speed of 300 kph and acceleration time histories of the
bodies

U Peak acceleration time histories of all locomotive and passenger bodies over the
speed range of 25 kph to 600 kph

Keywords

Moving mass, time domain, response, interactive modal dynamics, [IMDPIlus,
eigenvalue.

Associated Files

U CRH Train.Imd Attribute library that contains the CRH train definition for
the example.

U CRH_Wheelset_Positions.xls Microsoft Excel spreadsheet that
contains the wheel positions and spring-mass system identifiers of the CRH train
for the example.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command File
> New to start a new model file. Modeller will prompt for any unsaved data and display
the New Model dialog.

Creating a new model
e Enter the file name as IMDPIus CRH High Speed Train

e Choose User-defined and browse to the \<LUSAS Installation Folder>\Projects\
folder, click on the Make New Folder button and enter IMDPlus CRH Analysis as
the folder name and click the OK button

e Enter the title as IMDPIlus Sprung Mass Modelling of CRH High Speed Train

e Ensure the model units are N,m,kg,s,C
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| Geometry
| Line >
Coordinates...
| Geometry
| Line >
Coordinates...
| Attributes
|Mesh >
[Line...

Modelling

¢ Ensure the timescale units are Seconds
e Ensure the analysis type is Structural
e Ensure the Startup template is None

e Select the Vertical Y axis option and click OK

Feature Geometry

Enter coordinates of (0, 0), (20,0) and (40, 0) to define the lines representing the
main features of the two-span continuous beam.

This completes the geometry for the beam that the train will pass across. A further line
must also be defined which will be used by IMDPlus to define the path that the train
passes along since this line cannot form part of the physical structure.

Enter coordinates of (0, 10) and (40, 10) to define the line above the two-span
continuous beam that represents the path of the train (line is defined above for ease of
selecting, the train loading will be projected from this line vertically onto the structure).

Meshing

The Line features representing the two-span continuous beam are to be meshed using
two-dimensional beam elements.

e Select Thick beam, 2 dimensional, Linear elements.
e Set the number of divisions to be 20

e  Enter the attribute name as Thick Beam then click OK
e Select the lines defining the two-span continuous beam.

e Drag and drop the mesh attribute Thick Beam from the & Treeview onto the
selected model Lines.

40 BEAM elements will be created along the lines.

Material Properties

The Line features representing the two-span continuous beam are to be assigned C50
concrete in accordance with the China National Standard: Code for Design of Concrete
Structures.
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| Attributes
| Material >

Material Library ...

| Attributes
| Geometric >
| Line ...

High Speed Train Modelling through Sprung Masses

e Select Concrete China material.
I aterial IConcrete China j
e Select GB50010-2002 C50 grade.
Grads |GES00 0-2002 £50 =
e  (lick OK to define the material. Properties
Young's modulus IW
e  With the lines defining the two-span beam Poissor's ralio oz
still selected, drag and drop the material Dersiy [z55e3
attribute  1sol  (Concrete  China L —— [ooes
GB50010-2002 C50) from the
Treeview onto the selected model Lines. ok | _cocd | ooow | ke |

Geometric Properties

The Line features representing the two-span continuous beam are to be assigned with a
custom section equivalent to the properties used in the paper by Wang et al. In this
paper the flexural rigidity EI value of 2.5E10 N/m® and mass per unit length of
3.4088E4 kg/m equate to the properties entered below.

e Select the usage as 2D
Thick Beam
Usage
e  Ensure the definition is set [0 Thick Beam ]| |[oxsections =]
to Enter Properties Definton [Uriversal Beams (63%) =
' From Library
. Raotation about centroid ID 'l ® |914x305x289kg UE j
e Set the Cross sectional & Enter Properties B
area (A) as 13.368
e Set the Second moment of
area about z axis (Izz) as
0.724638
¥
e Set the Effective shear
area in y direction (Asy) E
as 13.368E3 _ ENTE
Cross sectional area (&) 13.368
Second mament of area about z axis [|zz) 0724633
° Ensure the Eccentricity in Eftective shear area in y direction [Asy] 13.368E3
. . . Eceentiicity in v direction [ey) 0
y direction (ey) is set to
0.0
e  Enter the attribute name as
Cross-Section and click Yisualse, . | Tapering =3 Section details. .. |
OK
Mame ICross-Section j ﬂ (1
e  With the lines defining the

two-span  beam  still |
selected, drag and drop = ||

Help
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| Attributes

Support...

Modelling

the geometric attribute Cross-Section from the & Treeview onto the selected
model Lines.

Note. The effective shear area has been set to 1000 times the area of the section to
effectively remove shear deformation from the calculations of the beams. The paper
uses Bernoulli-Euler beams which do not account for shear deformations.

Supports

The continuous beam is supported with a pinned support at the left-hand end and is
supported by roller supports at the middle and right-hand end of the beam.

e  Set the Translation in X as Fixed

e  Set the Translation in Y as Fixed

e  Enter the attribute name as Pinned and click Apply
e Set the Translation in X as Free

e Leave the Translation in Y as Fixed

e  Enter the attribute name as Roller and click OK

e  Assign the Pinned support to the left-hand point, and the Roller support to the other
two points on the model as indicated below, clicking OK to accept the defaults
when the Assign Support dialog appears.

i
Assigned the Pinned support to this paint Assigned the Roller support to these points
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| Attributes

Loading...

| Attributes

High Speed Train Modelling through Sprung Masses

[Search Area...

Loading

To allow the IMDPlus moving mass analysis to be carried out a unit load representing
the action of the spring-mass system on the beam needs to be included in the model so
this can be passed across the beam to calculate the modal forces.

Click the left-hand mouse button in a blank part of the graphics window to remove
all items from the selection.

On the Structural
Loading dialog
select the Point
type  from  the
Discrete loading
section and click
the Next button

Ensure that
Arbitrary is
selected

Ensure that the

Untransformed load
direction is set to Y

Ensure the Project
in load direction is
selected

Enter a single load

Untransformed load direction - Projection wector
& arbitrary Ty owyz ¥ Praject in load direction
. o Project For prestress
Coarid  x |1 & v " surface normal
¥ I1 A compaonent ID.D
oz
f component | 1.0
£ component ID 1]

[ % Y 4 [ Load [
1] 0.0 ] 0.0 ]
MName IUnit wheelset Load j i’ (1)

< Back | Iext = | Finish | Cancel | Apply | Help |

into the grid with the X set to 0.0, Y set to 0.0 , Z set to 0.0 and the Load set to -1

so it acts downwards in the global Y axis direction

Enter the attribute name as Unit Wheelset Load and click Finish

Search Area

Set the attribute name as Continuous Beam and click OK

Select the lines defining the two-span continuous beam.

When the discrete load representing the single unit wheelset is passed across the
structure it is best practice to target the action of this load to the model using a search
area.
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Drag and drop the search area attribute Continuous Beam from the & Treeview
onto the selected model Lines.

Click the left-hand mouse button in a blank part of the graphics window to remove
all items from the selection.

Defining Eigenvalue Controls

Eigenvalue controls are defined as properties of the loadcase.

In the ‘™ Treeview expand Analysis 1 then right-click on Loadcase 1 and select
Eigenvalue from the Controls menu.

The Eigenvalue dialog will appear.

The following parameters need to be specified:

Ensure the Solution is set to Frequency

Set the Eigenvalues required to Range

Ensure the Range specified as is set to Frequency

Set the Minimum frequency as 0

Set the Maximum frequency as 50

Set the Number of eigenvalues as 0 to solve for all modes in the range

Ensure the Type of eigensolver is set as Default

Note. Eigenvalue normalisation is set to Mass by default. This is essential if the
/ eigenvectors are to be used for subsequent IMD analyses.

Click the OK button to finish.

|F”gave El Save the model file.

Running the Analysis

With the model loaded click the Solve button El and the Solve Now dialog will be
displayed.

Click the OK button to run the analysis.

A LUSAS Datafile will be created from the model information. The LUSAS Solver
uses this datafile to perform the analysis.
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Viewing the Results

| utilities

Print Results
Wizard...

If the analysis was run from within LUSAS Modeller the results will be loaded on top

of the current model and the loadcase results for each eigenvalue can be seen in the
Treeview. Eigenvalue 1 is set to be active by default.

Checking the Frequencies

The Wang et al paper lists only the first two frequencies but the other vertical
frequencies can be calculated from the equations in the paper. These frequencies of the
vertical modes below 50 Hz of the Bernoulli-Euler beams are listed below:

f, = 3.363 Hz, f, = 5.255 Hz, f; = 13.452 Hz, f, = 17.025 Hz, f; = 30.267 Hz,
f,=35.522 Hz

The frequencies obtained from the analysis are obtained from the Print Results Wizard.
e Select Active and click Next.

e Seclect Entity None and from the Type drop-down menu select Eigenvalues and
then click Finish. The eigenvalue / frequency results will be printed to the Text
Output window.

It can be seen that LUSAS has obtained 7 modes of vibration in the range of 0 to 50 Hz.
All of the modes of vibration listed above for the Bernoulli-Euler beam are closely
matched but with an additional mode of vibration, mode 5, at 22.990 Hz which was not
captured in the paper. This will be shown to be a horizontal mode of vibration below
which is not considered by Wang et al.

MODE EIGENVALUE FREQUENCY ERROR NORM
1 445.894 3.36075 0.100680E-10
2 1087.93 5.24953 0.414174E-11
3 7105.85 13.4162 0.828539E-12
4 11376.9 16.9759 0.470560E-12
5 20866.7 22.9904 0.843402E-12
6 35737.0 30.0870 0.219183E-09
7 49189.1 35.2984 0.466222E-06

Checking the Mass Participation Factor

Note. In order to carry out a successful IMDPlus analysis you should ensure that a
significant proportion of the total mass has been accounted for in the analysis. Ideally
this requires checking that around 90% of the total mass has been achieved in the global
directions. If less than 90% has been achieved no further modes need be included if the
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modes of vibration omitted cannot be excited by the dynamic input or a significant
proportion of the structure is restrained by support in these directions and therefore
cannot participate in the modes of vibration. The acceptability of the included modes of
vibration will vary from analysis to analysis but failure to check that a significant
proportion of the total mass has been accounted for may lead to important modes being
missed and subsequent errors in the analysis results.

Note. The mode shapes should also be checked as a mode can have a low mass
participation factor and still be significant in the analysis. This often occurs with
‘symmetrical modes’ where equal mass is moving in opposite directions in the mode
shape. This is the case for the first mode in this analysis which is a simple sinusoid
shape with one span moving up with the other of equal length and mass moving down.
This mode has a zero mass participation factor in the Y-direction but is an important
mode in the analysis (see the resonance of the beam to the train speed later in the
example). A certain amount of engineering judgement is therefore required for the
assessment of the importance of modes of vibration and this should be used in addition
to the simple checks on the sum of the mass participation included in the analysis.

e Select Active and click Next.

e Select Entity None and from the Type drop-down menu select Sum mass
participation factors and then click Finish. The Sum Mass Participation Factors
results will be printed to the Text Output window.

In can be seen that the 90% value has almost been achieved in both the X- and Y-
directions and is discussed in the note below.

MODE SUM MASS X SUM MASS Y SUM MASS Z
1 0.175061E-36 0.439835E-26 0.00000
2 0.135185E-34 0.738434 0.00000
3 0.178691E-30 0.738434 0.00000
4 0.338629E-29 0.745294 0.00000
5 0.810569 0.745294 0.00000
6 0.810569 0.745294 0.00000
7 0.810569 0.856006 0.00000

Note. In this analysis we are only including the first 7 modes of vibration with
frequencies up to and including 50 Hz. These 7 modes include the 6 vertical modes
considered by Wang et al and also an additional horizontal mode, mode 5, with 81.06%
mass participation in the X-direction. If more than 7 modes of vibration were included
then the sum mass participation would approach the 90% in all directions (solving from
0 to 100 Hz will give 12 modes of vibration which will give 90.06% in the X-direction
and 89.97% in the Y-direction but these higher modes may not be excited by the
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passage of the trainset and may not significantly contribute to the vibration response of
the structure).

e Close the text windows by selecting the close button in the top right hand corner of
the windows.

e Use the maximise button to increase the size of the graphics window.

Note. To simplify the use of IMDPlus for the rest of the example it is recommended
that the IMDPlus toolbar is enabled in LUSAS Modeller. To do this select the View >
Toolbars... menu command and enable the IMDPIus option in the list and click Close.

e If the IMDPIus toolbar has been enabled, click on the gl Moving Mass analysis
button in the toolbar to select a moving mass analysis and enable the toolbutton
shortcuts to the dialogs.

Defining the CRH Trainset

Before the analysis can be performed we need to define the sprung mass representation
of the CRH Chinese high speed trainset in LUSAS Modeller. This is a two stage
process where

1. the individual spring-mass definitions for the wheelsets / bogies / bodies need
to be defined,

2. the complete trainset configuration is defined.

The spring-mass representation from the paper will be used for the analysis which
includes only a single spring-mass definition that is used for all of the wheelsets of the
trainset.

e Open the IMDPIlus Spring-Mass System Properties dialog through the menu or click

on the il button in the toolbar. The wheelsets / bodies of the CRH train will be
defined with the wheelset as the unsprung mass and the body as the first spring-
mass.

166



Viewing the Results

IMDPlus Spring-Mass System Properties E
ISingIe SOrUng mass j Unsprung mass Sprung mass 1
_ hass 3300 9500
I¥' Damping Elastic spring stiffness 25ER
[~ manlinear springs Viscosity coefficient 4.5E4
) Balyninomisl
% piecewise lineat
Spring 1 stiffness Spring 2 stiffmess
| Stiffness | Deformation | | Stiffness | Deformation
1] il :
Piecewise
liniear;
COTMEressian
Piecewise
liear;
Lemsion
Mame | CRH Train Wheelset j ﬂ (1)

[a]4 I Cancel | Apply | Help

Select Single sprung mass from the drop-down list.
Ensure Damping is selected.

Enter the Mass of the Unsprung mass as 3300

Enter the Mass of Sprung mass 1 as 9500

Enter the Elastic spring stiffness of Sprung mass 1 as 2.5E5
Enter the Viscosity coefficient of Sprung mass 1 as 4.5E4
Enter the Name as CRH Train Wheelset

Click the OK button.

The Chinese CRH trainset in the paper consists of a total of eight cars. Using the
dimensions shown in the paper results in the following spring-mass systems to define
the total trainset.
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Car Distance from Previous Axle (m) | Distance from front of train (m)
Locomotive 0 0.0
Locomotive 2.5 -2.5
Locomotive 15 -17.5
Locomotive 2.5 -20.0
Passenger 1 5 -25.0
Passenger 1 2.5 -27.5
Passenger 1 15 -42.5
Passenger 1 2.5 -45.0
Passenger 2 5 -50.0
Passenger 2 2.5 -52.5
Passenger 2 15 -67.5
Passenger 2 2.5 -70.0
Passenger 3 5 -75.0
Passenger 3 2.5 -77.5
Passenger 3 15 -92.5
Passenger 3 2.5 -95.0
Passenger 4 5 -100.0
Passenger 4 2.5 -102.5
Passenger 4 15 -117.5
Passenger 4 2.5 -120.0
Passenger 5 5 -125.0
Passenger 5 2.5 -127.5
Passenger 5 15 -142.5
Passenger 5 2.5 -145.0
Passenger 6 5 -150.0
Passenger 6 2.5 -152.5
Passenger 6 15 -167.5
Passenger 6 2.5 -170.0
Locomotive 5 -175.0
Locomotive 2.5 -177.5
Locomotive 15 -192.5
Locomotive 2.5 -195.0

e Open the IMDPlus Moving Mass Vehicle Configuration dialog through the menu or
click on the EI button in the toolbar.

The moving mass vehicle is now defined using the Distance from front of train in the
table above and the spring-mass system. To simplify the definition of the vehicle the
positions and identifiers of the spring-mass systems are included in a Microsoft Excel
spreadsheet so they can be copied and pasted into the dialog.
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o Locate the
CRH_Wheelset_Positions.xls
spreadsheet ~ in_the oy Tl
\<LusaslnstallationFolder>\ z 25 T.EAH Train Wheelset
E] 178 1.CRH Train Wheelset
Examples\M odeller folder [} 20,0 TiEAH Train Whesiset
. ] -25.0 1.CRH Train Wheslset
aIld Open lt. E 275 1.CRH Train Wheelset
7 425 T.CRH Train Wheelset
L. ] -45.0 1:CRH Train Wheelset
e Select all of the 32 positions ] il TERH Train Wheslset
. 10 £25 1.CRH Train Wheslsat
and Spring-mass System 11 £75 1:.CRH Train Wheelset
. . . 12 00 T-CRH Train iwheelset
identifiers in the first and 13 50 R oo heelset —
14 #7h 1.CRH Train Wheelset
second columns and copy 15 5 1.CRH Train Wheekset
1 1 16 95.0 1:.CRH Train Wheelset
these to the Chpboard usulg 17 -100.0 T.CRH Train Wheelset
Ctrl+C 18 1025 1:CAH Train Wheelset
19 1175 1.CRH Train Wheelset
. 20 1200 1.CRH Tla!m wheelzet ﬂ
e Select both the Position and - BT Tt
Spring-mass system headers _ §
of the grid in the dialog and Heme [ 1 T ] 3o
paste these into the grid using
Ctr|+v Close I Cancel | Apply: | Help |

e Enter the Name as CRH Train
Once finished the dialog should appear as shown.
e  Click OK to create the vehicle configuration.

Note. Alternatively each Position in the table can be entered manually and the
Spring-mass system associated with each of the wheelset/body positions can be
selected from the drop-down lists containing the available spring-mass system property
attributes.

Note. The positions of the wheelsets should be defined as negative values to ensure
that the whole trainset passes over the structure. Negative values place the wheelsets
behind the front of the train which is at a position of 0. The movement of the front of
the train will be calculated from the start of the path to the end of the path with
additional time included in the IMDPlus solution to allow all of the wheelsets with
negative positions to pass along the path.

If any wheelsets are defined with positive values then these will already be the distance
down the path equivalent to the position entered in the trainset definition. Those
wheelsets with positive positions may already be over the structure at the start of the
IMDPlus analysis if the start of the path has not been defined to account for this. If any
positive positions are used then always ensure that the lines defining the beginning of
the path allow sufficient additional length in order to model the transition of the whole
of the train onto the structure correctly.
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Note. Once a trainset or vehicle has been defined it can be saved in a library so it can
be imported and used in future analyses without the need to go through all of the
definition process above. This is achieved through the Library Browser accessed
through the File > Import/Export Model Data... menu command.

Importing a Vehicle

If it proves time consuming or you are unable to obtain the same results shown later in
the example the spring-mass system and vehicle definition can be imported from the
library provided in the \<LusaslInstallationFolder>\Examples\Modeller folder.

0 CRH Train.Imd contains the vehicle library for the example.

e Select the Import from library to model option

e Click on the Choose file... button and browse to the CRH Train.Imd file in the
\<LusaslInstallationFolder>\Examples\Modeller folder.

e Select the IMDPIus (2) entries in the tree

e (lick the OK button.

After the spring-mass systems and vehicle @ |E |& |®@ & |BE |

attributes have been defined they will appear in | & ‘=3 MDPlus CRH High Speed Train.md
=423 Utilities (2)

the Utilities & treeview. =423 IMDPlus (2)
Ea SMS Properties (1)
To edit the spring-mass system or vehicle Eaihélec E:nTﬁr;L'::a\'t\:::?f; '
attributes simply double-click with the left =423 Moving Mass (1)

. . - e, I:CRHT i
mouse button or right-click and choose Edit e
Attribute... on the name of the attribute to bring

up the original dialog.

Moving Mass Analysis

Moving mass calculations are performed using the IMDPlus (Interactive Modal
Dynamics) facility. In order to carry out the moving mass analysis of the train travelling
across the structure we need to carry out three stages:

4. Define and set-up the path along which the spring-mass systems will travel
using a unit load defined as either a discrete point or patch load. For this
example the unit wheelset load has already been defined as a discrete point
load called Unit Wheelset Load which acts vertically
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5. Convert the loading along this path from this unit load into modal forces that
are applied in the IMDPlus moving mass analysis, to compute the dynamic
effects of the spring-mass systems on the response of the structure

6. Run an IMDPlus moving mass analysis to calculate the response of the
structure and the spring-mass systems

Note. This process is similar to the IMDPlus moving load analysis procedure but
with the trainset / vehicle defined by the spring-mass systems rather than constant
forces.

Defining the Moving Mass Path

To solve for the passage of the CRH train across the structure the path for the moving
mass must be defined. Line 3 (the line representing the path of the moving mass) will be
set to be the current selection.

To ensure the whole model is visible:

e In the Treeview click the right-hand mouse button on the group name IMDPIus
CRH High Speed Train.mdl and select the Visible option from the drop-down
menu.

e In the I=" Treeview click the right-hand mouse button and choose the On/Off option
if it has been turned off or alternatively double-click on the Geometry layer name
and click the OK button to accept the default settings if it was turned off.

e Select the line shown (line 3)

Shaight line 3, length=40.0
Paints : 4,5

e r r

Note. The path can be built from multiple lines and arcs but these must form a
continuous path without branching.
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e Open the IMDPlus Moving Load Generation dialog through the menu or click on
4+
the il button in the toolbar.

On startup of the IMDPlus Moving Load Generation dialog, all valid discrete loads and
search areas will be made available in the loading options along with information about
the path defined by the current selection.

In this example a single discrete load called Unit Wheelset Load which defines the unit
loading from a single wheelset of the train is present along with a search area that is
assigned to the bridge structure.

e Ensure 1:Unit Wheelset Load is

selected from the Moving load  -Loadingoptions
dataset list. Maving load dataset |1:Unit 'wheelset Load |
Search area D |1:Eontinuous Beam j

e Ensure 1:Continuous Beam is
selected from the Search area ID for
the assignment of the discrete » -

. MOTE: All existing loading will be removed and A —
loadlng. the maoving loads will start from loadcase 1

' Project onto line [ 20 line beam and frame models)

€ Project over area [ grilages, slabs and| 300 frame space]

—Load path options

Incremental distahce for maving load along path ID.‘I

Direction  © Fonwards  © Backwards

e Ensure Project onto line is selected
(the analysis is 2D so this should be
the only option).

Statofpath: ®=| 00  v=| 100 Z=| 00

e Click on the Advanced button to Finshofpath: %= | 400 v=[ 100 z-| 0o
adjust the inclusion of load Number of divisions/inciements to define full path: [ 400
characteristics. On the Moving Load —
Advanced Options dial'og choose the _:::E:[S;'T::z;ses b [0 = I¥ Datacheck
Exclude all load option for loads analysis ¥ Pun analyses
outside the search area, ensure the
load factor is 1.0 and click the OK
button.

] | Cancel | Help |

e On the IMDPlus Moving Load Generation dialog set the Incremental distance to 0.1

Note. Using search areas targets the application of the loading to the required
features as described in the Modeller Reference Manual.

Note. By default the incremental distance is set to one tenth of the length of the line
along which the load moves.

e Leave all other settings as their defaults and click the OK button to proceed and
choose Yes to save the current model.

The program will now generate the loading information for the 401 locations of the unit
wheelset along the path before returning control back to LUSAS Modeller.
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Note. The discrete loading locations defined by this dialog will be tabulated into five
datafiles with a maximum of 100 loadcases each and the analyses will be performed
automatically. These analyses will use the same file basename as the original model
with a numeric indicator appended to it (e.g. 00001, 00002, etc). They are required
for the modal force calculation stage.

Generating the Modal Force History for the Moving Mass

In the previous stage the passage of the unit train wheelset across the structure has been
defined. The modal forces for the IMDPlus solution now need to be calculated using
the Modal Force Calculator.

e Open the IMDPIlus Modal Force Calculator dialog through the menu or click on the
%l button in the toolbar.

o C(Click the OK button to accept IMDPlus Modal Force Calculator
the default information and —Modal force input options

proceed. First file contaiting —[1.MDPlus CRH High Speed Train~Analysis 1.mys ¥ |
eigenvalues

T atal number of eigervalue files = I 1

First file containing |2:IMDF'Ius CRH High Speed Train_00001. mys
static lnadzases

Mumber of loadcases in each static file = 100

—Moving load path options

Direction & Fonward  Backward

Ok Cancel Help

Identification of Output Nodes

In this example all of the output relates to the mid-spans of the two-span continuous
beam model. If the model is identical then these node numbers should be node 11 for
the first span and node 31 for the second span as shown below. These nodes will be
entered into the IMDPlus dialogs later.

- Lk
T Mode 11 T T
Elements: 11,10
(10.0, 0.0, 0.0)
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| IMDPIus >
| Moving Mass >

Moving Mass

Analysis...

&
i ! S !
Mode 21
Elements: 31, 30
[30.0, 0.0, 0.0)

Defining the Moving Mass Parameters

All of the basic moving mass information has now been defined for the IMDPlus
analysis. The next stage is to define the included modes, damping and speed
parameters.

Open the IMDPlus Moving Mass Analysis Control dialog through the menu or click
on the ;l button in the toolbar.
Ensure the Vehicle

configuration contains | "orameses
1:CRH Train

“ehicle configuration |1:CHH Train j
™ Path surface profilz I Browse.. |
Ensure that the Path
H . —Mode/damping control
su rface p rOfI Ie 1S not Total participating mass
selected. Included modes: Al Modify... | #-Direction I B.05 %

h I~ *-Direction 85.60
nc i 258 % Modify... |
Ensure that I 1uded Diefault damping % adify. I

Z-Direction IW k-
modes is set to All. If this
is not the case, click on the
Modify... button and

e

i

i Solution contral

Advanced solution options odify... |

Path surtace profile options I odify...
ensure the AIll modes e |

. . jet time af
option is selected. Minmoum speed [53 44 pesssaroroad  |°

. ) Maximum speed 63.44 I IMDPlus automatic time step [Mygquist]
Click on the Modify... _ _
Speed increment 0 Solution time step 2E-3

button to change the
Default damping. Enter
25 for the default
damping and click the OK
button.
In the Solution control <ok [[[Met> | cancel Help

section, click on the
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Modify... button to change the advanced solution options. Click the Defaults button
to set the default options and click the OK button.

¢ Enter the Minimum Speed as 69.44, the Maximum Speed as 69.44 and the Speed
Increment as O to analyse a single speed of 69.44 m/s which is equivalent to 250
kph.

e Enter the Quiet time after passage of load as 5

e Deselect the IMDPIlus determining time step (Nyquist) option so we can specify
the required time step.

o Enter the Solution time step as 2E-3

e Click the Next button to proceed. When prompted about missing total mass due to
mass participation factors below 90% choose Yes to continue. For this analysis we
are only interested in the contributions of modes of vibration up to and including the
first 7 modes (0 to 50 Hz) which means that we are not going to achieve the 90%
total mass target.

Vertical Mid-Span Displacement Responses

The IMDPIus Output Control dialog will appear. This controls the results output for the
model. The vertical displacement response at the mid-span of the two spans of the
continuous beam, nodes 11 and 31, for a speed of 250 kph will be investigated. The
first span, node 11 is investigated first.

e Choose Node and select Extent as Individual
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e Enter Node number 11
(This is the node in the
mid-span of the first span)

e Select Displacement
results of DY
e Ensure Individual items

is selected. Sum of chosen
items and Average of
chosen items will not be
available as an individual
node is being processed.
e Ensure Response time
history is selected.

e Ensure Generate graphs
in Modeller is selected.

e Click the Apply to
proceed with the analysis.

Note.

IMDPlus Moving Mass Dutput Control

—Mode/element selaction

= Node " Element Enity IDispIacement j
Extent IIndeuaI VI Companent IDY j
Nade 11 - IV Individual iterns

I= | S of chozer items

™| &verage of chosen items

—Spring-mass system selection

' Spring-mass system Fiesult IUnsp[ung mass j
Estent IIndividuaI j Entity IDispIacement ﬂ
System lm

— Output control

¥ Response time histary

| Positive/negative

= Bbsolute

I™ | Ervelope

fdmdifi.. |
[Dptions... |
|1 £9.44 =

[Hptions. |

Cancel | Help |

™ Peak response summary

™ Secondary response specta [SRS)
I Modal combinationfactor histomn

v Generate graphs in Modeller Speed to araph

™ Generate texfile output

<Back |[ Finsh |

Apply |

Clicking the Apply button instead of the Finish button keeps the IMDPlus

session active for subsequent graph plotting.

00025

MNode 11, Speed B3.4400000000000: Translational Displacement Time History

0.002 -

0.0015 |-

0.001 -

0.0005 -

Displacernent

-0om0s H-
o001 |
00015 -
o2 |

-0.0025 -

-0.003

Dy

Response Time
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The graph generated shows the vertical displacement response at the mid-span of the
first span of the continuous beam for the passage of the CRH trainset at 250 kph. The
peak downwards deflection of the beam is approximately 2.6 mm and the peak upwards
deflection approximately 1.7 mm. The quiet time after the passage of the trainset allows
the decay of the response to be observed with most of the dynamic response damped
out at around 8.5 seconds after the trainset first enters the continuous beam. The
response matches the response of the first span in the Wang et al paper, noting that the
sign conventions are opposite to the paper which has a positive vertical displacement in
the downwards direction.

e When the graph has been displayed, close the graph

The vertical displacement response at the mid-span of the second span of the
continuous beam for the speed of 250 kph will now be investigated.

If the IMDPlus toolbar has been enabled,

e Click on the EI button in the toolbar to open the IMDPlus Output Control dialog
If the IMDPlus toolbar is not enabled,

e Open the IMDPIus Moving Mass Analysis Control dialog through the menu and
click Next > to keep the existing analysis control settings and open the IMDPlus
Output Control dialog.

e Ensure Node and Extent as Individual are still selected

o Enter Node number 31 (This is the node in the mid-span of the second span)
e Ensure all other dialog input is unchanged.

e Click the Finish to proceed.

The IMDPIlus will now proceed for the second span. The solution time for this analysis
will be quicker than for the first node because of the presence of binary results
databases that are saved to the disk.

e Click No when asked whether to free up disk space by deleting the temporary files
created by IMDPlus. Choosing no will save data extraction times for subsequent
analyses at the cost of some disk space.
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Mode 31, Speed 69.4400000000000: Translational Displacerment Time History

0.0025

0002 -

0.0015 --

0.001 -

0.0005 -

-0.0005 |-

-0.001 -

Displacement

-0.0015 -
0002 -
-0.0025 |-
0003 -

-0.0035 |-

-0.004

Response Time

DY

The graph generated shows the vertical displacement response at the mid-span of the
second span of the continuous beam for the passage of the CRH trainset at 250 kph.
The peak downwards deflection of the beam is approximately 3 mm and the peak
upwards deflection approximately 1.6 mm. The response again matches the response of
the second span in the Wang et al paper, noting that the sign conventions are opposite
to the paper which has a positive vertical displacement in the downwards direction.

e When the graph has been displayed, close the graph

Peak Vertical Displacement of Mid-Spans for Multiple
Speeds

The response of the two spans of the continuous beam were investigated for a single
speed of 250 kph. The response of these two spans for a range of speeds between 25
kph and 600 kph (in 25 kph increments) is now investigated to determine the worst
speeds for the response of the beam.

e Open the IMDPIus Moving Mass Analysis Control dialog through the menu or click
on the ;l button in the toolbar.
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Ensure that the Moving

—Moving mass input

mass input and Vobic corie | 5
. ehicle configuration 1.CRH Trai hd
Mode/damping  control o
sections of the dialog are I Pathsuface profie | o |
unchanged  from  the :
. — Mode/damping control
preVIOuS analyses Total participating mass

Included modes: All Maodify... | H-Direction I 2105

=
ini Y-Diection | 8560 %
Enter the Mlnlmum Speed ¥ Detault damping 258 % I adify... | frec fon
as 6.944, the Maximum ZDiection | 000 %

Speed as 166.667 and the r— Solution control

Speed Increment as 6944 Advanced solution options Modify... |

to analyse a range Of Path surface profile options [ adifiy.... |

speeds between 6.944 m/s Ouiet e sl

(25 kph) and 166667 m/s inimum speed £.944 e ahlaed) |5

(600 kph) in increments Of Maximurn speed 1E6.667 ™ IMDPlus automatic time step (Myquist)
6944 rn/s (25 kph) Speed increment E.944 Solution time step 2E-3

Ensure the Quiet time after
passage of load is 5

Ensure the IMDPlus
determining time step
(NquISt) Option iS < Back | Mext » I Cancel Help

deselected and the
Solution time step is 2E-3

Click the Next button to proceed. When asked whether the speed range is correct
choose Yes to continue. When prompted about missing total mass due to mass
participation factors below 90% choose Yes to continue.
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e Ensure Node and Extent
as Individual are still
selected

e Enter Node number 11

e Ensure Displacement
results of DY is selected.

e Ensure Individual items

is selected.

e Deselect Response time
history .

e Select Peak response
summary and Absolute

e Ensure Generate graphs
in Modeller is selected.

e Click
proceed.

the Apply to

IMDPlus Moving Mass Dutput Control

—Mode/element selaction

= Node " Element Enity IDispIacement j
Extent IIndeuaI VI Companent IDY j
Nade 11 - IV Individual iterns

I= | S of chozer items

™| &verage of chosen items

—Spring-mass system selection

' Spring-mass system Fiesult IUnsp[ung mass j
Estent IIndividuaI j Entity IDispIacement ﬂ
System 1 [0.0) CRH Train =

— Output control

™ Response time histary

' Positive/negative

= Absolute

I™ | Ervelope

fdmdifi.. |
[Dptions... |

V¥ Peak response summany

™ Secondary response specta [SRS)

I Modal combinationfactor histomn

v Generate graphs in Modeller Speed to araph |1 E.944 e
" Generate textfile output [Hptions. |
< Back | Finish I Apply | Cancel | Help |

IMDPIus will now calculate the sprung-mass and continuous beam interaction
behaviours for all 24 of the speeds chosen in the 25 kph to 600 kph range.

Note.

Due to the complexity of the equilibrium calculations of the compatible

responses of the 32 spring-mass systems and the continuous beam as they pass along the
path for the 24 speeds, the first analysis will take extra time to complete. Once this is
done, so long as no changes to the modal information or analysis options are made, all
subsequent solutions will be considerably faster due to the presence of binary results

databases on disk.

180
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IMDPlus >

| Moving Mass >
Moving Mass
Analysis...

Viewing the Results

Mode 11: Absolute Translational Displacement Sumrmary
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The graph shows that the worst vertical displacement response of the first span occurs
around 83.328 m/s which is equivalent to a train speed of 300 kph. At this speed the
peak vertical displacement response is approximately 7 mm. A second peak is observed
between speeds of 124.992 m/s (450 kph) and 131.936 m/s (475 kph). Both of these
peaks agree with the Wang et al paper which states that the speeds where resonance is
induced in the beam for the first two modes of vibration are 302.67 kph and 472.98
kph. The magnitudes of the two peaks are also in agreement with Wang et al.

e When the graph has been displayed, close the graph

The peak vertical displacement response at the mid-span of the second span of the
continuous beam for the same speed range will now be investigated.

If the IMDPlus toolbar has been enabled,

e C(Click on the EI button in the toolbar to open the IMDPlus Output Control dialog
If the IMDPlus toolbar is not enabled,

e Open the IMDPlus Moving Mass Analysis Control dialog through the menu and
click Next > to keep the existing analysis control settings and open the IMDPlus
Output Control dialog.

e Ensure Node and Extent as Individual are still selected
e Enter Node number 31
e Ensure all other dialog input is unchanged.

e Click the Apply to proceed.
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The IMDPIlus analysis will now proceed for the second span. The solution time for this
analysis over the range of speeds will be much quicker than for the first node because of
the presence of binary results databases that are saved to the disk.

Mode 31: Absolute Translational Displacement Summary

Displacernent

The graph shows that the worst vertical displacement response of the second span
occurs again around 83.328 m/s which is equivalent to a train speed of 300 kph. At this
speed the peak vertical displacement response is approximately 8.7 mm. A second peak
is again observed between speeds of 124.992 m/s (450 kph) and 131.936 m/s (475 kph).
Both of these peaks agree with the Wang et al paper and a more refined speed range
would provide the same smooth curves in the paper.

e When the graph has been displayed, close the graph

Note. The Wang et al paper considered speeds between 5 kph and 600 kph in very
small increments and therefore appears much smoother than the two graphs above. If
this analysis is conducted with a similar resolution of speed increment then the
following graphs are obtained from IMDPlus which agree with those in the paper
(plotted together in Microsoft Excel for a minimum speed of 5 kph, a maximum speed
of 600 kph and a speed increment of 1 kph).
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Viewing the Results
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Resonant Response of Mid-Spans at 300 kph

The train speed of 300 kph (83.328 m/s) showed that there was a resonant response in
the continuous beam at around this speed. The time history response of the two mid-
span nodes of the continuous beam will now be investigated at this speed.

Click on a blank part of the model window to deselect the line (if it is still selected)
Right click on a blank part of the model window and choose Advanced Selection...
Set the Type and name as Node and enter 11,31 in the textbox

Click on OK to select both mid-span nodes

Open the IMDPlus Moving Mass Analysis Control dialog through the menu or click
on the ;I button in the toolbar.
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e Ensure that the Moving

mass input and —Moving mass input

. ‘ehicle configuration 1:CRH Trai =
Mode/damping  control I1CAK Tian =
sections of the dialog are I Pathsuface profie | o |
unchanged  from  the :

. — Mode/damping control
preVIOuS analyses Total participating mass

Included modes: Al adify... | H-Direction I 81.05

%

. ini Y-Direction | B5.60 %
Enter the Mlnlmum Speed ¥ Detault damping 258 4 tadify... | frec fon

as 83.328, the Maximum ZDiecion | 000 %

Speed as 83.328 and the i~ Solution control

Speed Increment as O to Advanced solution options Modify... |
analyse a Slngle Speed Of Path surface profile options [ @difiy... |
83.328 m/s which is T
equivalent to 300 kph. Hamspeed 0 0 pacagelond
Maximurn speed 93328 ™ IMDPlus automatic ime step [Myquist)
d Ensure the (Qulet time after Speed increment 0 Solution time step 2E-3
passage of load is 5

e Ensure the IMDPlus
determining time step
(Nyquist) option is
deselected and the
Solution time step is 2E-3 EEZE ==

e Click the Next button to proceed and click Yes when informed about the analysis
having a mass participation below 90%.
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Viewing the Results

Choose Node and Extent
as Selected

Ensure Displacement
results of DY is selected

Ensure Individual items

is selected

Ensure Sum of chosen
items and Average of

chosen items are
deselected

Select Response time
history

Deselect Peak response
summary

Ensure Generate graphs
in Modeller is selected

Ensure the Speed to graph
is set to 1:83.328
(equivalent to 300 kph)

Click the Apply to proceed

IMDPlus Moving Mass Dutput Control

—Mode/slement selection

= Node " Element Enity IDispIaCement j
Extent ISe\ected vl Companent |DY j
Node 31 - ¥ Individual iterns

™ Sum of chozen items

™ awverage of chosen iterns

—Spring-mass system selection

' Spring-mass system Fiesult IUnsp[ung mass j
Estent IIndividuaI j Entity IDispIacement ﬂ
System lm

— Qutput control

¥ Response time histary

I~ Peak response summay

™ Secondary response spectia [SRS)

I Modal combinationfactor histon

| Positive/regative

= hbsolute

I™ | Envelope

fdadifir..
[Options...

¥ Generate graphs in Modeller Speed to araph |1:83.328 'I
™ Generate texfile output [ pticrs.
< Back | Finizh I Apply | Cancel | Help |

Choose Yes when asked whether you wish to process all selected nodes

The responses of the two mid-span nodes are shown below, firstly for the first span
(node 11) and secondly for the second span (node 31). In both figures the resonance of
the continuous beam is observed until the departure of the last wheelset of the train
from the structure after 2.82 seconds. After this time the damping causes the decay of
the vertical response of the beam which will eventually return to a static state.
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Mode 11, Speed 83.3280000000000: Translational Displacement Time History
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e When the graphs have been displayed, close the graphs

Displacement Time Histories of First and Last Spring-
Mass Systems

In the previous analyses attention was focused on the vertical displacement response of
the continuous beam from the passage of the CRH trainset over a range of speeds. The
response of the actual train is now investigated.

If the IMDPIus toolbar has been enabled,
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Viewing the Results

e Click on the EI button in the toolbar to open the IMDPlus Output Control dialog
If the IMDPIlus toolbar is not enabled,

| Utiities e Open the IMDPlus Moving Mass Analysis Control dialog through the menu and
% click Next > to keep the existing analysis control settings and open the IMDPIus
—m Output Control dialog.
Analysis...

e Select Spring-mass

System and Extent as —Mode/element selection

i  Had " Element Enfity | ¥
Individual ade emen nity [Dispiacement =
Estert  [Scecied -] Component [Dv = |
e Set the System to .
Node kil - ¥ Individual items

1 (00) CR H Tral n I Sumaf chosen items:
Wheelset I™ | &verage of chosen items

—Spring-mass system selection

e Set the Result to
Unsprung mass

% Spring-mass system Result IUnsprung mass j

Extent IIndividuaI = Entity IDispIacement =l

e Set the Entity to System |1 (D.0)CAH Train ' =
Displacement

— Output contral

. ¥ R time hist
e Ensure all of the selections Fepense fme A

in the Output Control are I~ Peak response summary £ Positive/negative I” | Envelope
: : : & Lhsolute
identical to the previous :
analySiS ™| Secondany response spectra (SHS] Iy
™ Modal combinationfactor history [ ptions...
o Cth the Apply to ¥ Generats graphs in Modeller Speed to graph |1:83.328 'l
proceed.

™ Generate textfile autput [ ptiors...
< Back | Finizh I Apply | Cancel | Help |

The plotting of the results will now proceed. IMDPlus should not need to resolve the
analysis since the spring-mass system results should already be available.
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Unsprung Mass, Speed 63.3280000000000: Displacement Time History
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The second graph shows the curve after zooming into the first 0.5 seconds of the time
history. This indicates that the displacement of the unsprung mass returns to zero (i.e.
the first spring-mass system has left the structure) after about 0.48 seconds. This can be
confirmed by dividing the total length of the continuous beam by the speed, 40 / 83.328
= 0.48 seconds.

e When the graph has been displayed, close the graph
If the IMDPlus toolbar has been enabled,

e Click on the El button in the toolbar to open the IMDPlus Output Control dialog
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| Utilities
IMDPlus >
| Moving Mass >
Moving Mass
Analysis...

Viewing the Results

If the IMDPIlus toolbar is not enabled,

Open the IMDPlus Moving Mass Analysis Control dialog through the menu and
click Next > to keep the existing analysis control settings and open the IMDPlus
Output Control dialog.

Ensure  Spring-mass

System iS Selected —Mode/slement selection

" Node " Element Enlity IDisDIacement j
Ensure Extent is set to Ewert  [oooes <] Comporen [T |
Individual

Node kil - ¥ | Inddividual iterms

™| S of chazer items

Ensure the System is set
1 (0.0) CRH Train

I™ | &verage of chosen items

—Spring-mass system selection

Wheelset
& Springimass system Result [Sprung mass 1 =l
Set the Result to Sprung Estent Incividual x| Entiy |Displacement |
mass 1 Sysem |1 (0.0JCRH T 7|
— Qutput control

Ensure the Entity is set to
Displacement

¥ Response time history

™ Peak response summany £ Positive/riegative I” Envelope
Ensure all of the selections  Asolie
in the Output Control are I™ | Secondan responise spectra (SES) Fladify...
identical to the pl‘eViouS I Modal combinationfactar histany Opticrs...
analySIS ¥ Generate graphs in Modeller Speed to graph I'I'EB 328 'I
Clle the Apply to ™ Generate textfile output Optiors. .
proceed.

< Back | Finizh I Apply | Cancel | Help |
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The graph shows that the sprung mass representing the body of the first wheelset of the
train displaces just over 2 mm from its static position 0.43 seconds after it first enters
the continuous beam and the viscous damping of the spring-mass system quickly damps
out the body motion within 2 to 2.5 seconds after the wheelset leaves the structure
(which occurs at 0.48 seconds).

e When the graph has been displayed, close the graph

Note. All results for the sprung masses are with respect to their static equilibrium
positions. Static displacements of the sprung masses are summarised in the
IMDPlus.log file at the beginning of the analysis.

The last spring-mass system is 195 m behind the first one and therefore the continuous
beam will have received dynamic input from 31 spring-mass systems by the time it
enters the beam. As a result, the vertical displacement of the unsprung and sprung
masses are expected to be different from the graphs presented above.

If the IMDPlus toolbar has been enabled,

e C(Click on the El button in the toolbar to open the IMDPlus Output Control dialog
If the IMDPIlus toolbar is not enabled,

e Open the IMDPlus Moving Mass Analysis Control dialog through the menu and
click Next > to keep the existing analysis control settings and open the IMDPlus
Output Control dialog.

190



Viewing the Results

e Ensure  Spring-mass

system iS Selected —Mode/slement selection

" Node " Element Enity IDispIaCement j
i Ensure EXtent 1S set to Extent ISe\ected vl Component |DY j
Individual
MNode il - ¥ | Inddividual iterms

™| S of chazer items

e Set the System to
32 (-195.0) CRH Train

I™ | &verage of chosen items

—Spring-mass system selection

Wheelset
' Spring-mass system Result IUnsprung mass ﬂ
e Set the Result to Extent IIndividuaI j E ity IDispIacement j
Unsprung mass Sysem [ %00 7]
— Qutput control

e Ensure the Entity is set to
Displacement

¥ Response time histary

™ Peak response summany £ Positive/riegative I” Envelope
o Ensure all of the selections fF Absole
in the Output Control are I™ | Secondan response spectia (SES) Fladify...
identical to the preViOuS I Modal combinationfactar histany Opticrs...
analYSIS ¥ Generate graphs in Modeller Speed to araph |1:83.328 'I
° Clle the Apply to ™ Generate texfile output Optiors
proceed.

< Back | Finizh I Apply | Cancel | Help |

The graphs show the vertical displacement of the last sprung mass for the whole time
history and having zoomed into the region where the dynamic behaviour is observed.
This indicates that the displacement of the unsprung mass is zero until it enters the
structure at about 2.34 seconds and returns to zero after it has left the structure at about
2.8 seconds. Comparison of the vertical displacement response while the spring-mass
system is over the beam with the first unsprung mass system above shows how the
existing vibration of the continuous beam has altered the unsprung behaviour.
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Unsprung Mass, Speed 83.3280000000000: Displacement Time History
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e When the graph has been displayed, close the graph
If the IMDPlus toolbar has been enabled,

e C(Click on the El button in the toolbar to open the IMDPIlus Output Control dialog
If the IMDPlus toolbar is not enabled,

e Open the IMDPlus Moving Mass Analysis Control dialog through the menu and
click Next > to keep the existing analysis control settings and open the IMDPlus
Output Control dialog.
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e Ensure  Spring-mass

System iS Selected —Mode/slement selection

" Node " Element Enity IDispIaCement j
i Ensure EXtent 1S set to Extent ISe\ected vl Component |DY j
Individual
MNode il - ¥ | Inddividual iterms

™| S of chazer items

e Ensure the System is set
32 (-195.0) CRH Train

I™ | &verage of chosen items

—Spring-mass system selection

Wheelset
' Spring-mass system Result ISprungmass1 ﬂ
o Set the Result to Spl’ung Extent IIndividuaI j E ity IDispIacement j
mass l System Im
— Qutput control

e Ensure the Entity is set to
Displacement

¥ Response time histary

™ Peak response summary | Positive/negative. [T Envelope
o Ensure all of the selections £ ol
in the Output Control are I™ | Secondan response spectia (SES) Il
identical to the previous I Madal combinstion Aactor histary Dptions...
analYSis ¥ Generate graphs in Modeller Speed to araph lm
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proceed. < Back | ’WI Apply | Cancel | Help |
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The graph shows that the sprung mass representing the body of the last wheelset of the
train displaces almost 6.5 mm from its static position while it is over the continuous
beam before the damping of the spring-mass system quickly damps out the body motion
after the wheelset leaves the structure.
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|IMDPIus >
|Moving Mass >

Moving Mass

Analysis...

When the graph has been displayed, close the graph

Acceleration Time Histories of First and Last Spring-Mass
System Bodies

The acceleration response of the sprung masses representing the bodies of train
locomotives and passenger cars can be used to assess the comfort level that would be
experienced by passengers. The accelerations of the sprung mass for the first and last
sprung mass systems will be investigated.

If the IMDPlus toolbar has been enabled,

Click on the El button in the toolbar to open the IMDPIus Output Control dialog

If the IMDPIlus toolbar is not enabled,

Open the IMDPlus Moving Mass Analysis Control dialog through the menu and
click Next > to keep the existing analysis control settings and open the IMDPlus
Output Control dialog.

Ensure  Spring-mass

System iS selected —Mode/element selection

" Node " Element Entity IDispIacement j
Ensure Extent is set to Ewert  [Geloied <] Component [0V =
Individual Node 31 - ¥ Individual items

™ Sumf chosen items:

Set the System to
1 (0.0) CRH Train

™| Awerage of chosenitems

—Spring-mazs system selection

Wheelset

' Spring-mass system Result ISprung mass 1 ﬂ
Ensure the Result is set to Extent IIndividuaI j Entity IAcceIeration j
Sprung mass 1 System |1 (0.0)CRH Tran 7]

Set the  Entity to [ uPeen
ACCG| e ratl on ¥ Fesponse time histary

™ Peak response summany | Positive/negative I™ Envelope
Ensure all of the selections 2 Aol
in the Output Control are I | Secondary resporse spectia (SRS] Fadifi... |
identical to the pI'eViOUS ™ Modal combinationfactor histony Opticts... |
analYSIS V¥ Generate giaphs in Modellsr Speed lo graph |1 83328 =
Click the Apply to ™ Generate textfile autput Optiors... |

proceed.

< Back | Finizh I Apply | Cancel | Help |
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IMDPlus >

Moving Mass >

Moving Mass

Analysis...

The graph shows the vertical acceleration response of the body of the first wheelset
which experiences a maximum acceleration of +0.174 m/s* or 0.018 g as it is about to
leave the continuous beam. This peak acceleration for the first wheelset occurs while
the dynamic response of the continuous beam is still increasing and therefore a higher
peak acceleration might be expected for subsequent wheelsets of the train.

Sprung Mass 1, Speed 83.3280000000000: Acceleration Time Histary
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e When the graph has been displayed, close the graph
If the IMDPIlus toolbar has been enabled,

e Click on the EI button in the toolbar to open the IMDPIlus Output Control dialog
If the IMDPIlus toolbar is not enabled,

e Open the IMDPlus Moving Mass Analysis Control dialog through the menu and
click Next > to keep the existing analysis control settings and open the IMDPlus
Output Control dialog.
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e Ensure Spring-mass
system is selected

e Ensure Extent is set to
Individual
e Set the System to

32 (-195.0) CRH Train
Wheelset

e Ensure the Result is set to
Sprung mass 1

e Ensure the Entity is set to
Acceleration

o Ensure all of the selections
in the Output control are
identical to the previous
analysis

e Click the Finish to
proceed. Click No when
asked whether to free up
disk space.

IMDPlus Moving Mass Dutput Control

—Mode/element selaction
" Mode " Element Enity IDispIacement j
Extent ISe\ecled VI Companent IDY j
Mode 21 - ¥ | Indivicual iterms
I= | S of chozer items
™| &verage of chosen items
—Spring-mass system selection
* Spring-mass system Fiesult ISprung mass 1 j
Extent IIndividuaI j Entity IAcceIeration ﬂ
Syztem |32 [195.0) CRH Tr. >
— Output control
¥ Response time histary
™ Peak response summany € Positive/riegative I™ Envelope
= Bbsolute
I™ | Secondan response spectia (SES] Il adify... |
I Medal eombinationfacter histary Optiors... |
v Generate graphs in Modeller Speed to araph |1 83.328 v
™ Generate texfile output Optiors |
< Back | Finish I Apply | Cancel | Help |

Sprung Mass 1, Speed 83.3280000000000: Acceleration Time Histary
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The graph shows the vertical acceleration response of the body of the last wheelset and
indicates that it experiences a maximum acceleration of -0.582 m/s* or -0.059 g while it
is about to leave the continuous beam. This peak acceleration for the last wheelset is
significantly higher than the first wheelset as might be expected for subsequent
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[IMDPlus >
|Moving Mass >

Moving Mass

Analysis...

wheelsets of the train since the beam has already experienced excitation from all of the
previous wheelsets.

e When the graph has been displayed, close the graph

Peak Acceleration Response of All Train Bodies

In the previous graphs the acceleration response of the sprung masses representing the
bodies of the first and last wheelsets representing the train were inspected. The peak
vertical acceleration response of all of the sprung masses representing the bodies of the
train is now inspected for the 25 kph to 600 kph speed range.

¢ Open the IMDPlus Moving Mass Analysis Control dialog through the menu or click
on the ;I button in the toolbar.

e Ensure that the Moving

—Moving mass input

mass input and Vobic corie | 3
. ehicle configuration 1.CRH Trai hd
Mode/damping control =
sections of the dialog are I Pathsuface profie | e |
unchanged  from  the :
. — Mode/damping control
previous analyses Total participating mass
Included modes: All Maodify... | #-Direction I 70 %
° ini Y-Direction [ 85.60 %
Enter the Mlnlmum Speed ¥ Detault damping IT % I adify... | frec fon
as 6.944, the Maximum Z0ieotion [ 000 %
Speed as 166.667 and the r— Solution control
Speed Increment as 6944 Advanced solution options Modify... |
to analyse a range Of Path surface profile options [ odifi.. |
speeds between 6.944 m/s Ouiet e afer
(25 kph) and ]66667 m/S tinimum speed B.344 gesae ol |5
(600 kph) in increments of Maimurn speed 166667 [~ IMDPlus automatic time step [Myguist]
6944 m/s (25 kph) Speed increment E.944 Solution time step 2E-3

e Ensure the Quiet time after
passage of load is 5

e Ensure the IMDPlus
determining time step
(NquISt) Option iS < Back | Mext » I Cancel Help

deselected and the
Solution time step is 2E-3

e Click the Next button to proceed. When asked whether the speed range is correct
choose Yes to continue. When prompted about missing total mass due to mass
participation factors below 90% choose Yes to continue.
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High Speed Train Modelling through Sprung Masses

e Ensure Spring-mass
system is selected

e Set Extent to All

e Ensure the Result is set to
Sprung mass 1

e Ensure the Entity is set to
Acceleration

e Deselect Response time
history

e Select Peak response
summary and Absolute

o Ensure all of the selections
in the Output control are
identical to the previous
analysis

e Click the
proceed.

Finish to

e C(Click Yes when asked

IMDPlus Moving Mass Output Control

—Mode/element selection

" Node " Element Entity IDispIacement ﬂ
Extent ISe\ecled 'l Campanent IHSLT j

MNode 31 v [+ | [iclividdual it=mms
™| Suim of choser items

™| Awerage of chosen items

—Spring-mazs system selection

' Spring-mass systam Result ISprung mass 1 ﬂ

Extent IAII j Enitity IAcceIeration ﬂ

System |32 [-195.0) CRH Tr. ~

—Dutput contral

™ Response time histary

" Positive/negative

@ Absolute

™| Envelope

fdadify.... |
[pticns... |

¥ Peak response summary

I | Secondary responss spectia (SHS]

™ todal combinationAactor history

¥ Generate giaphs in Modeller Speed ta graph |1 E.944 -
™ Generate textfile output [pticns... |
< Back | Finizh I Apply | Cancel | Help |

whether to free up disk space by deleting the temporary files created by IMDPlus.

IMDPIlus will perform the analysis and the graphs for all 32 of the spring-mass systems
will be displayed and can be printed out. A sample of the graphs are shown below
demonstrating the different behaviours of each of the sprung bodies of the train (first
spring-mass system, sixteenth spring-mass system and the last spring-mass system).
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Viewing the Results

Sprung Mass 1: Absolute Acceleration Summary
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High Speed Train Modelling through Sprung Masses

Sprung Mass 1: Absolute Acceleration Summary

Acceleration

ﬁ*l\c:e\eratmn 32 (-195.0) CRH Train Wheelset (CRH Train)

The graphs of the absolute peak vertical acceleration of the sprung bodies over the
speed range appears to indicate that the peak acceleration increases as the number of
wheelset spring-mass systems which have already passed along the beam increases.
This is roughly true but from inspection of each wheelset spring-mass system it can be
seen that the absolute peak acceleration out of the whole 32 wheelsets of the train
actually occurs at the 30™ wheelset, indicated in the graph below.

For the 30" wheelset the absolute peak acceleration is observed at the first resonant
frequency equivalent to a train speed of 300 kph and is approximately 0.78 m/s* or
almost 0.08 g.

Sprung Mass 1: Absolute Acceleration Summary
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200



| File

Save...

Viewing the Results

e Close all of the graph windows.

Save the model

Save the model.

This completes the example.

201



High Speed Train Modelling through Sprung Masses

202



	IMDPlus User Manual
	IMDPlus Analysis Types
	IMDPlus Assumptions
	Performing IMDPlus Calculations in LUSAS
	Seismic Analysis
	Moving Load Analysis
	Moving Mass Analysis

	IMDPlus Toolbar
	Seismic Analysis
	Earthquake Input
	Sample Acceleration Time History Records

	Mode / Damping Control
	Frequency Interpolation
	Advanced Seismic Solution Options


	Moving Load Analysis
	Moving Load Generation
	Explicit Definition of United Kingdom HB Vehicle
	Composite Axle Definition of United Kingdom HB Vehicle using a Moving Load Vehicle Configuration
	Generation of the Moving Load Discrete Locations

	Modal Force Calculator
	Running the Moving Load Analysis
	Moving Load Input
	Mode / Damping Control
	Solution Control
	Advanced Moving Load Solution Options



	Moving Mass Analysis
	Spring-Mass System Properties
	Piecewise linear springs
	Polynomial Springs
	Spring Mass System Properties Dialog

	Moving Mass Vehicle Configuration
	Moving Load Generation
	Generation of the Moving Load Discrete Locations

	Modal Force Calculator
	Running the Moving Mass Analysis
	Moving Mass Input
	Vehicle Configuration
	Path Surface Profile

	Mode / Damping Control
	Solution Control
	Advanced Moving Mass Solution Options
	Path Surface Profile Options



	Visualising the Results
	Node / Element Selection
	Processing Individual, Selected or All Nodes or Elements
	Entity and Component Output
	Results for Individual items, Sum of chosen items and Average of chosen items

	Spring-Mass System Selection (Moving Mass Only)
	Processing Individual or All Spring-Mass Systems
	Result and Entity Output

	Output Control
	Response Time History
	Peak Response Summary
	Secondary Response Spectra (SRS)
	Modal Combination/Factor History
	Generate Textfile Output


	Elements Supported By IMDPlus

	Seismic Analysis of a 2D Frame (Time Domain)
	Description
	Objectives
	Keywords
	Associated Files
	Discussion

	Modelling
	Running LUSAS Modeller
	Building and loading the model
	Defining Eigenvalue Controls

	Running the Analysis
	Viewing the Results
	Plotting Mode Shapes
	Printing Eigenvalue Results
	Checking the Mass Participation Factor
	Seismic Response Analysis
	Defining the Seismic Parameters
	Displacement Plots
	Velocity Plots
	Acceleration and Secondary Response Spectra Plots
	Displaying Individual Element Results
	Displaying Results for a Selected Set of Elements
	Save the model


	Seismic Analysis of a 3D Frame (Time Domain)
	Description
	Objectives
	Keywords
	Associated Files
	Discussion

	Modelling
	Running LUSAS Modeller
	Building and loading the model
	Defining Eigenvalue controls

	Running the Analysis
	Viewing the Results
	Seismic Response Analysis
	Defining the Seismic Parameters
	Individual Node Displacements
	Average and Peak Displacements for a Selection of Nodes
	Peak Axial Forces from All of the Elements in the Model
	Displaying Deformed Mesh Plots from Modal Combinations
	Displaying Envelopes for the Whole Earthquake
	Displaying results for a selected member
	Save the model


	Train Induced Vibration of a Bridge
	Description
	Objectives
	Keywords
	Associated Files

	Modelling
	Running LUSAS Modeller
	Building and loading the model
	Modelling Discussion
	Defining Eigenvalue Controls

	Running the Analysis
	Viewing the Results
	Checking the Mass Participation Factor
	Plotting Mode Shapes
	Selecting individual nodes and elements of interest
	Defining the Eurocode ENV 1991-3 Type 3 Trainset
	Importing a Vehicle
	Moving Load Analysis
	Defining the Moving Load Path
	Generating the Modal Force History for the Moving Load
	Defining the Moving Load Parameters
	Displaying Individual Node and Element Results for Moving Load Analysis
	Displacement and Acceleration Graphs
	Stress Resultant Graphs for Shells
	Displaying Results for a Selection of Nodes and Elements
	Averaged and Peak Displacements and Dynamic Amplification Factors for the Bridge Structure
	Total and Peak Reactions for the Bridge Structure
	Average and Peak Stresses in a Side Panel of the Bridge Structure
	Save the model


	High Speed Train Modelling through Sprung Masses
	Description
	Objectives
	Keywords
	Associated Files

	Modelling
	Running LUSAS Modeller
	Creating a new model
	Feature Geometry
	Meshing
	Material Properties
	Geometric Properties
	Supports
	Loading
	Search Area
	Defining Eigenvalue Controls

	Running the Analysis
	Viewing the Results
	Checking the Frequencies
	Checking the Mass Participation Factor
	Defining the CRH Trainset
	Importing a Vehicle
	Moving Mass Analysis
	Defining the Moving Mass Path
	Generating the Modal Force History for the Moving Mass
	Identification of Output Nodes
	Defining the Moving Mass Parameters
	Vertical Mid-Span Displacement Responses
	Peak Vertical Displacement of Mid-Spans for Multiple Speeds
	Resonant Response of Mid-Spans at 300 kph
	Displacement Time Histories of First and Last Spring-Mass Systems
	Acceleration Time Histories of First and Last Spring-Mass System Bodies
	Peak Acceleration Response of All Train Bodies
	Save the model



